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n Safety Symbols
The following symbols are used in this manual to prevent accidents which may occur as result of 
incorrect use of the instrument.

Denotes a sentence regarding safety warning or note.
Read the sentence carefully to ensure safe and correct use.

Denotes a prohibited operation.
The operation must never been performed.

Denotes an instruction.
The instruction must be strictly adhered to.

Denotes a sentence regarding safety precaution for laser.
Read the sentence carefully to ensure safe and correct use.

n Notes on this Manual
•	 The	VI-9i,	VI-910,	VI-900,	VI-700,	VI-300	are	model	names	for	Europe	and	VIVID	9i,	VIVID	910,	VIVID	
900,	VIVID	700,	VIVID	300	are	model	names	for	other	countries.	The	VIVID	(VI)	series	digitizer	includes	
VIVID	9i	(VI-9i),	VIVID	910	(VI-910),	VIVID	900	(VI-900),	VIVID	700	(VI-700)	and	VIVID	300	(VI-300).

•	 In	this	manual,	VIVID(VI)	Series	digitizer	is	also	renamed	to	as	“VIVID	digitizer”	or	simply	“VIVID”.
•	 Copying	or	reproduction	of	all	or	any	part	of	the	contents	of	this	manual	without	KONICA	MINOLTA	
SENSING’s	permission	is	strictly	prohibited.

•	 The	contents	of	this	manual	are	subject	to	change	without	prior	notice.
•	 Every	effort	has	been	made	in	the	preparation	of	this	manual	to	ensure	the	accuracy	of	its	contents.	
However,should	you	have	any	questions	or	find	any	errors,please	contact	a	KONICA	MINOLTA	SENSING	
authorized	service	facility.

•	 KONICA	MINOLTA	SENSING	will	not	accept	any	responsibility	for	consequences	arising	from	the	use	of	
the instrument.

n Trademarks
•	 Microsoft	and	Windows	are	registered	trademarks	of	the	Microsoft	Corporation	in	the	United	States	and	other	countries.
•	 Other	product	names	and	company	names	used	herein	are	trademarks	or	registered	trademarks	of	their	respective	owners.

n	Official	names	for	application	mentioned	in	this	manual
Name given in this manual Official	name

Windows Microsoft®	Windows®

Windows	XP Microsoft®	Windows®	XP	Professional	Operating	System

Windows	Vista Microsoft®	Windows®	Vista	Business	Operating	System

Windows	7 Microsoft®	Windows®	7	Professional	Operating	System

n About	This	Manual	and	Related	Documents
This	manual	explains	how	to	install	and	operate	the	Polygon	Editing	Tool	software	as	well	as	explain-
ing all the functions it provides.
The	Polygon	Editing	Tool	software	is	designed	to	control	“VIVID	Series”	non-contact	3D	digitizers,	
convert	scan	data	into	polygons,	edit	data	and	convert	VIVID	data	to	universal	data	formats.
The following is a list of manuals related to this one.

Document Content

Polygon	Editing	Tool

Basic	Operation	Guide
Explains	the	basic	operations	of	the	Polygon	Editing	Tool	software.
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Instruction	manual	for	each	model	in	
the	VIVID	series	of	non-contact	3D	
digitizers

VIVID	digitizers	offers	rapid,	high-precision	3D	scanning	ideal	for	imaging	of	in-
dustrial products	in	a	wide	range	of	shapes	and	configurations.	This	manual	describes	the	
digitizer’s	features	and	operating	procedures,	and	calls	attention	to	relevant	precautions.

Photogrammetry	System

PSC-1	Instruction	Manual
Explains	the	PSC-1	system,	a	high-precision	alignment	system	based	on	photographic	
measurement	technology.	This	system	is	for	use	in	the	VIVID	9i	only.

Bench	Top	Frame	Set	

Instruction	Manual

This	manual	explains	how	to	set	up	the	Bench	Top	Frame	Set,	which	offers	more	
stable	measurements	both	horizontally	and	vertically,	and	how	to	attach	the	VIVID	
910(VI-910)	or	VIVID	900(VI-900)	to	the	set.	This	frame	set	is	for	use	with	VIVID	
910(VI-910)	or	VIVID	900(VI-900)		only.

Safety	Precautions
When	using	this	software,	the	following	points	must	be	strictly	observed	to	ensure	correct	and	safe	use.
After	you	have	read	this	manual,	keep	it	in	a	safe	place	so	that	it	can	be	referred	to	easily	whenever	it	is	needed.	

WARNING Failure	to	adhere	to	the	following	points	may
result	in	death	or	serious	injury

To	ensure	correct	and	safe	use	of	this	software,	please	read	the	instruction	manuals	of	the	VIVID	(VI)	
series	digitizer	and	personal	computer	in	addition	to	this	manual	before	operating.	Incorrect	operation	of	the	
software	may	result	in	fire	or	electric	shock.

Software	Restrictions
•	 Copying	or	reproduction	of	all	or	any	part	of	the	contents	of	this	software	and	manual	without	KONICA	MI-
NOLTA	SENSING’s	permission	is	strictly	prohibited.

•	 The	specifications	of	the	software	are	subject	to	change	without	prior	notice.
•	 KONICA	MINOLTA	SENSING	will	not	take	any	responsibility	for	damage	caused	as	result	of	use	of	this	

software.

Notes On Use
•	 When	inserting	a	CD-ROM	into	the	CD-ROM	drive,	make	sure	that	it	is	placed	straight	in	the	right	direction,	

and inserted gently.
•	 Keep	the	CD-ROM	clean.	If	it	becomes	dirty,	a	reading	or	writing	error	may	result.
•	 Pay	attention	to	rapid	temperature	changes	and	dew	condensation.
•	 Keep	the	CD-ROM	away	from	direct	sunlight	or	heaters.
•	 Do	not	let	the	CD-ROM	drop	or	be	exposed	to	strong	shocks.
•	 Keep	the	CD-ROM	away	from	water,	alcohol,	thinner	etc.

Notes On Storage
•	 Do	not	store	the	CD-ROM	in	a	hot	area,	for	instance,	in	direct	sunlight	or	near	heaters.
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File New   Creating New Scene Data 24
 Open   Opening Saved Data 24
 Save Elements  Saving Element Data 26
  Scene  Saving Scene Data 27
 Save as Elements  Saving Element Data under a Different Name 28
  Scene  Saving Scene Data under a Different Name 29
 Import Elements  Importing Scanned Data 30
 Import Digitizer One Scan
     Performing One Scan with the VIVID 9i 33
    Performing One Scan with the VIVID 910 50
    Performing One Scan with the VIVID 900 or VIVID 910 74
    Performing One Scan with the VIVID 700 103
    Performing One Scan with the VIVID 300 118
 Import Digitizer Step Scan
    Performing Step Scan with the VIVID 9i 41
    Performing Step Scan with the VIVID 910 58
    Performing Step Scan with the VIVID 900 or VIVID 910 79
    Performing Step Scan with the VIVID 700 106
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 Import Digitizer PC Card
    Importing Data from the Memory Card of VIVID 910 67
    Importing Data from the Memory Card of VIVID 900 or VIVID 910 96
    Importing Data from the Memory Card of VIVID 700 111
   Easy Align Aligning Multiple Scans (for VIVID 910 only) 126
   PSC-1 Performing Precision Registration of Scan Data  136
 Export Elements  Exporting Element Data as Various Formats 137
  Images  Exporting Image Data as Various Formats 140
  Elements  Removing the Selected Element (s) 141
  Preferences   Displaying Information for Setting Conditions 142
 Select Digitizer  Selecting a Digitizer 144
 Exit   Exiting the Polygon Editing Tool 145
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• View Menu
View Orbit   Rotating or moving the Camera Position 148
 Zoom   Enlarging/Reducing the Displayed Item 149
 Full Frame All  Displaying Data Fully in all Windows 150
 Full Frame Displaying  Data Fully in Active Window 150
 Area Orbit   Rotating the Camera and Setting the Rotation Center 151
 Area Zoom   Enlarging/Reducing Item Enclosed by Specified Rectangle 152
 Move Plane   Setting Display Depth 153
 Move Light   Moving the Light 154
 Camera Settings  Setting the Camera Parameters 155
 Image   Displaying Color Images 156
 Show Element List/Hide Element List Displaying/Hiding the Element List 156
 Show Toolbar  Displaying the Toolbar 156

• Select Menu
Select Point   Selecting/Unselecting a Point by Clicking the Mouse 158
 Rectangle   Selecting/Unselecting Points within Specified Rectangle Area 159
 Bezier   Selecting Points within Specified Bezier Curve 160
 Boundary – Elements  Selecting Only the Boundary of Holes of Element (s) 162
 Boundary – Points  Selecting Only the Boundary of Holes of Points 162
 Color   Selecting Points within Specified Homogeneous Area 163
 Toggle Points  Reversing Selection State of Points of Selected Element (s) 165
 Select by Elements  Selecting All the Points of Element (s) 165
 Unselect by Elements  Unselecting All the Points of Element (s) 166
 Select Front   Selecting Only the Points Comprising Polygons that are Both Visible and at the Front 166

• Edit Menu
Edit Undo   Canceling the Previous Operation 168
 Redo   Performing the Canceled Operation 168
 Delete – Elements  Deleting the Selected Elements from the Element List 169
 Delete – Points  Deleting the Selected Points 170
 Delete – Polygons  Deleting Polygons Comprised of Selected Points 170
 Images   Editing the Texture of Selected Element 171
 Define   Defining Points as a New Element 178
 Recalc LOD   Recalculating the Simplified Display Data 179
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• Build Menu
Build Registration Initial Manual Performing Initial Registration of Elements Manually 182
   Auto   Performing Initial Registration of Elements Automatically 184
  Fine Elements  Performing Fine Registration of Elements 185
   Points   Performing Fine Registration of Selected Points 186
 Move Points    Moving the Selected Points 187
  Elements    Moving Element (s) 189
  To Origin    Moving the Element (s) to the Origin 191
  To X-Y-Z    Converting the Coordinate System of Element 192
 Rotate Elements    Rotating Element (s) 198
 Merge     Merging Elements 200
 Fill Holes Manual    Filling Holes Manually 201
  Auto    Filling Holes Automatically 202
 Smooth Element    Smoothing the Selected Element 204
  Points    Smoothing the Selected Points 205
 Subsample Uniformly Element  Reducing the Number of Points of the Selected Element Uniformly 206
   Points   Reducing the Selected Points Uniformly 207
  Adaptively Element  Reducing the Number of Points of the Selected Element Adaptively 208
   Points   Reducing the Selected Points Adaptively 209
 Modify Element    Rebuilding the Selected Element by Deleting Small Polygons 210
  Points    Rebuilding the Selected Points by Deleting Small Polygons 211
 Subdivision Element    Rebuilding the Selected Element by Dividing Large Polygons 212
  Points    Rebuilding the Selected Points by Dividing Large Polygons 213
 Triangulate Elements    Dividing Polygons in Elements into Triangles 214
  Polygons    Dividing Selected Polygons into Triangles 214
 Texture Blending     Blending Textures 215
 Check Polygons Element    Checking for Illegal Polygons in Element 216
  Polygons    Checking for Illegal Polygons Composed of Selected Points 218

• Info Menu
Info Info Elements    Displaying Information for the Element (s) 222
 Points     Displaying Information for Points 223
 Picked Point      Displaying Information for the Picked Point 224

• Window Menu
Window New Front/Right/Left/Back/Top/Bottom/Isometric/Perspective
      Changing Direction of View of Element view window 226
 Clone     Cloning an Element view window 226
 Close     Closing Active Element view window 227
 Cascade     Cascading Element view windows 227
 Tiling     Tiling Element view windows 228
 Layout 1/4    Displaying an Element view windows in 1/4 Layout 228
  1/1    Displaying an Element view window in 1/1 Layout 228
  Format A    Displaying an Element view window in Format A Layout 229
  Format B    Displaying an Element view window in Format B Layout 229
 Property     Displaying Window Properties 230
 Next     Displaying Next Element view window 232
 Previous     Displaying Previous Element view window 232

• Tool Menu
Tool Measure     Measuring Dimensions within the Selected Element (s) 234
 Menu Add     Adding a Menu 241
 Menu Del     Deleting an Added Menu 241
 Shortcut Keys    Displaying a List of Shortcut Keys 242
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• Pop-up Menus in Element view window
View Mode   Front/Right/Left/Back/Top/Bottom/Isometric/Perspective
       Changing View Mode 244
Rendering Mode   Wireframe/Shading/Texture Mapping/Wireframe + Shading/Wireframe + Texture Mapping
       Changing Rendering Mode 244
Show Vertex/Hide Vertex     Showing or Hiding Vertices 244
Show Normal/Hide Normal     Showing or Hiding Normal Vectors 245
Show Axis/Hide Axis     Showing or Hiding Axes 245
Smooth Shading/Flat Shading    Changing Shading Mode 245
Select element from window    Changing Displayed Element by Windows 246
Create clone window     Cloning an Element view window 247
Close window      Closing an Element view window 247
Property      Displaying Window Properties 248
• Pop-up Menus in Element List
Show Element/Hide Element    Showing/Hiding Elements 250
Delete Elements      Deleting Elements from the Element List  250
View Image      Displaying Color Images 251
Set Wireframe Color     Changing Wireframe Color 251
Set Shading Color     Changing Shading Color 252
Rename Element      Changing an Element Name 252

• Pop-up Menus in Image Window
Change Image      Changing the Color Image 254
Overlay      Displaying Wireframe on a Color Image 254
Zoom In      Enlarging the Color Image 254
Zoom Out      Reducing the Color Image 255
Actual Pixels      Displaying the Color Image in One-to-One Pixel Mode 255
Close       Closing the Color Image 255

Chapter 3  Appendix

Error Messages ...............................................................................................................................................259
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 Coordinate System ................................................................................................................................................. 264
 Window View........................................................................................................................................................... 264
 Vertex ...................................................................................................................................................................... 264
 Polygon ................................................................................................................................................................... 264
 Color Image ............................................................................................................................................................. 264
 Element ................................................................................................................................................................... 265
 Scene ...................................................................................................................................................................... 265
 Camera Data File .................................................................................................................................................... 265
 Element File ............................................................................................................................................................. 265
 Scene File ............................................................................................................................................................... 266
 Dynamic Range Expansion Function ...................................................................................................................... 266
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Conventions	for	Command	Reference	(Chapter	2)
Chapter	2	“Command	Reference”	(from	page	21)	gives	an	explanation	of	the	function	and	operating	procedure	
of each command in the menu order.
The	shortcut	key	and	the	icon	(displayed	on	the	tool	bar)	are	also	shown	in	the	command	title.
We	recommend	that	you	make	extensive	use	of	shortcut	keys	when	running	this	software.	Note	that	while	
software	keys	indicated	in	the	command	reference	are	effective	by	default,	you	are	free	to	add	new	shortcuts	
and	to	customize	the	existing	ones.

Ref.  For information about using and customizing shortcut keys, see page 242.

149

Chapter 2

View
Menu

9i
910
900
700
300

View – Zoom [Z] (Effective while held down)
Enlarging/Reducing the Displayed Item

This command is used to enlarge (zoom-in) or reduce (zoom-out) the displayed item, or to move the camera to
change the view angle.

Ref.  For a description of camera position, refer to the View – Camera Settings command (page 155).

Note
View – Zoom mode will be active when this command is selected. To cancel the View – Zoom mode, execute the View
– Zoom command again. However, if you are executing this command using the shortcut key, the View – Zoom mode
can be canceled by releasing the key.

Left : zoom-in, zoom-out
Middle ([Shift] + Left) : –

Right  : Drags the camera.

 Operating Procedure 

1 Click [Zoom] on the [View] menu.

2 Drag the item in an element window 
while holding down the left mouse button.
Dragging the item upward will enlarge it 
(zoom-in) and dragging it downward will re-
duce it (zoom-out).

• To move the camera (i.e. drag the camera), drag 
while holding down the right mouse button.

Memo

The element will be displayed in simple form during 
zoom and drag. It will be displayed in detailed form when
zooming or dragging is canceled.

79

Chapter 2
File
Menu

900
910

File – Import – Digitizer – Step Scan (When VIVID 900/910 is Selected)
Performing Step Scan with the VIVID 910 or VIVID 900

This command is used to take two or more shots using the rotating stage via the remote control function of this 
software. If a rotating stage has been selected by the Turntable, rotation of the stage can also be controlled. 
After the necessary shots are taken, scan the calibration chart required for calibration of rotation. Data ac-
quired from different angles will be subjected to registration, and the resulting data will appear.

Warning

Never stare into the laser emitting window.

Do not place a lens, mirror or optical element in the passage of the laser beam. Doing so may converge the 
laser beam, resulting in damage to your eyes, burns or fi re. To prevent the above accidents, make sure that a 
wall or similar which can block the laser beam is located behind the object.

■ When Using Only the Rotating Stage

 Operating Procedure 

1 From the [File] menu, select [Import], 
[Digitizer] and then [Step Scan].
The [File-Import-Digitizer-Step Scan] dialog 
box will appear.

Memo

• The calibration chart is an accessory of the rotating 
stage set.

• Before performing the procedure below, make sure that 
the digitizer you are going to use is selected by the File 
– Select Digitizer command.

• If you have connected multiple VIVID 900/910 units, 
you can select the unit to be used by changing the SCSI 
ID. Note that the software can only load memory-card 
data from the VIVID unit with the highest SCSI ID.

Note

If the rotating stage does not operate correctly from the 
dialog box, turn OFF the stage, turn it ON again, and 
then try to operate it.

Ref.  For details of the File – Select Digitizer command, 
refer to page 144.

• The monochrome monitor image currently cap-
tured by the VIVID 900/910 will appear in the 
Image area of the dialog box.

2 Place the object on the rotating stage.

3 To display the object in the middle of 
the window, change the position of the 
object or move the VIVID 900/910 back 
and forth to change the view angle.

Memo

If necessary, replace the lens attached to the VIVID 
900/910.

Mouse 
functions

Command name
Description of the command

Shortcut key

Command
icon

Chapter and
Nenu entry

In Chapter 2, 
it shows the 
model name.

The left column shows 
detailed explanations of 
each step.

The right column shows the 
outline of the procedure.

*	 This sample page is for explanatory purposes.  
 Actual pages will be different.6
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Chapter 1
F o r w a r d

Chapter 1 explains the preparations for using Polygon EditingTool. 
The method for uninstalling the software from the computer is also 
explained.
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1) Introduction of Operating Conditions ....................................8
2) Attaching the protect key to the computer ............................9
3) Installing the ASPI driver software on the computer ...........10
4) Installing Polygon Editing Tool on the computer .................11
5) Connecting the VIVID (VI) digitizer to the computer
    (necessary only if the VIVID(VI) digitizer will be controlled from the software) ......13

Regarding the software
1) Starting and exiting from the software ................................16
2) Main window, toolbar and icons ..........................................17

Uninstalling
1) Uninstalling Polygon Editing Tool ........................................19
2) Uninstalling the protect key (HASP) driver software ............20
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1)	Introduction	of	Operating	Conditions
The	following	hardware	environment	is	required	to	run	this	software.	

Hardware PC/AT	compatible	

CPU Piuentm	4	or	higher	recommended	(only	Intel)

Main memory 1024	MB	or	more	(2048	MB	or	more	recommended)

HDD 15	MB	free	space	is	required	to	install	this	software.

Applicable	OS

Windows	XP	Professional	SP2	(32	bit)
Windows	XP	Professional	x64	Edition	SP2	(64	bit)
Windows	Vista	Business	Edition	SP2	(32	bit)
Windows	Vista	Business	x64	Edition	SP2	(64	bit)
Windows	7	Professional	(32	bit)
Windows	7	Professional	(64	bit)
*	This	software	runs	as	the	32	bit	application	software	on	the	64	bit	OS.

Graphic
A	graphic	board	that	supports	Open	GL	and	enables	16-bit	color	display	with	a	resolu-
tion	of	1024	by	768	pixels	or	higher	is	required.

Interface

USB	port	for	the	protect	key
SCSI	port	for	VIVID	control

* Adaptec	SCSI	interface	board	and	ASPI	layer	(Ver.	4.70	or	higher)	must	be	installed.
*	When	Windows	Vista	or	Windows	7	is	used,	the	RATOC	Systems	Inc.’s	USB2.0-
UltraSCSI	converter	U2SCX	must	be	used.

Other A	CD-ROM	drive	is	required	to	install	the	software.

 Note   
To install and use this software, a login must be made by a user who has Administrator authority.

Preparations

Chapter 1
Preparations
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n Installing	the	protect	key	driver	software	(HASP	driver)	on	the	computer
	 In	order	for	the	protect	key	to	be	recognized	by	the	corresponding	driver	software,	it	is	necessary	to	install	the	
driver	software	on	the	computer	before	connecting	the	protect	key	to	the	computer.

2)	Connecting	the	protect	key	to	the	computer
When	using	Polygon	Editing	Tool,	it	is	necessary	to	attach	the	protect	key	and	install	the	protect	key	(HASP)	
driver	to	the	computer	before	installing	Polygon	Editing	Tool.
Attach	the	protect	key	to	the	computer	correctly	according	to	the	following	procedure.

 Memo 
The	installation	procedure	is	also	given	in	the	“READ-
ME_E.txt”	file	in	the	“Polygon	Editing	Tool”	directory	of	
the	software’s	CD-ROM.

 Operating Procedure 

1 Start Windows and insert the software 
CD-ROM into the CD-ROM drive. 

2 From Explorer, execute the “HASPUser-
Setup.exe” file stored in the CD-ROM.
The driver setup program will start.

3 Follow the instructions displayed on the 
screen to complete installation.
The protect key driver will be installed.

n	Connecting	the	protect	key
	 Connect	the	protect	key	to	the	USB	port	of	the	computer.

 * Insert	the	protect	key	into	the	computer’s	USB	port	straightly	and	carefully.

1 Connect the protect key to the 
computer’computer’s USB port.

Chapter 1
Preparations
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3)	Installing	the	ASPI	driver	software	to	the	computer
The	software	uses	SCSI	as	the	interface	connecting	the	VIVID	and	the	computer.
For	the	computer	to	recognize	VIVID	correctly,	it	is	necessary	to	install	the	ASPI	driver	software	on	the	
computer.

* Even	if	the	VIVID	will	not	be	connected	to	the	computer,	it	is	still	necessary	to	install	the	ASPI	driver.

 Note  
When Windows Vista or Windows 7 is used, it is necessary to install the driver software of the RATOC Systems Inc.’s USB2.0-Ul-
traSCSI converter U2SCX on the computer. Be careful not to install the Adaptec ASPI driver software, because it cannot control the 
VIVID digitizer.
To install the USB2.0-UltraSCSI converter driver software, refer to “About installation of U2SCX” below. 

 Operating Procedure 

1 Start up Windows, and set the Polygon 
Editing Tool CD-ROM into the computer’s 
CD-ROM drive.

2 Using Explorer, access the CD-92ROM 
drive and double-click on “aspi_v***.
exe”.

 Memo 
The	“aspi_v	.exe”	file	stores	the	driver	and	installa-
tion	software	in	self-compressed	form.	Double-clicking	
on“aspi_v	.exe”	causes	the	file	to	automatically	decom-

press	into	multiple	files.

3 Proceed to install the driver as de-
scribed below.

 Memo 
About	the	details	of	installation,	refer	to	the	decom-

pressed	“Readme.txt”	file.

4 Double-click on the decompressed 
“ASPIINST.EXE” file.
The driver install program starts up.

 Memo 
If	you	use	Windows	XP,	select	[Run]	from	the	[Start]	
menu,	and	then	run	the	decompressed	“INSTALL.BAT”	
file	added	“XP32”	parameter	as	following	dialog.	The	
install program starts to install.

5 Follow the instructions on the screen to 
complete the installation.
The install program installs the ASPI driver.

Chapter 1
Preparations

n	About	installation	of	U2SCX
	 It	is	necessary	to	install	Polygon	Editing	Tool	on	the	computer	before	installing	the	driver	software	of	the	
USB2.0-UltraSCSI	converter.

 Operating Procedure 

1 Start Windows and insert the software CD-ROM into the CD-ROM drive.

2 From Explorer, open the “U2SCX for Vista” (when using Windows Vista) or “U2SCX for 
Win7” (when using Windows 7 ) directory in the CD-ROM.

3 Proceed to install the driver as described on “Installation of Emulation Driver” in U2SCX_
InstallGuide.

10
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4)	Installing	Polygon	Editing	Tool	on	the	computer
When	installing	the	software,	make	sure	to	install	it	correctly	according	to	the	following	procedure.

 Operating Procedure 

1 Start Windows and insert the software 
CD-ROM into the CD-ROM drive.

2 From Explorer, execute the “setup.exe” 
file stored in the CD-ROM.
The setup program will start.

3 Click the [NEXT] button.
A dialog asking whether you agree with the 
program agreement will appear.

 Note 
Read it thoroughly and select whether you agree or not.
If you agree, proceed to step 4.
If you do not agree, the software cannot be installed.
Click the [Cancel] button to cancel installation.

4 Select [ I accept the terms in the license 
agreement. ] and click the [NEXT] but-
ton.

 Memo 
It	is	necessary	to	connect	the	protect	key	to	the	computer	
correctly before installing the software.
If	the	protect	key	has	not	yet	been	connected,	connect	the	
protect	key	to	the	computer	according	to	the	procedure	on	
page	9.

Chapter 1
Preparations

Below	are	display	examples	when	Windows	Vista	is	used.

Memo If	you	want	to	install	the	software	in	another	directory,	
click	the	[Change...]	button	and	select	the	desired	direc-
tory.	If	you	do	not	specify	another	directory,	the	software	
will	be	installed	in	“C:\Program	Files	(x86)\KONICA	
MINOLTA”	in	case	of	a	64-bit	OS	or		“C:\Program	Files\
KONICA	MINOLTA”	in	case	of	a	32-bit	OS.

11
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5 Click the [NEXT] button and click the 
[Install] button.

6 Follow the instructions displayed on the 
screen to complete installation.
The Polygon Editing Tool will be installed.
When installation is completed successfully, 
the following files will be created in the direc-
tory where the software has been installed.  KONICA MINOLTA

  Polygon Editing Tool Ver.*.**

   Bin 

   PET.exe
	 	 	 •
	 	 	 •
	 	 	 •

   Plugin

    AddTexture.dll

Memo 
The	files	that	will	be	created	will	change	according	to	the	
selected installation type.

Chapter 1
Preparations

Memo 
When	the	application	software	runs	for	the	first	time,	the	“..KONICA	MINOLTA\Polygon	Editing	Tool	Ver.*.**	\Model”	folder	
will	be	created	in	My	Documents.
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5)	Connecting	the	VIVID	digitizer	to	the	computer
When	the	VIVID	digitizer	will	be	controlled	from	Polygon	Editing	Tool,	connect	the	VIVID	digitizer	to	the	
computer	first,	and	then	start	up	Polygon	Editing	Tool.
The	first	time	the	VIVID	digitizer	is	connected	to	the	computer,	it	is	necessary	for	the	computer	to	recognize	
the	VIVID	digitizer	as	an	external	device.
Perform	operations	according	to	the	following	procedure.

n	Connecting	the	VIVID	digitizer	to	the	computer
	 In	order	for	the	protect	key	to	be	recognized	by	the	corresponding	driver	software,	it	is	necessary	to	install	the	
driver	software	on	the	computer	before	connecting	the	protect	key	to	the	computer.

 Operating Procedure 

1 Turn the POWER switch of the comput-
er OFF.

2 Connect the VIVID digitizer to the com-
puter.

 Memo

For	details	on	how	to	connect	the	VIVID	digitizer	to	the	
computer,	refer	to	the	instruction	manual	of	each	model	
of	the	VIVID	digitizer.

3 Set the POWER switch of the VIVID 
digitizer to ON (set switch to “I” mark).
Initializing of the digitizer will start.

4 After MENU appears in the finder of 
the digitizer, switch on the computer to 
start the Windows operating system.
Note
The POWER switch of the digitizer should be set to ON 
first before switching on the computer.

Chapter 1
Preparations
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n	Recognition	of	the	VIVID	digitizer	by	the	computer
The	first	time	the	VIVID	digitizer	is	connected	to	the	computer,	cause	the	computer	to	recognize	the	VIVID	digi-
tizer	as	an	external	device	by	following	the	procedure	below.

Note
It is not necessary to install the device driver of the VIVID digitizer on the computer; however, Polygon Editing Tool cannot 
control the digitizer until recognition has been completed.

 Operating Procedure 

1 After connecting the digitizer to the 
computer, switch on the computer.

 The digitizer will be recognized by the 
computer as a new external device, and 
then the Hardware Wizard will start.

2 A dialog confirming whether or not to 
connect to Windows Update will ap-
pear first. Check the “No, not this time” 
checkbox and then click “Next”.

3 When a dialog for confirming the driver 
installation method appears, check the 
“Install from a list or specific location 
(Advanced)” checkbox and then click 
“Next”.

Chapter 1
Preparations
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4 When a dialog for specifying the de-
sired driver search method appears, 
check the “Search for the best driver in 
these locations.” radio button, clear any 
other checkbox for specifying the loca-
tion, and then click “Next”.

5 If a dialog with the message “Cannot 
Install this Hardware” appears, check 
the “Don’t prompt me again to install 
this software.” checkbox and then click 
“Finish”. 

6 Start the device manager to confirm 
whether or not the VIVID digitizer has 
been properly recognized by the com-
puter.
Right-click the “My Computer” icon and select 
“Properties” in the popup menu. When the 
“System” dialog appears, click “Device Man-
ager” in the “Hardware” tab.
Alternately, open the “Control Panel” from the 
“Start” menu, double-click the “System” icon 
to display the “System Properties” dialog, and 
then click “Device Manager” in the “Hardware” 
tab.
If the name showing the VIVID digitizer such 
as “VIVID XXX Scanner Device” appears in 
the “Other devices” section, recognition of the 
digitizer has been completed.

 Memo 

	marks	may	be	displayed	on	the	device	icon.	This
is not a problem.

Chapter 1
Preparations

15
Download from Www.Somanuals.com. All Manuals Search And Download.



1)	Starting	and	Quitting	the	Software

n Starting the Software

 Operating Procedure 

1 From the [Start] menu, select [Program] 
–[KONICA MINOLTA], and then click 
[Polygon Editing Tool Ver.*.**].
The Polygon Editing Tool will start.
•	 If	a	scene	file	with	the	name	“startup.scn”	current-
ly	exists	in	the	directory	named	“Polygon	Editing	
Tool	Ver.*.**”

		 Model”,	the	program	will	automatically	load	this	
file	as	it	starts	up.

Note
When Windows Vista is used and the user account con-
trol is available, the [User Account Control] dialog box 
will appear. Click the [Continue] button.
When Windows 7 is used and UAC (User Account 
Control) is set to other than “Never notify”, the [User 
Account Control] dialog box will appear. Click the [Yes] 
button.

n	Quitting	the	Software

 Operating Procedure 

1 Click [Exit] on the [File] menu.
The software will be exited.

Regarding the software

Chapter 1

Regarding
the software
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2)	Main	Window

1. Title bar

2. Menu bar

3. Tool bar

            4. Element list

5. Window tile

6. Element view window

7. Status bar

1. Title bar ..........................	Displays	the	file	name	of	the	currently	displayed	image	data.
2. Menu bar .......................	Used	to	select	various	functions	of	this	software.
3. Tool bar .........................	Displays	the	icons	of	the	frequently	used	commands.	Clicking	an	icon	will	ex-

ecute the corresponding command.
4. Element list ................... Displays the names of all the elements currently opened by this software. High-

lighted	elements	mean	that	they	have	been	selected	by	an	operation	(e.g.	by	a	
menu).	To	select/unselect	an	element,	just	click	its	name.

	 	If	you	place	a	checkmark	next	to	an	element	name,	the	element	will	appear	in	the	
Element	view	window.	To	toggle	the	display	of	all	selected	elements	on	or	off,	
press	the	space	bar	or	the	[Ctrl]	key.

5. Window title ..................	Indicates	the	orientation	of	the	image	shown	in	the	window.	It	is	possible	to	open	
two	or	more	windows	having	the	same	orientation.	In	the	Isometoric	or	Perspec-
tive	window,	the	image	can	be	rotated	in	different	directions	using	the	[Orbit],	
[Camera	Settings]	commands	of	the	[View]	menu.

6. Element view window .....	Displays	the	elements	whose	corresponding	checkboxes	are	checked	(i.e.	a	check	
mark	is	displayed).

7. Status bar ...................... Displays the function of each button of the mouse according to the currently 
selectedcommand.	(The	functions	vary	with	the	currently	selected	command.)

Chapter 1

Regarding
the software
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n	Toolbar	Icons

Icon Command Description Reference	Page

File	–	Open Open	an	element	file	or	scene	file.	 24

File	–	Save	–	Elements Saves	element	data.	 26

File	–	Import	–	Digitizer	–	One	Scan Reads	in	the	data	from	a	1-shot	scan	by	the	digitizer.
33,	50,	74,
103,	118

File	–	Import	–	Digitizer	–	Step	Scan
Reads	in	the	data	from	a	step-shot	scan	by	the	digi-
tizer.

41,	58,	79,
106,	121

File	–	Import	–	Digitizer	–	PSC-1
Performing	Precision	Registration	of	Scan	Data
*	for	VIVID	9i	only;	Additional	license	is	required.

136

File	–	Import	–	Digitizer	–	Easy	Align Aligns	multiple	scans	taken	by	the	digitizer. 126

Edit	–	Delete	–	Points
Deletes	a	point(s)	selected	for	the	currently	displayed	
element.

170

View	–	Orbit Rotating	/	moving	the	camera	position 148

View	–	Zoom Enlarges/reduces	the	window.	 149

View	–	Full	Frame	All Fully	frames	the	element	in	the	window.	 150

View	–	Area	Zoom Enlarges/reduces	the	selected	area.	 152

Wireframe	(Window	–	Property)	 Displays the wireframe. 230

Shading	(Window	–	Property) Displays the image in shading mode. 230

Texture	(Window	–	Property) Texture-maps	the	image.	 230

Select	–	Select	Front
Selects	a	group	of	polygon	points	that	are	at	the	front	
and visible.

166

Select	–	Rectangle Selecting	points	within	the	specified	rectangle	area. 159

Select	–	Bezier Selecting	points	within	the	specified	Bezier	curve. 160

Select	–	Unselect	by	Element Unselects	all	the	points	inside	the	element. 166

Select	–	Toggle	Points Reverses the selection state of the points. 165

Select	–	Boundary	–	Elements	 Select	the	points	on	the	boundary	of	the	element. 162

Build	–	Registration	–	Initial	–	Manual
Performs	initial	registration	of	the	specified	corre-
sponding points of elements.

182

Build	–	Move	–	Elements Moves	the	currently	selected	elements. 189

Build	–	Rotate	–	Elements Rotates the elements. 198

Build	–	Merge Merges	elements	to	form	one	element. 200

Build	–	Fill	Holes	–	Auto Fills	holes	in	the	element	automatically.	 202

Build	–	Fill	Holes	–	Manual
Creates	polygon	data	for	the	specified	points	to	fill	
holes in the element.

201

Build	–	Smooth	–	Points Smoothens	the	boundary	of	the	specified	points. 205

Show	Vertex/Hide	Vertex Showing	or	Hiding	Vertices 244

Regarding
the software
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1)	Uninstalling	the	Polygon	Editing	Tool
To	uninstall	the	software,	use	the	standard	uninstall	program	of	Windows.

Remarks
The software will be deleted one folder at a time. If you have a file(s) you want to keep, copy it to another folder before start-
ing uninstallation.

 Operating Procedure 

1 From the [Start] menu, select [Setting] 
and then click [Control Panel].
The [Control Panel] window will appear.

2 Double-click the “Add/Remove” icon, 
select “Polygon Editing Tool” from the 
list that appears, and then click the 
[Add/Remove] button.
The uninstall program will start.

3 Follow the instructions displayed on the 
screen to complete uninstallation.

Uninstalling

Chapter 1

Uninstalling
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2)	Uninstalling	the	Protect	Key	Driver
	 To	uninstall	the	protect	key	driver,	use	the	standard	uninstall	program	of	Windows.

 Operating Procedure 

1 Remove the protect key from the com-
puter’s USB port.

2 From the [Start] menu, select [Setting] 
and then click [Control Panel].
The [Control Panel] window will appear.

3 Double-click the “Add/Remove” icon, 
select “HASP Device Driver” from the 
list that appears, and then click the 
[Change/Remove] button.
The uninstall program will start.

4 Follow the instructions displayed on the 
screen to complete uninstallation.
The protect key driver will be uninstalled.

 Memo 
Before	uninstalling	the	protect	key	driver,	make	sure	that	
the	protect	key	is	removed	from	the	computer.

 Memo 
After	the	protect	key	driver	has	been	uninstalled,	restart	
the computer.

Chapter 1

Uninstalling
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Chapter 2
Command Reference

Chapter 2 explains the functions of Polygon Editing Tool, using as key-
words the commands that can be selected from the menus of the main 
window and/or icons of the toolbar.
In addition, the scanning procedure for storing 3-dimensional data by 
controlling the digitizer from Polygon Editing Tool is also explained.
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File Menu
New ………………………………………………………………………………………24

Open ……………………………………………………………………………………24

Save – Elements …………………………………………………………………………26

Save – Scene ……………………………………………………………………………27

Save as – Elements ………………………………………………………………………28

Save as – Scene …………………………………………………………………………29

Import – Elements ………………………………………………………………………30

Import – Digitizer – One Scan

• When VIVID 9i is Selected  ……………………………………………………33

• When VIVID 910 is Selected ……………………………………………………50

• When VIVID 900/910 is Selected ………………………………………………74

• When VIVID 700 is Selected ………………………………………………… 103

• When VIVID 300 is Selected ………………………………………………… 118

Import – Digitizer – Step Scan

• When VIVID 9i is Selected  ……………………………………………………41

• When VIVID 910 is Selected ……………………………………………………58

• When VIVID 900/910 is Selected ………………………………………………79

• When VIVID 700 is Selected ………………………………………………… 106

• When VIVID 300 is Selected ………………………………………………… 121

Import – Digitizer – PC Card

• When VIVID 910 is Selected ……………………………………………………67

• When VIVID 900/910 is Selected ………………………………………………96

• When VIVID 700 is Selected ………………………………………………… 111

Import – Digitizer – Easy Align ……………………………………………………… 126

Import – Digitizer – Photogrametry System PSC-1 ………………………………… 136

Export – Elements …………………………………………………………………… 137

Export – Images ……………………………………………………………………… 140

Remove Elements …………………………………………………………………… 141

Preferences …………………………………………………………………………… 142

Select Digitizer ……………………………………………………………………… 144

Exit …………………………………………………………………………………… 145
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File – Open [Ctrl] + [O]
Opening Saved Data

This command is used to load an element file or scene file that has been saved using the File – Save – Elements 
command etc.

 Operating Procedure 

1 Click [Open] on the [File] menu.
The [File-Open] dialog box will appear.
•  The dialog box shows a list of files. If all the files 

cannot be displayed on one page, a scroll bar will 
be displayed.

File – New [Ctrl] + [N]
Creating New Scene Data

This command is used to delete the current scene and open a new scene.

 Operating Procedure 

1 Click [New] on the [File] menu.
The current scene will be deleted and a new 
blank scene will be generated.

 • If modifications have been made to an element 
after it has been imported or saved, the “Some el-
ements are modified. Do you want to save them?” 
message dialog box will appear.

 • To save the element data, click the [Yes] but-
ton.

 • Clicking the [No] button will display the new 
scene without saving the element data.

Ref.  For details of how to save elements, refer to the File 
– Save – Elements command (page 26).
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File – Open

2 Select the file you want to load.
If you select an element file with an attached 
image and you have also checked the Preview 
box, the display area will show a preview im-
age.

Parameters for [File-Open] Dialog Box

Look in Select the folder containing the file to open.

File name File name selected on the list is displayed.

File of type Data format of the selected file is displayed.

Preview If you check the Preview box, the [File - Open] dialog box will display preview images of those 
element files that have attached images.

Memo

A clock icon will be displayed during loading.

• To display files of a certain format only, select the 
desired format from the [File of type] pull-down 
menu.

Memo

In the case of element files, it is possible to select two 
or more files by clicking them while holding down the 
[Shift] or [Ctrl] key. If two or more files are selected, the 
preview image can be switched from one file to another 
using the [BACKWARD] and [FORWARD] buttons.

Note

•	 It	is	not	possible	to	select	files	of	different	formats.
•		 In	the	case	of	scene	files,	only	one	file	can	be	opened.
•		 It	is	not	possible	to	open	scene	files	which	have	been	
saved	using	the	Utility	Software VI-S1.

3 Click the [Open] button.
The data of the selected file(s) will be loaded 
and displayed in the element view window.

When an element file is loaded:
• The loaded data will be ready to be displayed in 

all windows. It will be displayed in the active 
window and the windows for which all the ele-
ments are set to be displayed.

• When the data is loaded for the first time after the 
software is started, it will be fully framed in all 
the windows including those that are hidden.

• The names of the loaded elements will also ap-
pear in the element list, indicating that the ele-
ments have been selected (highlighted).

When a scene file is loaded:
• The element list will show the names of the ele-

ments contained in the scene, and the view infor-
mation of each element will be loaded.

  The state in effect when a scene file was saved 
can be restored. However, it cannot always be 
restored completely, for example, if elements in 
the file have been set not to be displayed.

• If an element has already been loaded, the Warn-
ing dialog box shown on the right will appear.
q Click the [OK] button.
 All the elements that have already been loaded 

will be deleted, and the data of the scene file 
will be displayed.
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File – Save – Elements [Ctrl] + [S]
Saving Element Data

This command is used to save the data selected in the element list. The data will be saved under the current 
element file name.

 Operating Procedure 

1 From the element list, select the 
element(s) to be saved. Memo

It is possible to select two or more elements by clicking 
them while holding down the [Shift] or [Ctrl] key.

2 From the [File] menu, select [Save] and 
then click [Elements].
The selected element data will be saved under 
the current file name.

• If the selected elements are newly created ele-
ments or those that are loaded in another file for-
mat, the same dialog box as the one that appears 
when the File – Save as – Elements command 
is selected will appear, displaying the element 
names in the order they are selected.
q If you want to change the file name, change it 

and click the [Save] button.
 • The first element will be saved, and a dialog 

box for the next element will appear.
 • If you click the [Cancel] button, the next ele-

ment and subsequent elements will not be 
saved.

Ref.  For details of the File – Save as – Elements com-
mand, refer to page 28.
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File – Save – Scene
Saving Scene Data

This command is used to save the current scene data under the current scene file name.

 Operating Procedure 

1 From the [File] menu, select [Save] and 
then click [Scene].
The elements comprising the scene and its 
view information will be saved under the cur-
rent scene file name.

• If the scene is one that has been newly created, 
the same dialog box as the one that appears when 
the File – Save as – Scene command is selected 
will appear.
q Enter the desired file name, and click the 

[Save] button.
 The scene will be saved.

Ref.  For details of the File	–	Save	as	–	Scene command, 
refer to page 29.

Memo

If no elements are present, only the view information will 
be saved.
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File – Save as – Elements
Saving Element Data under a Different Name

This command is used to save the data selected in the element list under a different file name.

 Operating Procedure 

1 From the element list, select  the  
element to be saved.

Parameters for [File-Save As-Elements] Dialog Box

Save in Select the folder for saving file.

File name Input the name of file to save.

Save as type Select format for saving file.

Memo

It is possible to select two or more elements by clicking 
them while holding down the [Shift] or [Ctrl] key.

2 From the [File] menu, select [Save as] 
and then click [Elements].
The [File-Save as-Elements] dialog box will 
appear.
• If two or more elements have been selected, their 

names will be displayed in the order they are 
displayed in the element list.

3 If you want to change the file name, 
enter a new file name.
Note
The	file	name	must	consist	of	alphanumeric	characters	
only.
Changing	the	file	name	will	not	cause	the	element	
names	to	change.

4 Click the [Save] button.
The first element will be saved, and a dialog 
box for the next element will appear.
• When all the elements are saved, the dialog box 

will close.
• If you click the [Cancel] button, the next element 

and subsequent elements will not be saved.
Memo

By selecting “Element files Ver.1.x” from the [Save as 
type] pull-down menu, the elements can be saved under 
the format of the Utility Software VI-S1.

Note

If	the	elements	are	saved	under	the	format	of	the	Utility	
Software	VI-S1,	data	attached	to	the	images	may	be	lost.
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File – Save as – Scene
Saving Scene Data under a Different Name

This command is used to save the current scene data under a different file name.

 Operating Procedure 

1 From the [File] menu, select [Save as] 
and then click [Scene].
The [File-Save as-Scene] dialog box will ap-
pear.

2 Enter the desired file name, and click 
the [Save] button.
The scene comprising the elements and its 
view information will be saved.

Parameters for [File-Save As-Scene] Dialog Box

Save in Select the folder for saving file.

File name Input the name of file to save.

Save as type Select format for saving file.

Memo

• If no elements are present, only the view information 
will be saved.

• If you want the scene file to start up automatically the 
next time you run the program, save it into the “Poly-
gon Editing Tool Ver.*.**/Model” directory and give it 
the name “startup.scn”. When the program starts it will 
check for this file, and if the file exists it will automati-
cally load it.

Note
•	 The	scene	data	can	not	be	loaded	using	the	Utility	
Software	VI-S1.

•	 The	file	name	must	consist	of	alphanumeric	charac-
ters	only.
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File – Import – Elements
Importing Scanned Data

This command is used to import the raw scan data that was saved when the object was scanned by the VIVID 
(VI) series digitizer.

 Operating Procedure 

1 From the [File] menu, select [Import] 
and then click [Elements].
The [File-Import-Elements] dialog box will ap-
pear.
• The dialog box shows a list of files. If all the files 

cannot be displayed on one page, a scroll bar will 
be displayed.

2 From the [File of type] pull-down menu, 
select the format of importing data.

Item Explanation

CAM (*.cam) Scan data for VIVID 300 or 700

CDM (*.cdm) Scan data for VIVID 900 or 910

CDK (*.cdk) Scan data for VIVID 9i

STL (*.stl) ASCII or Binary-type STL.

3 Select the file you want to import.
If you select an element file with the attached 
image and you have also checked the Preview 
box, the display area will show a preview im-
age.

Memo

• If you select data files having two or more data, the 
[BACKWARD] and [FORWARD] buttons will be 
active, allowing you to display a preview image of each 
data.

• It is possible to select two or more files by clicking 
them while holding down the [Shift] or [Ctrl] key. If 
two or more files are selected, the preview image can 
be switched from one file to another using the [BACK-
WARD] and [FORWARD] buttons.

Note
•	 It	is	not	possible	to	select	files	of	different	formats.
•	 Although	it	is	possible	to	import	STL	format	data,	no	
guarantee	will	be	given	if	it	contains	illegal	polygons.

4 Set various parameters including re-
duce rate.

• Select the desired rate from “1/1”, “1/4”, “1/9”, 
“1/16” and “No polygon” by selecting from the 
[Reduction Rate] pull-down menu. “Adaptive” is 
able to be selected when the CDK format is setting.

• If you want to generate points to fill in holes caused 
by missing data, set the [File Holes] setting to “On”.

• The [Remove] pull-down menu lets you select 
which points to remove from the imported data.

  You can set this to any of the following: “None”, 
“Boundary(B.)”, “5deg. & B.”, “10deg. & B.”, 
“15deg. & B.”, or “20deg. & B.”

• If you want to filter the imported data, select the 
appropriate parameter from the [Filter] pull-down 
menu.
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• When importing data, if you want to perform dark 
correction for color data, check the [Dark Correc-
tion] checkbox.

• When importing data, if you want to perform log 
correction for color data, check the [Log Correc-
tion] checkbox.

5 Click the [Import] button.
The data will be imported and displayed in 
the element view window. The names of the 
imported elements will also appear in the ele-
ment list, indicating that the elements have 
been selected (highlighted).

• The loaded data will be ready to be displayed in 
all windows. It will be displayed in the active 
window and the windows for which all the ele-
ments are set to be displayed.

• When the data is loaded for the first time after the 
software is started, it will be fully framed in all 
the windows including those that are hidden.

• In the case of data acquired using the File – Im-
port – Digitizer – Step Scan command, each 
data will be subjected to registration when the 
file is opened, and then the resulting data will be 
displayed. A dialog box will also appear asking 
whether you want to perform fine-registration.
q Click the [OK] button.
 Fine-registration will be performed.

Memo

A progress bar will be displayed during loading.
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Parameters for [File-Import-Elements] Dialog Box

Look in Select the folder containing the element file to import.

File name File name selected on the list is displayed.

File of type Data format of the selected file is displayed.

Reduction Rate Selects the reduction rate to be applied when importing the data. You can select any of the
following: “1/1”, “1/4”, “1/9”, “1/16”, or “No polygon”, “Adaptive”.

Note
Selecting	“Adaptive”	reduces	data	adaptively.	This	option	is	displayed	only	if	the	CDK	format	is	selected.

Fill Holes Selects whether the programs fill in holes when importing the data. If the setting is On, the pro-
gram will automatically generate points to fill in holes left by missing data.

Remove Selects which the data the program excludes when carrying out the import. Select from an of the 
following: “None”, “Boundary (B.)”, “5deg. & B.”, “10deg. & B.”, “15deg. & B.”, or “20deg. & B.”

None: Removal is not carried out when importing the data.
Boundary (B.): The program removes boundary points.
5deg. & B.,10deg. & B., 15deg. & B., 20deg. & B.:

The program removes boundary points, and also removes polygons 
within the specified angular range (5°, 10°, 15° , or 20°) to the 
view vector.

Filter None:  The program does not perform filtering when importing the data.
Noise Filter (N.F.):  When importing the data, the points that appear to be noise will be 

corrected according to other data.
High Quality (H.Q.):  The program filters out unreliable data. (Effective only when 

importing data that was scanned using the VIVID 9i or the VIVID 
910.)

H.Q & N.F.:  Applies both noise filter and high quality filter. (Effective only 
when importing data that was scanned using the VIVID 9i or the 
VIVID 910.)

Dark Correction If this box is checked, the program applies dark correction when importing color data.

Log Correction If this box is checked, the program applies log correction when importing color data.

Preview If this box is checked, the program displays color data.
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Performing One Scan with the VIVID 9i

This command is used to cause the VIVID 9i (VI-9i) to scan the object one scan at a time using the remote 
control function of this software. Registration of multiple scan data can be performed by manually designating 
their corresponding points.
Once registration is complete, the data can be saved together with the coordinate conversion parameters pro-
vided for registration as a single data file (CDK). The data is then registrated and three-dimensionalized based 
upon the saved coordinate conversion parameters using the File-Import commands. 

Warning

Never stare into the laser emitting window.

Do not place a lens, mirror or optical element in the passage of the laser beam. Doing so may converge the 
laser beam, resulting in damage to your eyes, burns or fire. To prevent the above accidents, make sure that a 
wall or similar which can block the laser beam is located behind the object.

Memo

Before performing the procedure below, make sure that 
the digitizer you are going to use is selected by the File 
– Select Digitizer command.

Ref.  For details of the File	–	Select	Digitizer command, 
refer to page 144.

 Operating Procedure 

1 When using VIVID 9i for the first time 
or when the lens has been exchanged, 
field calibration must be performed us-
ing a Field Calibration System.
Place a Field Calibration System that is suit-
able for the lens to be used, and click the 
[Calibration] button in the [File-Import-Digi-
tizer-One Scan] dialog box to start field cali-
bration.

Note
User	calibration	must	also	be	performed	when	using	
VIVID	9i	after	long	periods	of	non-use	or	when	exces-
sive	changes	in	the	environment	(temperature,	humid-
ity)	have	occurred.

Ref.  For details on user calibration, refer to VIVID 9i 
Instruction Manual.

2 From the [File] menu, select [Import], 
[Digitizer] and then [One Scan].
The [File-Import-Digitizer-One Scan] dialog 
box will appear.

• The monochrome monitor image captured by the 
VIVID 9i will appear in the Work window area of 
the dialog box.
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4 To display the object in the middle of 
the Work window area, change the po-
sition of the object or move the instru-
ment back and forth to change the view 
angle.

3 Set an object in place.
If you are going to use the rotating stage, 
place the object on it.

Memo

If necessary, replace the lens attached to the instrument. 
If the lenses are changed, carry out field calibration using 
the Field Calibration System.

5 Click the [Option] button.
The [File-Import-Digitizer-One Scan-Option] 
dialog box will appear.

6 Set optional parameters.

Item Explanation

Scan Parameter Sets the settings for scanning.

Convert Parameter Sets the settings for three-
dimensionalization.

Stage Parameter Select the rotary stage to be 
used.

[Default] button Clicking this restores the 
default settings.

Ref.  For details, refer to parameters (P.39) for [File-Im-
port-Digitizer-One Scan-Option] dialog box.

• Select the desired stage in [Stage Parameter] field, 
and click on the [Apply] button. If the stage has 
been recognized properly, a stage slide bar will be 
displayed at the bottom of the work window when 
the [File-Import-Digitizer-One Scan-Option] 
dialog box is closed.

• If initialization is not successful, turn off the 
power to the rotary stage power, turn it on again, 
and then click on the [Apply] button.

7 After necessary settings are made, 
click the [OK] button.
The settings will be set and the [File-Import-
Digitizer-One Scan-Option] dialog box will 
close.
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8 Click the [Scan] button to acquire the 
first scan data.
A scan will start, and a color image will be 
displayed in the Work window area.

Memo

If  [Use Color] is not checked (i.e. no check mark is 
shown), The scan data has no color image data, and a gray-
scale image will be displayed instead of a color image.

• Clicking on the following radio buttons will make 
a change to the image displayed in the Work win-
dow area. The data acquired during the scan will 
remain unchanged.

Item Explanation

[Mono] radio 
button

The current image is displayed in 
monochrome.

[Color] radio 
button

The color image acquired from 
the scan is displayed.

[Pitch] radio 
button

The distance data is displayed 
in the color that is shown in the 
Near-Far color slide bar ac-
cording to the distance from the 
object to the digitizer.

• Clicking  the [Color Read] button will re-scan for 
the color data only. The distance data will not be 
updated.

• Clicking the [Edit] button enables you to delete 
the area that is not necessary for three-dimen-
sionalization by specifying it using the mouse. 
Messages will appear at the bottom of the Work 
window area as shown right, so follow them to 
operate the mouse.

  Click the [Edit] button again to exit the edit mode.

• Switch to pitch display screen, and right-click on 
desired position in the screen while holding down 
[CTRL] key. The Z-axis coordinates at that posi-
tion (distance from VIVID 9i) will appear.

  To specify distance manually and perform mea-
surement, this value must be used.
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Note
The	[Store]	button	will	be	disabled	(displayed	in	gray)	
when	clicked	once.	This	will	prevent	the	same	Work	
window	area’s	data	from	being	stored	repeatedly.

10 Acquire the second scan data. Move 
the object so that 3 pairs of corre-
sponding points or 1 or more pairs of 
corresponding points can be set be-
tween the first scan data and the sec-
ond and subsequent scan data.

9 Click the [Store] button.
The color data displayed in the Work window 
area will appear in the Store Window area.

First Scan Data
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12 Designate three or more corresponding 
points. Set the corresponding points in 
the Work window area and then store 
window alternately. When the corre-
sponding points have been designated 
properly, the red frame will turn to blue.

11 Click the [Scan] button.
At this time, the data in the Work window area 
does not correspond to the one in the Store 
window area, so a red frame is displayed.

• Each time corresponding points are designated, 
registration among data is performed.

• If the [Auto Store] checkbox has been checked, 
proceed to Step 13 after the corresponding points 
are designated properly.

Memo

Registration with 1 pair of corresponding points must be 
used for objects with characteristic shape.
Since registration may not be performed successfully for 
objects with non-characteristic shape (e.g. flat planes, cy-
lindrical surfaces), using 3 pairs of corresponding points 
is recommended

If desired points are set by left-clicking them, 
registration will be performed each time 3 or 
more pairs of corresponding points are set. 
By using middle button or left button + [Shift] 
button, registration can be performed when 1 
or more pairs of corresponding points are set.

Left : Sets a point.
  (Registration is performed using 3 or more pairs of corresponding points) 

Middle  : Sets a point.
([Shift] + Left)   (Registration is performed using 1 or more pairs of corresponding points) 

Right  : Points in a Work window area or Store window area can be de-
leted by clicking them in the reverse order in which they were set.

RED

3
5

2

4

6

Blue

1
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15 Click the [OK] button.
The data displayed in the element view win-
dow by the Store function will remain as is.

13 Click the [Store] button.

• This step is not necessary if the [Auto Store] 
checkbox has been checked.

The data displayed in the Work window area 
will appear in the Store window area. If the 
corresponding points have been properly des-
ignated, all the stored data will be displayed 
in 3-D in the element view window after it is 
registrated and three-dimensionalized.

• If [Save Raw Data] checkbox in [File-Import 
-Digitizer-One Scan-Option] dialog box has been 
checked, [Save As] dialog box will be displayed. 
The data comprised of multiple shots will be 
saved together with the registration conversion 
parameters as a single piece of data (CDK).
q Enter the desired file name.
w Click the [Save] button.

Note
The	file	name	must	consist	of	alphanumeric	characters	
only.

• Clicking the [Cancel] button will delete the ele-
ments that were displayed in the store window 
when the [Store] button is clicked at the end of 
execution of this command.

14 Repeat Steps 10 to 13 until the desired 
corresponding points are designated.

1 2
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Parameters for [File-Import-Digitizer-One Scan]  Dialog Box

AF Executes auto-focus.
Note
This	parameter	is	effective	only	when	VIVID	9i	is	connected.

Distance Checking this checkbox enables distance setting.
Note
This	parameter	is	effective	only	when	VIVID	9i	is	connected.

Intensity Checking this checkbox enables LD and Gain setting.
• LD:  Sets the laser power.
• Gain: Sets the gain. The gain cannot be set if the “Standard” scan mode has been selected.
Note
This	parameter	is	effective	only	when	VIVID	9i	is	connected.

Scan Performs a scan.
Note
This	parameter	is	effective	only	when	VIVID	9i	is	connected.

Import CDK Imports the stored data (CDK) that was scanned by the VIVID 9i.
If data containing coordinate conversion parameters is imported, it will be stored automatically 
even though it contains multiple scan data. In the case of data that has been stored, only the first 
scan data will be imported.

Color Read Takes a color shot. Clicking this button at the end of scan will take a color shot again and display 
the updated color image.
Note
This	button	is	effective	if	the	[Use	Color]	checkbox	is	checked.

Edit Clicking this button enables you to delete the area that is not necessary for threedimensionalization 
by specifying it in the Work window using the mouse.

Auto Store If this checkbox is checked, data save will be performed automatically when corresponding points 
are designated in the Work and Store window areas.

Store Registers the data present in the Work window area as store data, puts it into three-dimensional 
form and displays it in the element view window.

Mono/Color/Pitch Switches display mode for the data currently displayed in the Work window area.
• Mono: The current image is displayed in monochrome. This parameter is effective only when 

VIVID 9i is connected.
• Color: The color data acquired from the scan is displayed.
• Pitch: The color display is done in accordance with the distance data from Near to Far.

Angle Rotates the rotary stage to the desired angle using the slide bar.
This item is displayed when the rotary stage has been initialized successfully.

Prev/Next Switches from one stored data to another.
[Prev] button: Displays the previous data.
[Next] button: Displays the next data.

Delete Deletes the stored data currently displayed in the Work or Store window area. The corresponding 
elements in the element view window are also deleted at the same time.

View Displays/hides the data currently displayed in the Store window area into the element view win-
dow.

OK Keeps the element data created during command execution and exits the File-Import-Digitizer-
One Scan command.
Note
If	the	[Save	Raw	Data]	checkbox	is	checked,	the	data	save	dialog	box	is	displayed.

Cancel Exits the File-Import-Digitizer-One Scan command.
The element data created during command execution will be deleted.

Option Displays the [File-Import-Digitizer-One Scan-Option] dialogbox.

Calibration Executes the Calibration command and calibrates the VIVID 9i.
Note
Have	the	Field	Calibration	System	ready.

Ref.  For details on user calibration, refer to VIVID 9i Instruction Manual.
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Parameters for [File-Import-Digitizer-One Scan-Option] Dialog Box

Scan Parameter

Mode • Standard: The Filter settings are fixed to H.Q. & N.F.
  The settable distance range is from 600 to 1,000 mm.
  The Gain value is fixed at 0.
• Extend: The Filter settings are fixed to Noise Filter (N.F.).
  The settable distance range is from 500 to 2,500 mm.
• User: The Filter settings can be user-defined.
  The settable distance range is from 500 to 2,500 mm.

Digitizer’s Parameter • GET: Loads the setting parameters from VIVID 9i and uses them as parameters for this 
command.

• SET: Saves the parameters set by this command to VIVID 9i as the setting parameters.

Number of Scans Sets the number of shots to expand the dynamic range.
Increasing the number of shots reduces data loss.

Brightness Checking this checkbox enables you to set the brightness of the image.

Use Color Checking this checkbox takes a color shot when a scan is made.

Log Performs log correction for the color data if this checkbox is checked. This correction is used to 
make neutral colors brighter.

Dark Performs dark correction for the color data if this checkbox is checked. This correction is used 
when lines are noticeable in the color image.

Convert Parameter

Save Raw Data Checking this checkbox displays the data save dialog at the end of the File-Import-Digitizer-
One Scan command, allowing you to save the data.

Reduction Rate Used to select the number of data points to be read from “1/1”, “1/4”, “1/9”, “1/16” and “Adaptive”.

Filter • None:   Performs no correction for points when reading data. This can be set for 
User mode only.

• Noise Filter(N.F.): Reduces noise in points when reading data.
• High Quarity(H.Q.): Deletes low-reliable data when reading data.
• H.Q. & N.F.:  Reduces noise in points and deletes low-reliable data when reading data.

Note
In	the	case	of	low-reliable	data,	areas	with	excessively	high	laser	power	are	displayed	in	light	gray,	and	
those	with	excessively	low	laser	power	are	displayed	in	dark	gray.

Fill Holes If “ON” is selected, points are generated in the holes that were produced as a loss of data so that 
the holes are filled.

Remove Select the data to be deleted when reading data.

• None:   Outputs the data without performing specific processing.
• Boundary (B.): Outputs the data after deleting boundary points.
• 5deg & B./10dwg & B./15deg. & B./20deg & B.:

Outputs the data after deleting the points present inside and at the bound-
ary of the polygons that are angled within approximately 5, 10, 15 and 20 
degrees to the vector of the line of view.

Stage Parameter Select the Port and Model to be used and click on the [Apply] button. The rotary stage will be 
initialized. If initialization is successful, the rotary stage can be controlled by using the Angle 
slide bar in the [File-Import-Digitizer-One Scan] dialog box.

Default Restores the default parameter settings.

OK Closes the [File-Import-Digitizer-One Scan-Option] dialog box.
The settings will be set.

Cancel Closes the [File-Import-Digitizer-One Scan-Option] dialog box.
The settings will be cancelled.
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Performing Step Scan with the VIVID 9i

This command is used to cause the VIVID 9i to make multiple shots of the object by controlling the rotary 
stage remotely from this software. Registration of multiple scan data can be performed using the Calibration 
Chart for extract center of rotation.
Once registration is complete, the data can be saved together with the coordinate conversion parameters pr 
vided for registration as a single data file (CDK). The data is then registrated and three-dimensionalized based
upon the saved coordinate conversion parameters using the File-Import commands.

Warning

Never stare into the laser emitting window.

Do not place a lens, mirror or optical element in the passage of the laser beam. Doing so may converge the 
laser beam, resulting in damage to your eyes, burns or fire. To prevent the above accidents, make sure that a 
wall or similar which can block the laser beam is located behind the object.

n When Using Only the Rotating Stage

 Operating Procedure 

1 When using VIVID 9i for the first time 
or when the lens has been exchanged, 
field calibration must be performed us-
ing a Field Calibration System.
Place a Field Calibration System that is suitable 
for the lens to be used, and click the [Calibration] 
button in the [File-Import-Digitizer-Step Scan] 
dialog box to start field calibration.

Memo

• The calibration chart is an accessory of the rotating stage set.
• Before performing the procedure below, make sure that 

the digitizer you are going to use is selected by the File 
– Select Digitizer command.

Ref.  For details of the File-Select	Digitizer command, 
refer to page 144.

Note
User	calibration	must	also	be	performed	when	using	
VIVID	9i	after	long	periods	of	non-use	or	when	exces-
sive	changes	in	the	environment	(temperature,	humid-
ity)	have	occurred.

Ref.  For details on user calibration, refer to VIVID 9i 
Instruction Manual.

2 From the [File] menu, select [Import], 
[Digitizer] and then [Step Scan].
The [File-Import-Digitizer-Step Scan] dialog 
box will appear.

• The monochrome monitor image captured by the VIVID 
9i will appear in the Work window area of the dialog box.

• If the Model folder contains the Chart data that is consid-
ered to be appropriate, it will be imported automatically.
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3 Place the object on the rotating stage.

4 To display the object in the middle of the 
Work window area, change the position 
of the object or move the VIVID 9i back 
and forth to change the view angle.

Memo

If necessary, replace the lens attached to the VIVID 9i. If 
the lenses are changed, carry out field calibration using 

the Field Calibration System.

5 Click the [Option] button.
The [File-Import-Digitizer-Step Scan-Option] 
dialog box will appear.

Memo

• If rotary stage has already been used and if changing 
settings is not required, initialization of the rotary stage 
can be performed by clicking on the [Stage Apply] but-
ton in the [File-Import-Digitizer-Step Scan] dialog box.  
In this case, proceed to Step 9.
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6 Set optional parameters.

Item Explanation

Scan Parameter Sets the settings for scanning.

Convert Parameter Sets the settings for three-
dimensionalization.

Stage Parameter Select the rotary stage to be 
used.

[Default] button Clicking this restores the 
default settings.

Ref.  For details, refer to the parameters (P.49) for [File-
Import-Digitizer-Step Scan-Option] dialog box.

7 Click the [Apply] button to check 
whether the rotary stage has been ini-
tialized successfully.
If the rotary stage has been initialized success-
fully, the [Scan] button will be effective.
• If initialization is not successful, turn off the 

power to the rotary stage power, turn it on again, 
and then click the [Apply] button.

• Select “Free” for [Rotation Step] in [Stage Param-
eter] field, and click [Apply]. If the stage has been 
recognized properly, a stage slide bar and [Chart 
Scan] button will be displayed at the bottom of 
the work window when the [File-Import-Digi-
tizer-Step Scan-Option] dialog box is closed.

8 After necessary settings are made, 
click the [OK] button.
The settings will be set and the [File-Import-
Digitizer-Step Scan-Option] dialog box will 
close.

• If the rotary stage has already been used and if there 
is no need to change the settings, initialization of the 
rotary stage can be performed by clicking on the [Stage 
Apply] button in the [File-Import-Digitizer-Step Scan] 
dialog box instead of the [File-Import-Digitizer-Step 
Scan-Option] dialog box.
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9 Place the Calibration Chart on the ro-
tating stage and scan the Calibration 
Chart.
Position the chart with the black line facing 
the VIVID, and place it on the rotating stage so 
that both entire side surfaces are observed in 
the viewfinder.

Memo

If it is not possible to perform calibration using calibra-
tion chart S, use calibration chart M.

• This step is not necessary if the Calibration Chart 
data has already been imported when this dialog 
box is opened.

• To acquire data from the object first then acquire 
the calibration chart data, perform steps 9 and 10 
after completing step 15. In this case, select cur-
rent chart angle from [Current Angle] and click 
[Scan] button, or click [Chart Scan] button to 
acquire chart data. 
 • The [Chart Scan] button appears when “Free” 

is selected for [Rotation Step] in  [File-Import-
Digitizer-One Scan-Option] dialog box.

• Steps 9 and 10 are not necessary when importing 
existing the Calibration Chart data (i.e. data that 
has coordinate parameters). Clicking the [Import 
CDK] button will open the file read dialog box.

  The Calibration Chart data (chart****.cdk) that 
has been saved can be imported.
q Select the file to be imported.
w Click on the [Open] button.

10 Click the [Scan] button.
The Calibration Chart will be scanned.
When the data is recognized as Calibration 
Chart data successfully:

q The Calibration Chart data will be stored under 
the file name of chart****.cdk (“****” are the 
last four digits of the main unit’s serial num-
ber) in the Model folder.

w The data acquired from the subsequent scans 
will be coordinate-converted around the rota-
tional axis.

e The [AutoScan] checkbox will be displayed.

• An error message will be displayed if the data is 
not recognized as the Calibration Chart data suc-
cessfully.

• When “Free” has been selected using the [Rota-
tion Step] of the [Stage Parameter], please use the 
[Chart Scan] button instead of the [Scan] button.

Note
Make	sure	that	the	acquired	range	image	looks	like	
the	good	example	given	below.	If	it	resembles	the	bad	
example,	click	the	[Scan]	button	again	to	re-scan	the	
calibration	chart.

Calibration chart S

Good example Bad example

1

2
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11 Click the [Scan] button to acquire the 
first scan data.
A scan will start, and a color image will be 
displayed in the Work window area.

Memo

If  [Use Color] is not checked (i.e. no check mark is 
shown), The scan data has no color image data, and a gray-
scale image will be displayed instead of a color image.

• If the [Auto Scan] checkbox is checked, the 
second and subsequent scans will be carried out 
automatically.

• If the [Auto Store] checkbox is checked, a store 
will be carried out automatically at the end of 
scan.

• Clicking on the following radio buttons will make 
a change to the image displayed in the Work win-
dow area. The data acquired during the scan will 
remain unchanged.

Item Explanation

[Mono] radio 
button

The current image is displayed in 
monochrome.

[Color] radio 
button

The color image acquired from 
the scan is displayed.

[Pitch] radio 
button

The distance data is displayed 
in the color that is shown in the 
Near-Far color slide bar ac-
cording to the distance from the 
object to the digitizer.

• Clicking the [Color Read] button will re-scan for 
the color data only. The distance data will not be 
updated.

• Clicking the [Edit] button enables you to delete 
the area that is not necessary for three-dimen-
sionalization by specifying it using the mouse. 
Messages will appear at the bottom of the Work 
window area as shown right, so follow them to 
operate the mouse.

  Click the [Edit] button again to exit the edit mode.

• Switch to pitch display screen, and right-click on 
desired position in the screen while holding down 
[CTRL] key. The Z-axis coordinates at that posi-
tion (distance from VIVID 9i) will appear.

  To specify distance manually and perform mea-
surement, this value must be used.
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12 Click on the [Store] button.
The color data displayed in the Work window 
area will appear in the Store window area.

Note
The	[Store]	button	will	be	disabled	(displayed	in	gray)	
when	clicked	once.	This	will	prevent	the	same	work	
window	area’s	data	from	being	stored	repeatedly.

• By clicking the [Store] button, each shot data 
other than the Calibration Chart data will be 
coordinate-converted around the rotational axis 
and displayed three-dimensionally in the element 
view window. If a setting other than “Free” is 
selected for [Rotation Step], the rotary stage will 
rotate at specified angles automatically. The angle 
shown in [Current Angle] will automatically be 
updated at the same time.

• This step is not necessary if the [Auto Store] 
checkbox has been checked.

13 Click the [Scan] button to acquire the 
second data.
Note
If	“Free”	is	selected	for	[Rotation	Step]	in	the	[File-Im-
port-Digitizer-Step	Scan-Option]	dialog	box,	the	rotary	
stage	must	be	rotated	to	the	desired	angle	using	the	slide	
bar	in	advance.

14 Click the [Store] button.
The data displayed in the Work window area 
will appear in the Store window area. If the 
corresponding points have been properly des-
ignated, all the stored data will be displayed 
in 3-D in the element view window after it is 
registrated and three-dimensionalized.

• This step is not necessary if the [Auto Store] 
checkbox has been checked.
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15 Repeat Steps 13 to 14 until the desired 
corresponding points are designated.

16 Click the [OK] button.
The data displayed in the element view win-
dow by the Store function will remain as is.

• If [Save Raw Data] checkbox in [File-Import 
-Digitizer-Step Scan-Option] dialog box has been 
checked, [Save As] dialog box will be displayed.  
The data comprised of multiple shots will be 
saved together with the registration conversion 
parameters as a single piece of data (CDK).
q Enter the desired file name.
w Click the [Save] button.

Note
The	file	name	must	consist	of	alphanumeric	characters	
only.

• Clicking on the [Cancel] button will delete the 
elements that were displayed in the Store window 
area when the [Store] button is clicked at the end 
of execution of this command.

1 2
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Parameters for [File-Import-Digitizer-Step Scan]  Dialog Box

AF Executes auto-focus.
Note
This	parameter	is	effective	only	when	VIVID	9i	is	connected.

Distance Checking this checkbox enables distance setting.

Intensity Checking this checkbox enables LD and Gain setting.

• LD:  Sets the laser power. 
• Gain:  Sets the gain. The gain cannot be set if the “Standard” scan mode has been selected.

Auto Scan Checking this checkbox causes scan, store and stage control operations to be automatically　
performed sequentially.

Scan Performs a scan.
Note
This	parameter	is	effective	only	when	VIVID	9i	is	connected.

Import CDK Imports the stored data (CDK) that was scanned by the VIVID 9i.

Color Read Takes a color shot. Clicking this button at the end of scan will take a color shot again and display 
the updated color image.
Note
This	button	is	effective	if	the	[Use	Color]	checkbox	is	checked.

Edit Clicking this checkbox enables you to delete the area that is not necessary for threedimensionaliza-
tion by specifying it in the work window using the mouse.

Auto Store Checking this checkbox performs store operation automatically at the end of scan operation.

Store Registers the data p resent in the Work window area as store data, puts it into three-dimensional 
form and displays it in the element view window.

Mono/Color/Pitch Switches display mode for the data currently displayed in the Work window area.

• Mono:  The current image is displayed in monochrome. This parameter is effective only when 
VIVID 9i is connected.

• Color:  The color data acquired from the scan is displayed.
• Pitch:  The color display is done in accordance with the distance data from Near to Far.

Current Angle The current step angle is displayed. Normally, the angle is updated when a store operation is car-
ried out, so additional operations are not necessary. When the step angle has been changed to the 
desired angle manually, data scan can be performed at the new step angles.
Memo

This item is not displayed if “Free” is selected for [Rotation Step].

Angle Rotates the rotary stage to the desired angle using the slide bar.
This item is displayed when the rotary stage has been initialized successfully.

Chart Scan Used to scan the Calibration Chart data.
Memo

This item is displayed if “Free” is selected for [Rotation Step].

Stage Apply Initializes the rotary stage.

Prev/Next Switches from one stored data to another.

[Prev] button: Displays the previous data.
[Next] button: Displays the next data.

Delete Deletes the stored data currently displayed in the Work or Store window area. The corresponding 
elements in the element view window are also deleted at the same time.

View Displays/hides the data currently displayed in the Store window area into the element view window.

OK Keeps the element data created during command execution and exits the File-Import-Digitizer-
One Scan command.

Note
If	the	[Save	Raw	Data]	checkbox	is	checked,	the	data	save	dialog	box	is	displayed.

Cancel Exits the File-Import-Digitizer-One Scan command.
The element data created during command execution will be deleted.

Option Displays the [File-Import-Digitizer-Step Scan-Option] dialogbox.

Calibration Executes the Calibration command and calibrates the VIVID 9i.

Note
Have	the	Field	Calibration	System	ready.

Ref.  For details on user calibration, refer to VIVID 9i Instruction Manual.
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Parameters for [File-Import-Digitizer-Step Scan-Option] Dialog Box

Scan Parameter

Mode • Standard: The Filter settings are fixed to H.Q. & N.F.
   The settable distance range is from 600 to 1,000 mm.
   The Gain value is fixed at 0.
• Extend:  The Filter settings are fixed to Noise Filter (N.F.).
   The settable distance range is from 500 to 2,500 mm.
• User:  The Filter settings can be user-defined.
   The settable distance range is from 500 to 2,500 mm.

Digitizer’s Parameter • GET: Loads the setting parameters from VIVID 9i and uses them as parameters for this 
command.

• SET: Saves the parameters set by this command to VIVID 9i as the setting parameters.

Number of Scans Sets the number of shots to expand the dynamic range.
Increasing the number of shots reduces data loss.

Brightness Checking this checkbox enables you to set the brightness of the image.

Use Color Checking this checkbox takes a color shot when a scan is made.

Log Performs log correction for the color data if this checkbox is checked. This correction is used to 
make neutral colors brighter.

Dark Performs dark correction for the color data if this checkbox is checked. This correction is used 
when lines are noticeable in the color image.

Convert Parameter

Save Raw Data Checking this checkbox displays the data save dialog at the end of the  File-Import-Digitizer-
Step Scan command, allowing you to save the data.

Reduction Rate Used to select the number of data points to be read from “1/1”, “1/4”, “1/9”, “1/16” and “Adaptive”.

Filter • None:   Performs no correction for points when reading data. This can be set for 
User mode only.

• Noise Filter (N.F.): Reduces noise in points when reading data.
• High Quarity (H.Q.): Deletes low-reliable data when reading data.
• H.Q. & N.F.:  Reduces noise in points and deletes low-reliable data when reading data.

Note
In	the	case	of	low-reliable	data,	areas	with	excessively	high	laser	power	are	displayed	in	light	gray,	and	
those	with	excessively	low	laser	power	are	displayed	in	dark	gray.

Fill Holes If “ON” is selected, points are generated in the holes that were produced as a loss of data so that 
the holes are filled.

Remove Select the data to be deleted when reading data.

• None:  Outputs the data without performing specific processing.
• Boundary (B.): Outputs the data after deleting boundary points.
• 5deg & B./10dwg & B./15deg. & B./20deg & B.:

Outputs the data after deleting the points present inside and at the boundary of 
the polygons that are angled within approximately 5, 10, 15 and 20 degrees to the 
vector of the line of view.

Stage Parameter Select the Port and Model to be used and click on the [Apply] button. The rotary stage will be 
initialized. If initialization is successful, the rotary stage can be controlled in the [File-Import-
Digitizer-Step Scan] dialog box.

Rotation Step Select rotating angle for each step of rotary stage.

Default Restores the default parameter settings.

OK Closes the [File-Import-Digitizer-Step Scan-Option] dialog box.
The settings will be set.

Cancel Closes the [File-Import-Digitizer-Step Scan-Option] dialog box.
The settings will be cancelled.
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Performing One Scan with the VIVID 910

This command is used to cause the VIVID 910 (VI-910) to scan the object one scan at a time using the remote 
control function of this software. Registration of multiple scan data can be performed by manually designating 
their corresponding points.

Warning

Never stare into the laser emitting window.

Do not place a lens, mirror or optical element in the passage of the laser beam. Doing so may converge the 
laser beam, resulting in damage to your eyes, burns or fire. To prevent the above accidents, make sure that a 
wall or similar which can block the laser beam is located behind the object.

Memo

Before performing the procedure below, make sure that 
the digitizer you are going to use is selected by the File 
– Select Digitizer command.

Ref.  For details of the File	–	Select	Digitizer	command, 
refer to page 144.

 Operating Procedure 

1 From the [File] menu, select [Import], 
[Digitizer] and then [One Scan].
The [File-Import-Digitizer-One Scan] dialog 
box will appear.

• The monochrome monitor image captured by the 
VIVID 910 will appear in the Work window area 
of the dialog box.

3 To display the object in the middle of the 
Work window area , change the posi-
tion of the object or move the instrument 
back and forth to change the view angle.

2 Set an object in place.
If you are going to use the rotating stage, 
place the object on it.

Memo

If necessary, replace the lens attached to the VIVID. 

Download from Www.Somanuals.com. All Manuals Search And Download.



51

Chapter 2
File
Menu

910

File – Import – Digitizer – One Scan (When VIVID 910 is Selected)

4 Click the [Option] button.
The [File-Import-Digitizer-One Scan-Option] 
dialog box will appear.

5 Set optional parameters.

Item Explanation

Scan Parameter Sets the settings for scanning.

Convert Parameter Sets the settings for three-
dimensionalization.

Stage Parameter Select the rotary stage to be 
used.

[Default] button Clicking this restores the 
default settings.

Ref.  For details, refer to parameters (P.57) for [File-Im-
port-Digitizer-One Scan-Option] dialog box.

• Select the desired stage in [Stage Parameter]  
field, and click on the [Apply] button. If the stage 
has been recognized properly, a stage slide bar 
will be displayed at the bottom of the work win-
dow when the [File-Import-Digitizer-One Scan-
Option] dialog box is closed.

• If initialization is not successful, turn off the 
power to the rotary stage power, turn it on again, 
and then click on the [Apply] button.

6 After necessary settings are made, 
click on the [OK] button.
The settings will be set and the [File-Import-
Digitizer-One Scan-Option] dialog box will 
close.
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7 Click on the [Scan] button to acquire 
the first scan data.
A scan will start, and a color image will be 
displayed in the Work window area.

Memo

If [Use Color] is not checked (i.e. no check mark is 
shown), the scan data has no color image data, and a gray-
scale image will be displayed instead of a color image.

• Clicking on the following radio buttons will 
make a change to the image displayed in the work 
window. The data acquired during the scan will 
remain unchanged.

Item Explanation

[Mono] radio 
button

The current image is displayed in 
monochrome.

[Color] radio 
button

The color image acquired from 
the scan is displayed.

[Pitch] radio 
button

The distance data is displayed 
in the color that is shown in the 
Near-Far color slide bar ac-
cording to the distance from the 
object to the digitizer.

• Clicking the [Color Read] button will re-scan for 
the color data only. The distance data will not be 
updated.

• Clicking the [Edit] button enables you to delete 
the area that is not necessary for three-dimen-
sionalization by specifying it using the mouse. 
Messages will appear at the bottom of the Work 
window area as shown right, so follow them to 
operate the mouse.

  Check the [Edit] button again to exit the edit mode.

• Switch to pitch display screen, and right-click on 
desired position in the screen while holding down 
[CTRL] key. The Z-axis coordinates at that posi-
tion (distance from VIVID 9i) will appear.

  To specify distance manually and perform mea-
surement, this value must be used.
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Note
The	[Store]	button	will	be	disabled	(displayed	in	gray)	
when	clicked	once.	This	will	prevent	the	same	Work	
window	area’s	data	from	being	stored	repeatedly.

9 Acquire the second scan data. Move 
the object so that 3 pairs of corre-
sponding points or 1 or more pairs of 
corresponding points can be set be-
tween the first scan data and the sec-
ond and subsequent scan data.

8 Click on the [Store] button.
The color data displayed in the Work window 
area will appear in the Store window area.

First Scan Data

Download from Www.Somanuals.com. All Manuals Search And Download.



54

Chapter 2
File
Menu

910

File – Import – Digitizer – One Scan (When VIVID 910 is Selected)

11 Designate three or more corresponding 
points. Set the corresponding points in 
the work window and then store win-
dow alternately. When the correspond-
ing points have been designated prop-
erly, the red frame will turn to blue.

• Each time corresponding points are designated, 
registration among data is performed.

• If the [Auto Store] checkbox has been checked, 
proceed to Step 12 after the corresponding points 
are designated properly.

Memo

Registration with 1 pair of corresponding points must be 
used for objects with characteristic shape.
Since registration may not be performed successfully for 
objects with non-characteristic shape (e.g. flat planes, cy-
lindrical surfaces), using 3 pairs of corresponding points 
is recommended

If desired points are set by left-clicking them, 
registration will be performed each time 3 or 
more pairs of corresponding points are set. 
By using middle button or left button + [Shift] 
button, registration can be performed when 1 
or more pairs of corresponding points are set.

Left : Sets a point.
  (Registration is performed using 3 or more pairs of corresponding points) 

Middle  : Sets a point.
([Shift] + Left)   (Registration is performed using 1 or more pairs of corresponding points) 

Right  : Points in a Work window area or Store window area can be de-
leted by clicking them in the reverse order in which they were set.

3

5

2

4

6

Blue

1

10 Click on the [Scan] button.
At this time, the data in the Work window area 
does not correspond to the one in the Store 
window area, so a red frame is displayed.

RED
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14 Click the [OK] button.
The data displayed in the element view win-
dow by the Store function will remain as is.

12 Click on the [Store] button.

• This step is not necessary if the [Auto Store] 
checkbox has been checked.

The data displayed in the Work window area 
will appear in the Store window area. If the 
corresponding points have been properly des-
ignated, all the stored data will be displayed 
in 3-D in the element view window after it is 
registrated and three-dimensionalized.

• If [Save Raw Data] checkbox in [File-Import 
-Digitizer-One Scan-Option] dialog box has been 
checked, [Save As] dialog box will be displayed. 
The data will be saved as a CDM file.
q Enter the desired file name.
w Click the [Save] button.

Note
The	file	name	must	consist	of	alphanumeric	characters	
only.

• Clicking on the [Cancel] button will delete the 
elements that were displayed in the store window 
when the [Store] button is clicked at the end of 
execution of this command.

13 Repeat Steps 9 to 12 until the desired 
corresponding points are designated.

1 2
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Parameters for [File-Import-Digitizer-One Scan]  Dialog Box

AF Executes auto-focus.
Note
This	parameter	is	effective	only	when	VIVID	910	is	connected.

Distance Checking this checkbox enables distance setting.
Note
This	parameter	is	effective	only	when	VIVID	910	is	connected.

Intensity Checking this checkbox enables LD and Gain setting.
• LD :  Sets the laser power.
• Gain : Sets the gain. 
Note
This	parameter	is	effective	only	when	VIVID	910	is	connected.

Scan Performs a scan.
Note
This	parameter	is	effective	only	when	VIVID	910	is	connected.

Import CDM Import the saved CDM data.

Color Read Takes a color shot. Clicking this button at the end of scan will take a color shot again and display 
the updated color image.
Note
This	button	is	effective	if	the	[Use	Color]	checkbox	is	checked.

Edit Clicking this checkbox enables you to delete the area that is not necessary for threedimensionaliza-
tion by specifying it in the Work window area using the mouse.

Auto Store If this checkbox is checked, data save will be performed automatically when corresponding points 
are designated in the Work and Store window areas.

Store Registers the data present in the Work window area as store data, puts it into three-dimensional 
form and displays it in the element view window.

Mono/Color/Pitch Switches display mode for the data currently displayed in the Work window area.
• Mono : The current image is displayed in monochrome. This parameter is effective only when 

VIVID 9i is connected.
• Color : The color data acquired from the scan is displayed.
• Pitch : The color display is done in accordance with the distance data from Near to Far.

Angle Rotates the rotary stage to the desired angle using the slide bar.
This item is displayed when the rotary stage has been initialized successfully.

Prev/Next Switches from one stored data to another.
[Prev] button :  Displays the previous data.
[Next] button : Displays the next data.

Delete Deletes the stored data currently displayed in the Work or Store window area. The corresponding 
elements in the element view window are also deleted at the same time.

View Displays/hides the data currently displayed in the Store window area into the element view window.

OK Keeps the element data created during command execution and exits the File-Import-Digitizer-
One Scan command.
Note
If	the	[Save	Raw	Data]	checkbox	is	checked,	the	data	save	dialog	box	is	displayed.

Cancel Exits the File-Import-Digitizer-One Scan command.
The element data created during command execution will be deleted.

Option Displays the [File-Import-Digitizer-One Scan-Option] dialogbox.
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Parameters for [File-Import-Digitizer-One Scan-Option] Dialog Box

Scan Parameter

Mode • Select the scanning mode :  FINE or FAST

Scan Parameter • Load : Loads the setting parameters and uses them as parameters for this command.
• Save : Saves the parameters set by this command as the setting parameters.

Brightness Checking this checkbox enables you to set the brightness of the image.

Use Color Checking this checkbox takes a color shot when a scan is made.

Log Performs log correction for the color data if this checkbox is checked. This correction is used to 
make neutral colors brighter.

Dark Performs dark correction for the color data if this checkbox is checked. This correction is used 
when lines are noticeable in the color image.

Convert Parameter

Save Raw Data Checking this checkbox displays the data save dialog at the end of the File-Import-Digitizer-
One Scan command, allowing you to save the data.

Reduction Rate Used to select the number of data points to be read from “1/1”, “1/4”, “1/9”, “1/16” and “No Poly-
gon”.

Filter • None :   Performs no correction for points when reading data. 
• Noise Filter(N.F.) : Reduces noise in points when reading data.
• High Quarity(H.Q.) : Deletes low-reliable data when reading data.
• H.Q. & N.F. : Reduces noise in points and deletes low-reliable data when reading data.

Fill Holes If “ON” is selected, points are generated in the holes that were produced as a loss of data so that 
the holes are filled.

Remove Select the data to be deleted when reading data.

• None :   Outputs the data without performing specific processing.
• Boundary (B.) : Outputs the data after deleting boundary points.
• 5deg & B./10dwg & B./15deg. & B./20deg & B. :

Outputs the data after deleting the points present inside and at the bound-
ary of the polygons that are angled within approximately 5, 10, 15 and 20 
degrees to the vector of the line of view.

Hardware Parameter • Vertical :   Check this checkbox if using the VIVID unit in vertical orientation.
• Horizontal :  Check this checkbox if using the VIVID unit in horizontal orientation.

Stage Parameter Select the Port and Model to be used and click on the [Apply] button. The rotary stage will be 
initialized. If initialization is successful, the rotary stage can be controlled by using the Angle 
slide bar in the [File-Import-Digitizer-One Scan] dialog box.

Default Restores the default parameter settings.

OK Closes the [File-Import-Digitizer-One Scan-Option] dialog box.
The settings will be set.

Cancel Closes the [File-Import-Digitizer-One Scan-Option] dialog box.
The settings will be cancelled.
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Performing Step Scan with the VIVID 910

This command is used to cause the VIVID 910 (VI-910) to make multiple shots of the object by controlling 
the rotary stage remotely from this software. Registration of multiple scan data can be performed using the Calibra-
tion Chart for extract center of rotation.

Warning

Never stare into the laser emitting window.

Do not place a lens, mirror or optical element in the passage of the laser beam. Doing so may converge the 
laser beam, resulting in damage to your eyes, burns or fire. To prevent the above accidents, make sure that a 
wall or similar which can block the laser beam is located behind the object.

n When Using Only the Rotating Stage

 Operating Procedure 

1 From the [File] menu, select [Import], 
[Digitizer] and then [Step Scan].
The [File-Import-Digitizer-Step Scan] dialog 
box will appear.

Memo

• The calibration chart is an accessory of the rotating 
stage set.

• Before performing the procedure below, make sure that 
the digitizer you are going to use is selected by the File 
– Select Digitizer command.

Ref.  For details, refer to parameters (P.144) for [File-
Import-Digitizer-Step Scan-Option] dialog box.

• The monochrome monitor image captured by the 
VIVID 910 will appear in the Work window area 
of the dialog box.

• If the Model folder contains the Chart data that is 
considered to be appropriate, it will be imported 
automatically.

Download from Www.Somanuals.com. All Manuals Search And Download.



59

Chapter 2
File
Menu

910

File – Import – Digitizer – Step Scan (When VIVID 910 is Selected)

2 Place the object on the rotating stage.

3 To display the object in the middle of the 
Work window area, change the position 
of the object or move the VIVID 9i back 
and forth to change the view angle. Memo

If necessary, replace the lens attached to the VIVID 910. 

4 Click the [Option] button.
The [File-Import-Digitizer-Step Scan-Option] 
dialog box will appear.

Memo

• If rotary stage has already been used and if changing 
settings is not required, initialization of the rotary stage 
can be performed by clicking on the [Stage Apply] but-
ton in the [File-Import-Digitizer-Step Scan] dialog box.  
In this case, proceed to Step 8
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5 Set optional parameters.

Item Explanation

Scan Parameter Sets the settings for scanning.

Convert Parameter Sets the settings for three-
dimensionalization.

Stage Parameter Select the rotary stage to be 
used.

[Default] button Clicking this restores the 
default settings.

Ref.  For details, refer to the parameters (P.66) for [File-
Import-Digitizer-Step Scan-Option] dialog box.

6 Click the [Apply] button to check 
whether the rotary stage has been ini-
tialized successfully.
If the rotary stage has been initialized success-
fully, the [Scan] button will be effective.
• If initialization is not successful, turn off the 

power to the rotary stage power, turn it on again, 
and then click on the [Apply] button.

• Select “Free” for [Rotation Step] in [Stage Param-
eter] field, and click [Apply]. If the stage has been 
recognized properly, a stage slide bar and [Chart 
Scan] button will be displayed at the bottom of 
the work window when the [File-Import-Digitizer-
Step Scan-Option] dialog box is closed.

7 After necessary settings are made, 
click the [OK] button.
The settings will be set and the [File-Import-
Digitizer-Step Scan-Option] dialog box will 
close.

• If the rotary stage has already been used and if there 
is no need to change the settings, initialization of the 
rotary stage can be performed by clicking on the [Stage 
Apply] button in the [File-Import-Digitizer-Step Scan] 
dialog box instead of the [File-Import-Digitizer-Step 
Scan-Option] dialog box.
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8 Place the Calibration Chart on the ro-
tating stage and scan the Calibration 
Chart.
Position the chart with the black line facing 
the VIVID, and place it on the rotating stage so 
that both entire side surfaces are observed in 
the viewfinder.

Memo

If it is not possible to perform calibration using calibra-
tion chart S, use calibration chart M.

• This step is not necessary if the Calibration Chart 
data has already been imported when this dialog 
box is opened.

• To acquire data from the object first then acquire 
the calibration chart data, perform steps 8 and 9 
after completing step 14. In this case, select cur-
rent chart angle from [Current Angle] and click 
[Scan] button, or click [Chart Scan] button to 
acquire chart data. 
 • The [Chart Scan] button appears when “Free” 

is selected for [Rotation Step] in  [File-Import-
Digitizer-Step Scan-Option] dialog box.

Note
After	changing	the	setting	orientation	at	Convert	Pa-
rameter	–	Hardware	Parameter	on	the	[File-Import-
Digitizer-Step	Scan-Option]	dialog	box,	the	chart	data	
must	be	acquired	again	before	measuring.

• Steps 9 and 10 are not necessary when importing 
existing the Calibration Chart data (i.e. data that 
has coordinate parameters). Clicking on the [Im-
port CDM] button will open the file read dialog 
box.

  The Calibration Chart data (chart****.cdm) that 
has been saved can be imported.
q Select the file to be imported.
w Click on the [Open] button.

9 Click the [Scan] button.
The Calibration Chart will be scanned.
When the data is recognized as Calibration 
Chart data successfully:

q The Calibration Chart data will be stored under 
the file name of chart****.cdm (“****” are the 
last four digits of the main unit’s serial num-
ber) in the Model folder.

w The data acquired from the subsequent scans 
will be coordinate-converted around the rota-
tional axis.

e The [AutoScan] checkbox will be displayed.

• An error message will be displayed if the data is 
not recognized as the Calibration Chart data suc-
cessfully.

• When “Free” has been selected using the [Rota-
tion Step] of the [Stage Parameter], please use the 
[Chart Scan] button instead of the [Scan] button.

Note
Make	sure	that	the	acquired	range	image	looks	like	
the	good	example	given	below.	If	it	resembles	the	bad	
example,	click	the	[Scan]	button	again	to	re-scan	the	
calibration	chart.

Calibration chart S

Good example Bad example

1

2
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10 Click  the [Scan] button to acquire the 
first scan data.
A scan will start, and a color image will be 
displayed in the Work window area.

Memo

If [Use Color] is not checked (i.e. no check mark is 
shown), the scan data has no color image data, and a gray-
scale image will be displayed instead of a color image.

• If the [Auto Scan] checkbox is checked, the 
second and subsequent scans will be carried out 
automatically.

• If the [Auto Store] checkbox is checked, a store 
will be carried out automatically at the end of 
scan.

• Clicking on the following radio buttons will 
make a change to the image displayed in the work 
window. The data acquired during the scan will 
remain unchanged.

Item Explanation

[Mono] radio 
button

The current image is displayed in 
monochrome.

[Color] radio 
button

The color image acquired from 
the scan is displayed.

[Pitch] radio 
button

The distance data is displayed 
in the color that is shown in the 
Near-Far color slide bar ac-
cording to the distance from the 
object to the digitizer.

• Clicking the [Color Read] button will re-scan for 
the color data only. The distance data will not be 
updated.

• Clicking the [Edit] button enables you to delete 
the area that is not necessary for three-dimen-
sionalization by specifying it using the mouse. 
Messages will appear at the bottom of the Work 
window area as shown right, so follow them to 
operate the mouse.

  Click the [Edit] button again to exit the edit mode.

• Switch to pitch display screen, and right-click on 
desired position in the screen while holding down 
[CTRL] key. The Z-axis coordinates at that posi-
tion (distance from VIVID 910) will appear.

  To specify distance manually and perform mea-
surement, this value must be used.
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11 Click on the [Store] button.
The color data displayed in the Work window  
area will appear in the Store window area.

Note
The	[Store]	button	will	be	disabled	(displayed	in	gray)	
when	clicked	once.	This	will	prevent	the	same	Work	
window	area’s	data	from	being	stored	repeatedly.

• By clicking on the [Store] button, each shot data 
other than the Calibration Chart data will be 
coordinate-converted around the rotational axis 
and displayed three-dimensionally in the element 
view window. If a setting other than “Free” is 
selected for [Rotation Step], the rotary stage will 
rotate at specified angles automatically. The angle 
shown in [Current Angle] will automatically be 
updated at the same time.

• This step is not necessary if the [Auto Store] 
checkbox has been checked.

12 Click on the [Scan] button to acquire 
the second data.
Note
If	“Free”	is	selected	for	[Rotation	Step]	in	the	[File-Im-
port-Digitizer-Step	Scan-Option]	dialog	box,	the	rotary	
stage	must	be	rotated	to	the	desired	angle	using	the	slide	
bar	in	advance.

13 Click on the [Store] button.
The data displayed in the Work window area 
will appear in the Store window area. If the 
corresponding points have been properly des-
ignated, all the stored data will be displayed 
in 3-D in the element view window after it is 
registrated and three-dimensionalized.

• This step is not necessary if the [Auto Store] 
checkbox has been checked.
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14 Repeat Steps 12 to 13 until the desired 
corresponding points are designated.

15 Click the [OK] button.
The data displayed in the element view win-
dow by the Store function will remain as is.

• If [Save Raw Data] checkbox in [File-Import 
-Digitizer-Step Scan-Option] dialog box has been 
checked, [Save As] dialog box will be displayed.  
The data will be saved as a CDM file.
q Enter the desired file name.
w Click the [Save] button.

Note
The	file	name	must	consist	of	alphanumeric	characters	
only.

• Clicking on the [Cancel] button will delete the 
elements that were displayed in the store window 
when the [Store] button is clicked at the end of 
execution of this command.

1 2
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Parameters for [File-Import-Digitizer-Step Scan]  Dialog Box

AF Executes auto-focus.
Note
This	parameter	is	effective	only	when	VIVID	910	is	connected.

Distance Checking this checkbox enables distance setting.

Intensity Checking this checkbox enables LD and Gain setting.

• LD:  Sets the laser power. 
• Gain:  Sets the gain. 

Auto Scan Checking this checkbox causes scan, store and stage control operations to be automatically　
performed sequentially.

Scan Performs a scan.
Note
This	parameter	is	effective	only	when	VIVID	910	is	connected.

Import CDK Import the saved CDM data.

Color Read Takes a color shot. Clicking this button at the end of scan will take a color shot again and display 
the updated color image.
Note
This	button	is	effective	if	the	[Use	Color]	checkbox	is	checked.

Edit Clicking this button enables you to delete the area that is not necessary for three-dimensionalization by 
specifying it in the Work window area using the mouse.

Auto Store Checking this checkbox performs store operation automatically at the end of scan operation.

Store Registers the data p resent in the Work window area as store data, puts it into three-dimensional 
form and displays it in the element view window.

Mono/Color/Pitch Switches display mode for the data currently displayed in the Work window area.

• Mono:  The current image is displayed in monochrome. This parameter is effective only when 
VIVID 910 is connected.

• Color:  The color data acquired from the scan is displayed.
• Pitch:  The color display is done in accordance with the distance data from Near to Far.

Current Angle The current step angle is displayed. Normally, the angle is updated when a store operation is car-
ried out, so additional operations are not necessary. When the step angle has been changed to the 
desired angle manually, data scan can be performed at the new step angles.
Memo

This item is not displayed if “Free” is selected for [Rotation Step].

Angle Rotates the rotary stage to the desired angle using the slide bar.
This item is displayed when the rotary stage has been initialized successfully.

Chart Scan Used to scan the Calibration Chart data.
Memo

This item is displayed if “Free” is selected for [Rotation Step].

Stage Apply Initializes the rotary stage.

Prev/Next Switches from one stored data to another.

[Prev] button: Displays the previous data.
[Next] button: Displays the next data.

Delete Deletes the stored data currently displayed in the Work or Store window area. The corresponding 
elements in the element view window are also deleted at the same time.

View Displays/hides the data currently displayed in the Store window area into the element view window.

OK Keeps the element data created during command execution and exits the File-Import-Digitizer-
One Scan command.

Note
If	the	[Save	Raw	Data]	checkbox	is	checked,	the	data	save	dialog	box	is	displayed.

Cancel Exits the File-Import-Digitizer-One Scan command.
The element data created during command execution will be deleted.

Option Displays the [File-Import-Digitizer-Step Scan-Option] dialogbox.
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Parameters for [File-Import-Digitizer-Step scan-Option] Dialog Box

Scan Parameter

Mode Select the scanning mode : FINE or FAST

Scan Parameter • Load: Loads the setting parameters from VIVID 910 and uses them as parameters for this 
command.

• Save: Saves the parameters set by this command to VIVID 910 as the setting parameters.

Dynamic Range Expan-
sion Mode

If this button is checked, the program takes multiple shots so as to expand the dynamic range and 
reduce data loss. This button is displayed only for the VIVID 910.

Brightness Checking this checkbox enables you to set the brightness of the image.

Use Color Checking this checkbox takes a color shot when a scan is made.

Log Performs log correction for the color data if this checkbox is checked. This correction is used to 
make neutral colors brighter.

Dark Performs dark correction for the color data if this checkbox is checked. This correction is used 
when lines are noticeable in the color image.

Convert Parameter

Save Raw Data Checking this checkbox displays the data save dialog at the end of the File-Import-Digitizer-
Step Scan command, allowing you to save the data.

Reduction Rate Used to select the number of data points to be read from “1/1”, “1/4”, “1/9”, “1/16” and “No Polygon”.

Filter • None :   Performs no correction for points when reading data. This can be set for 
User mode only.

• Noise Filter (N.F.) : Reduces noise in points when reading data.
• High Quarity (H.Q.) : Deletes low-reliable data when reading data.
• H.Q. & N.F. : Reduces noise in points and deletes low-reliable data when reading data.

Fill Holes If “ON” is selected, points are generated in the holes that were produced as a loss of data so that 
the holes are filled.

Remove Select the data to be deleted when reading data.

• None :   Outputs the data without performing specific processing.
• Boundary (B.) :  Outputs the data after deleting boundary points.
• 5deg & B./10dwg & B./15deg. & B./20deg & B.:

 Outputs the data after deleting the points present inside and at the bound 
 ary of the polygons that are angled within approximately 5, 10, 15 and 20  
 degrees to the vector of the line of view.

Hardware Parameter • Vertical :   Check this checkbox if using the VIVID unit in vertical orientation.
• Horizontal :  Check this checkbox if using the VIVID unit in horizontal orientation.

Note
After	changing	the	setting	orientation,	the	Calibration	Chart	data	of	the	rotating	stage	must	be	acquired	
again	before	measuring.

Stage Parameter Select the Port and Model to be used and click the [Apply] button. The rotary stage will be 
initialized. If initialization is successful, the rotary stage can be controlled in the [File-Import-
Digitizer-Step Scan] dialog box.

Rotation Step Select rotating angle for each step of rotary stage.

Default Restores the default parameter settings.

OK Closes the [File-Import-Digitizer-Step Scan-Option] dialog box.
The settings will be set.

Cancel Closes the [File-Import-Digitizer-Step Scan-Option] dialog box.
The settings will be cancelled.
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Importing Data from the Memory Card of VIVID 910

This command is used to remote-control the data stored in the memory card of the VIVID 910 (VI-910).

Note
This command does not operate on step-shot scan data 
in the memory card.

Parameters for [File-Import-Digitizer-PC Card] Dialog Box

File name Displays file names stored in the memory card.

Date Displays the dates on which the files are stored in the memory card.

Size Displays the size of each file (in bytes).

Total ** files Displays the total number of camera data files stored in the memory card.

** MB/ ** MB Displays the unoccupied capacity and total capacity of the memory card.

Memo

• Before performing the procedure below, make sure that 
the digitizer you are going to use is selected by the File 
– Select Digitizer command.

Ref.  For details of the File	–	Select	Digitizer	command, 
refer to page 144.

 Operating Procedure 

1 From the [File] menu, select [Import], 
[Digitizer] and then [PC Card].
The [File-Import-Digitizer-PC Card] dialog box 
will appear.

Memo

• Only the raw image data (.cdm) scanned by the VIVID 
910 (VI-910) or VIVID 900 (VI-900) will be displayed.

• Upper-case file names specified using the camera will 
be converted to lower-case file names when the files are 
imported to this software.

2 Select the file you want to import.
• To perform dark correction for the color data, 

check the [Dark Correction] checkbox.
• To display the preview image, check the [Pre-

view] checkbox (so that a check mark appears in 
the check box). A color image of the selected file 
will be displayed.

Memo

A clock icon will be displayed during loading.
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n Sorting the Files (Sort radio button)
The [Name] and [Date] radio buttons are used to select whether file names are displayed alphabetically or 
by date.

 Operating Procedure 

Before starting the following procedure, make sure that the [File-Import-Digitizer-PC Card] dialog box is 
displayed.

1 Click the [Name] radio button to sort 
the files alphabetically or [Date] radio 
button to sort by date.
Clicking the [Name] radio button will sort the 
files alphabetically, and clicking the [Date] 
radio button will sort them by date.

• When sort is complete, selection state of each file 
in the file list and preview image will be cleared.

n Updating the File List ([Update] button)
The [Update] button is used to load the file names from the memory card to this software and update the 
file list. If the memory card is replaced while the [File-Import-Digitizer-PC Card] dialog box is open, be 
sure to clickthis button to update the file list.

 Operating Procedure 

Before starting the following procedure, make sure that the [File-Import-Digitizer-PC Card] dialog box is 
displayed.

1 Click the [Update] button.
All the file names in the memory card will be 
loaded to the software and a new file list will 
be displayed.

Download from Www.Somanuals.com. All Manuals Search And Download.



69

Chapter 2
File
Menu

910

File – Import – Digitizer – PC Card (When VIVID 910 is Selected)

n Loading the Selected Data ([Load] button)
The [Load] button is used to load the data of the selected file from the memory card to the software.

 Operating Procedure 

Before starting the following procedure, make sure that the [File-Import-Digitizer-PC Card] dialog box is 
displayed.

1 From the file list, select the name of the 
file you want to load.

2 Click the [Load] button.
A dialog box will appear, allowing you to enter 
the desired element name.
The file name in the memory card will be dis-
played as an element name.

3 Change the element name if necessary, 
and set the parameters.

• Select the desired rate from “1/1”, “1/4”, “1/9”, 
“1/16” and “No polygon” by selecting from the 
[Reduction Rate] pull-down menu.

• If you want to program to generate points to fill in 
holes caused by missing data, set the [File Holes] 
setting to “On”.

• Use the [Remove] pull-down menu to select 
which points to remove from the imported data.

  You can set this to any of the following: “None”, 
“Boundary(B.)”, “5deg. & B.”, “10deg. & B.”, 
“15deg. & B.”, or “20deg. & B.”

• If you want to filter the imported data, select the 
appropriate parameter from the [Filter] pull-down 
menu.

4 Click the [OK] button.
The data of the selected file will be loaded 
and displayed in the element view window. 
The names of the imported elements will also 
appear in the element list, indicating that the 
elements have been selected (highlighted).

• The loaded data will be ready to be displayed in 
all windows. It will be displayed in the active 
window and the windows for which all the ele-
ments are set to be displayed.

• When the data is loaded for the first time after the 
software is started, it will be fully framed in all 
the windows including those that are hidden.

Memo

A clock icon will be displayed during loading.
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Parameters for [File-Import-Digitizer-PC Card-Load] Dialog Box

Element name Enter the desired element name.

Reduction Rate Selects the reduction rate to be applied when importing the data. You can select any of the following: 
“1/1”, “1/4”, “1/9”, “1/16”, or “No polygon”.

Fill Holes Selects whether the programs fill in holes when importing the data. If the setting is On, the pro-
gram will automatically generate points to fill in holes left by missing data.

Remove Selects which the data the program excludes when carrying out the import. Select from an of the fol-
lowing: “None”, “Boundary (B.)”, “5deg. & B.”, “10deg. & B.”, “15deg. & B.”, or “20deg. & B.”

None:  Removal is not carried out when importing the data.
Boundary(B.): The program removes boundary points.
5deg. & B.,10deg. & B., 15deg. & B., 20deg. & B.:

The program removes boundary points, and also removes polygons within the 
specified angular range (5°, 10 °, 15°, or 20 °) to the view vector.

Filter None: The program does not perform filtering when importing the data.

Noise Filter (N.F.): When importing the data, the points that appear to be noise will be corrected 
according to other data.

High Quality (H.Q.): The program filters out unreliable data. 
H.Q & N.F.: Applies both noise filter and high quality filter. 

n Deleting the Selected File ([Delete] button)
The [Delete] button is used to delete the selected file from the memory card.

 Operating Procedure 

Before starting the following procedure, make sure that the [File-Import-Digitizer-PC Card] dialog box is 
displayed.

1 From the file list, select the name of the 
file you want to delete.

2 Click the [Delete] button.
A message dialog box will appear.

3 Click the [Delete] button.
The file will be deleted.
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n Deleting All the Files ([Delete All] button)
The [Delete All] button is used to delete all the files from the memory card.

 Operating Procedure 

Before starting the following procedure, make sure that the [File-Import-Digitizer-PC Card] dialog box is 
displayed.

1 Click the [Delete All] button.
A message dialog box will appear.

2 Click the [Delete All] button.
All the files in the memory card will be deleted.

Note
All	the	files	in	the	memory	card	will	be	deleted,	irrespec-
tive	of	whether	or	not	they	are	currently	selected	in	the
file	list.

n Saving the Selected File ([Copy] button)
The [Copy] button is used to copy the selected file from the memory card and save it as camera data.

 Operating Procedure 

Before starting the following procedure, make sure that the [File-Import-Digitizer-PC Card] dialog box is 
displayed.

1 From the file list, select the name of the 
file you want to save.

2 Click the [Copy] button.
The [PC Card-Copy] dialog box will appear.
The copy destination directory and names of 
the files present in that directory will be dis-
played.

3 Change the directory and file name if 
necessary.

Note
The	file	name	must	consist	of	alphanumeric	characters	
only.

4 Click the [Save] button.
All the files will be saved as camera data.
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n Saving All the Files ([Copy All] button)
The [Copy All] button is used to copy the data of all the files from the memory card and save them as 
camera data.

 Operating Procedure 

Before starting the following procedure, make sure that the [File-Import-Digitizer-PC Card] dialog box is 
displayed.

1 Click the [Copy All] button.
The [File-Import-Digitizer-PC Card-Copy All] 
dialog box will appear.
The copy destination directory will be dis-
played.

2 Change the directory if necessary.

3 Click the [OK] button.
All the files will be saved as camera data. • If a file(s) having the same name exists, a mes-

sage dialog box will appear.

 • Clicking the [Overwrite] button will overwrite 
the file which is currently displayed in the mes-
sage dialog box.

 • Clicking the [Overwrite All] button will over-
write the file which is currently displayed in the 
message dialog box as well as all the remaining 
files having the same names at once. The mes-
sage dialog box will not be displayed for those 
remaining files.

 • Clicking the [Skip] button will ignore the file 
displayed in the dialog box and proceed to the 
next file on the file list.

 • Clicking the [Cancel] button will close the 
dialog box without saving the files displayed in 
the dialog box.
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n Changing the Selected File Name ([Rename] button)
The [Rename] button is used to change the name of the file selected from the memory card.

 Operating Procedure 

Before starting the following procedure, make sure that the [File-Import-Digitizer-PC Card] dialog box is 
displayed.

1 From the file list, select the name of the 
file you want to save.

2 Click the [Rename] button.
The [File-Import-Digitizer-PC Card-Rename] 
dialog box will appear.

3 Enter the new name and click the [Re-
name] button.
The file name will be changed.

Note
Names	of	the	files	stored	in	the	memory	card	must	con-
sist	of	up	to	eight	characters.	Only	alphabets,	numeri-
cal numbers,	bars	“–”	and	underbars	“_”	can	be	used.	
Lower-case	characters	contained	in	file	names	will	be	
converted	to	upper-case	characters.
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Performing One Scan with the VIVID 910 or VIVID 900

This command is used to cause the VIVID 910 (VI-910) or VIVID 900 (VI-900) to scan the object one scan at 
a time using the remote control function of this software. If a rotating stage has been selected, rotation of the 
stage can also be controlled.

Warning

Never stare into the laser emitting window.

Do not place a lens, mirror or optical element in the passage of the laser beam. Doing so may converge the 
laser beam, resulting in damage to your eyes, burns or fire. To prevent the above accidents, make sure that a 
wall or similar which can block the laser beam is located behind the object.

Note
If	the	rotating	stage	does	not	operate	correctly	from	the	
dialog	box,	turn	OFF	the	stage,	turn	it	ON	again,	and	
then	try	to	operate	it.

Memo

• Before performing the procedure below, make sure that 
the digitizer you are going to use is selected by the File 
– Select Digitizer command.

• Note that although this version of the software supports 
simultaneous use of two VIVID 910 or VIVID 900 
units, the software can only access the memory card 
located in the unit with the higher SCSI ID.

Ref.  For details of the File	–	Select	Digitizer command, 
refer to page 144.

 Operating Procedure 

1 From the [File] menu, select [Import], 
[Digitizer] and then [One Scan].
The [File-Import-Digitizer-One Scan] dialog 
box will appear.

• The monochrome monitor image currently captured by 
the VIVID 910 or VIVID 900 will appear in the image 
area of the dialog box.

2 Set an object in place.
If you are going to use the rotating stage, 
place the object on it.

3 To display the object in the middle of 
the image area, change the position of 
the object or move the instrument back 
and forth to change the view angle.

Memo

If necessary, replace the lens attached to the VIVID.

4 In the [Camera1] tab, select the desired 
scan mode (Fine or Fast).
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5 If you are going to use the turntable, set 
the serial port and rotating stage type 
to be used under the Hardware tab.

6 Set optional parameters.

7 In the [General] tab, click the [Scan] 
button.
Scan will start, and both color and range im-
ages will be displayed.

Memo

• In the range image, areas comprised of regular data are 
shown in color.

• In High Quality mode, data for which laser intensity 
was too high are displayed in bright gray, while data for 
which intensity was too low are displayed in dark gray.

• If the color and range images are not scanned at the 
same time, clicking the [Color Read] button or double-
clicking on the image will capture a color image and 
display it.

• Dragging the mouse on the color image will enlarge 
the image. If necessary, enable color correction such as 
“Dark”, “Log” and “Smooth” in the [Camera1] tab, and 
load the color image again.

• To restart scan, repeat steps 2 to 4. If necessary, click 
the [Mono] button to display a monochrome image.

8 In the [General] tab, click the [Convert] 
button.
The [File-Import-Digitizer-One Scan-Convert] 
dialog box will appear.
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10 Click the [OK] button.
The scanned image will be displayed. The 
names of the imported elements will also 
appear in the element list, indicating that the 
elements have been selected (highlighted).

• The loaded data will be ready to be displayed in 
all windows. It will be displayed in the active 
window and the windows for which all the ele-
ments are set to be displayed.

• When the data is loaded for the first time after 
the software is started, it will be fully framed in 
all the windows including those that are hidden 
automatically.

• If the [Save CDM] checkbox was checked at step 
9, the [Remote-Save] dialog box will appear.
q Enter the desired file name.
w Click the [Save] button.

Note
The	file	name	must	consist	of	alphanumeric	characters	
only.

9 Enter the desired element name, and 
set parameters.

• Select the desired rate from “1/1”, “1/4”, “1/9”, 
“1/16” and “No polygon” by selecting from the 
[Reduction Rate] pull-down menu.

• If you want to generate points to fill in holes 
caused by missing data, set the [File Holes] set-
ting to “On”.

• The [Remove] pull-down menu lets you select 
which points to remove from the imported data.

  You can set this to any of the following: “None”, 
“Boundary(B.)”, “5deg. & B.”, “10deg. & B.”, 
“15deg. & B.”, or “20deg. & B.”

• If you want to filter the imported data, select the 
appropriate parameter from the [Filter] pull-down 
menu.

• To save the raw scan data (.cdm) when importing 
data, check the [Save CDM] checkbox.

Note
The	element	name	must	consist	of	up	to	31	characters.
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Parameters for [File-Import-Digitizer-One Scan] Dialog Box 

AF Executes auto-focus.

Mono Displays a monochrome monitoring image.

Color Takes and displays a color picture.

Pitch Displays previously scanned pitch image. (This button appears only if you are using two inter-
connected VIVID units.)

General Tab

Distance Checking this checkbox sets [Distance] on.

Intensity Checking this checkbox sets [LD] and [Gain] on.

LD Sets the intensity of the laser beam.

Gain Sets the gain.

Focus Lock Locks the focus. When you select this item, the program automatically places checks in the [Dis-
tance] and [Intensity] checkboxes, and displays the currently set position, the current laser-beam 
intensity, and the gain value.

Scan Executes scanning from the VIVID unit.

Color Read When you press this button after taking a scan, the program takes a color shot and updates the 
picture on the display. This button is effective only after scanning, and only if [Use Texture] is 
checked and [Auto Read] is unchecked.

Convert Use when you want the program to load camera data. Opens the [File-Import-Digitizer-One 
Scan-Convert] dialogbox.

Export Export scanned data in various data formats.

Go Sequentially executes those of the following functions that are checked: [AF], [Scan], [Convert], 
[Export], and [Close].

Camera 1 Tab Note that the program runs a SCSI check when the dialog tabs are generated. If the check re-
veals that two camera units are connected, the dialog will display a [Camera 2] tab as well as the 
[Camera 1] tab. The control content of both tabs will be identical.

Log If this checkbox is checked, the program applies log correction for color data. Use when you 
want to brighten up neutral color.

Smooth If this checkbox is checked, the program applies smoothing to color data. Use if illumination is 
low and the image is unclear.

Dark IIf this checkbox is checked, the program applies dark correction to color data. Use if you are 
getting striation-type noise in the images.

Color Level Checking this checkbox  sets the program to use color exposure level.

Threshold Checking this checkbox  sets the program to use a threshold for distance-image creation.

Fine/Fast Selects the scan mode.

Dynamic Range Expan-
sion Mode

If this checkbox is checked, the program takes multiple shots so as to expand the dynamic range 
and reduce data loss. This button is displayed only for the VIVID 910.

High Quality Mode If this checkbox is checked, the program includes display of low-reliability data. On the range im-
age, data for which laser intensity was too high appear in light gray, while data for which intensity 
was too low are shown in dark gray. This checkbox appears only if you using the VIVID 910.

Use Texture Checking this checkbox enables use of color images when converting and exporting.

Memo

Note that if you use the [Go] button, the program will automatically load color data after scan-
ning, regardless of whether [Auto Read] is checked.

Auto read Checking this checkbox enables auto-read operation. If auto-read is enabled, the program will load 
data after scanning (after the [Scan] button is clicked), with no need to click the [Color Read] button.

Scan loop Sets the number of scan iterations when taking multiple scans.

Auto Load Parameters Causes the command to automatically load the parameter settings saved by the [Save Parameters] 
feature.

Save Parameters Saves the parameter settings entered in the [Camera 1] tab.

Load Parameters Loads the parameter settings saved by the [Save Parameters] feature.
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Parameters for [File-Import-Digitizer-One Scan-Convert] Dialog Box

Reduction Rate Selects the reduction rate to be applied when importing the data. 
You can select any of the following: “1/1”, “1/4”, “1/9”, “1/16”, or “No polygon”.

Fill Holes Selects whether the programs fill in holes when importing the data. If the setting is “On”, the pro-
gram will automatically generate points to fill in holes left by missing data.

Remove Selects which the data the program excludes when carrying out the import. Select from an of the 
following: “None”, “Boundary (B.)”, “5deg. & B.”, “10deg. & B.”, “15deg. & B.”, or “20deg. & B.”

None:  Removal is not carried out when importing the data.
Boundary(B.): The program removes boundary points.
5deg. & B.,10deg. & B., 15deg. & B., 20deg. & B.:

The program removes boundary points, and also removes polygons within the 
specified angular range (5°, 10 °, 15°, or 20°) to the view vector

Filter None: The program does not perform filtering when importing the data.

Noise Filter (N.F.): When importing the data, the points that appear to be noise will be corrected 
according to other data.

High Quality (H.Q.): The program filters out unreliable data. (Effective only when importing data 
that was scanned using the VIVID 910.)

H.Q & N.F.: Applies both noise filter and high quality filter. (Effective only when importing 
data that was scanned using the VIVID 910.)

Save CDM Save the images as camera data.

Parameters for [File-Import-Digitizer-One Scan]  Dialog Box

Hardware Tab

Auto SCSI ID Check this checkbox if you want the program to automatically check SCSI connections for VIVID 
units. If this checkbox is not checked, the program will recognize VIVID units at specified SCSI IDs 
only.

Mounted • Vertical : Check this checkbox if using the VIVID unit in vertical orientation.

• Horizontal : Check this checkbox if using the VIVID unit in horizontal orientation.

Apply When you click the [Apply] button after selecting the serial port and rotating stage, the [Angle] 
slidebar becomes effective and stage control is enabled.
Note
If	connecting	to	a	SKIDS-60YAW	unit,	select	“CSG-602R(Ver.1.0)”	from	the	pull-down	menu.	If	connect-
ing	to	a	SKIDS-60YAW	(Ver.	2.0)	unit,	select	“CSG-602(Ver.2.0)”.

Angle This slidebar becomes enabled when the program determines that the rotating stage is operating 
normally. You can use the slidebar to control the stage’s rotation.
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Performing Step Scan with the VIVID 910 or VIVID 900

This command is used to take two or more shots using the rotating stage via the remote control function of this 
software. If a rotating stage has been selected by the Turntable, rotation of the stage can also be controlled. 
After the necessary shots are taken, scan the calibration chart required for calibration of rotation. Data ac-
quired from different angles will be subjected to registration, and the resulting data will appear.

Warning

Never stare into the laser emitting window.

Do not place a lens, mirror or optical element in the passage of the laser beam. Doing so may converge the 
laser beam, resulting in damage to your eyes, burns or fire. To prevent the above accidents, make sure that a 
wall or similar which can block the laser beam is located behind the object.

n When Using Only the Rotating Stage

 Operating Procedure 

1 From the [File] menu, select [Import], 
[Digitizer] and then [Step Scan].
The [File-Import-Digitizer-Step Scan] dialog 
box will appear.

Memo

• The calibration chart is an accessory of the rotating 
stage set.

• Before performing the procedure below, make sure that 
the digitizer you are going to use is selected by the File 
– Select Digitizer command.

• If you have connected multiple VIVID 910 or VIVID 900 
units, you can select the unit to be used by changing the 
SCSI ID. Note that the software can only load memory-
card data from the VIVID unit with the highest SCSI ID.

Note
If	the	rotating	stage	does	not	operate	correctly	from	the	
dialog	box,	turn	OFF	the	stage,	turn	it	ON	again,	and	
then	try	to	operate	it.

Ref.  For details of the	File	–	Select	Digitizer	command, 
refer to page 144.

• The monochrome monitor image currently cap-
tured by the VIVID 910 or VIVID 900 will appear 
in the image area of the dialog box.

2 Place the object on the rotating stage.

3 To display the object in the middle of the 
image area, change the position of the 
object or move the VIVID digitizer back 
and forth to change the view angle.

Memo

If necessary, replace the lens attached to the VIVID .
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4 In the [Hardware] tab, select the de-
sired rotation step from “90”, “60” and 
“Other” so that the rotating stage will 
rotate at the selected step.
If “Other” is selected, enter the desired rota-
tion angle.

Memo

To check whether the object is scanned properly when it 
is rotated, click [Check scanning area].
While the rotating stage rotates at the step selected by Ro-
tation Step, the monochrome image acquired from each 
angle will be displayed in the preview area.
When the rotating stage completes one turn, it will return 
to the home position and the check is complete.
If any problem is detected, repeat step 3.

Note
The	rotating	stage	may	rotate	in	the	opposite	direction	
during	measurement	depending	on	its	type.

5 In the [Camera1] tab, select the desired 
scan mode (Fine or Fast).

6 Set optional parameters.

Note
If	high	measurement	accuracy	is	required,	set	the	dis-

tance	parameter.

7 In the [General] tab, click the [Scan] 
button.
Scan will start, and both color and range im-
ages will be displayed.
The “Next angle: **degree” message dialog 
box will also appear.
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Memo

• In the range image, areas comprised of regular data are 
shown in color.

• In High Quality mode, data for which laser intensity was 
too high are displayed in bright gray, while data for which 
intensity was too low are displayed in dark gray.

 

• If the color and range images are not scanned at 
the same time, clicking the [Color Read] button or 
double-clicking on the image will capture a color 
image and display it.

• Dragging the mouse on the color image will en-
large the image. If necessary, enable color correc-
tion such as “Dark”, “Log” and “Smooth”, in the 
[Camera1] tab and load the color image again.

• If the type of rotating stage has not been desig-
nated, turn the rotating stage manually to the next 
angle displayed in the “Next angle:** degree” 
message dialog box.

8 Click the [OK] button.
The next specified angle will appear in [Current 
angle], and the object will be scanned for the 
next image.
• If a rotating stage has been selected by the Turn-

table, the stage will turn to the next angle and 
then the object will be scanned.

• To cancel scan, click the [Cancel] button instead 
of the [OK] button, and repeat steps 6 to 8.

Note
The	rotating	stage	may	rotate	in	the	opposite	direction	
during	measurement	depending	on	its	type.

9 Repeat step 8 until shots from all the 
desired angles are captured.
When shots from all the desired angles are 
captured, the “Scan the chart ? The turntable 
will be move.” message dialog box will appear.

• If you want to acquire a shot again, click the [Cancel] 
button to close the dialog box, click the angle cur-
rently displayed in [Current] with the left mouse but-
ton, then select the desired angle among those which 
have been set from the pulldown menu that appears.

Memo

If an angle (rotation step) has been selected at step 4, 
necessary steps (angles) to complete 360 degrees will 
be displayed in the pull-down menu. However, it is not 
necessary to scan at all the angles. You can select neces-
sary steps (angles) only.

• Click the [OK] button. The rotating stage will 
start to rotate toward the angle (home position) 
where the calibration chart is to be measured. 
When the rotating stage has reached that angle 
(home position), the “Scanning the Calibration 
Chart.” message dialog box will appear.

• Click the [OK] button. The rotating stage will 
start to rotate toward the angle (home position) 
where the calibration chart is to be measured. 
When the rotating stage has reached that angle 
(home position), the “Scanning the Calibration 
Chart.” message dialog box will appear.
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10 Place the calibration chart on the rotat-
ing stage.
When the “Scanning the Calibration Chart.” 
message dialog box appears, position the 
chart with the black line facing the VIVID, and 
place it on the rotating stage so that both 
entire side surfaces are observed in the view-
finder.
• If “Chart” is not displayed in [Current angle], 

click the left mouse button and select “Chart” 
from the pull-down menu that appears.

11 Click the [OK] button.
The calibration chart will be scanned.
Note
Make	sure	that	the	acquired	range	image	looks	like	
the	good	example	given	below.	If	it	resembles	the	bad	
example,	click	the	[Scan]	button	again	to	re-scan	the	
calibration	chart.

Memo

If it is not possible to perform calibration using calibra-
tion chart S, use calibration chart M.

12 Click the [Convert] button.
The [File-Import-Digitizer-Step Scan-Convert] 
dialog box will appear.

Calibration chart S

Good example Bad example
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13 Enter the desired element name, and 
set parameters.

• Select the desired rate from “1/1”, “1/4”, “1/9”, 
“1/16” and “No polygon” by selecting from the 
[Reduction Rate] pull-down menu.

• If you want to generate points to fill in holes 
caused by missing data, set the [File Holes] set-
ting to “On”.

• The [Remove] pull-down menu lets you select 
which points to remove from the imported data. 
You can set this to any of the following: “None”, 
“Boundary(B.)”, “5deg. & B.”, “10deg. & B.”, 
“15deg. & B.”, or “20deg. & B.”

• If you want to filter the imported data, select the 
appropriate parameter from the [Filter] pull-down 
menu.

• If you want to save the raw scan data (.cdm) when 
importing, check the [Save CDM] checkbox.

Note
The	element	name	must	consist	of	up	to	31	alphanu-
meric	characters.

14 Click the [OK] button.
Each scanned image will be subjected to reg-
istration and displayed, and the “Proceed to 
registration?” message dialog box will appear. 
The element list will also show the element 
name specified at step 13 plus “rotation step”. 
The element name is highlighted, indicating 
that it is currently selected.
• The loaded data will be ready to be displayed in 

all windows. It will be displayed in the active 
window and the windows for which all the ele-
ments are set to be displayed (i.e. the windows 
that are not set to “Selective”).

• When the data is loaded for the first time after 
the software is started, it will be fully framed in 
all the windows including those that are hidden 
automatically.

• If a rotating stage has been designated, the rotat-
ing stage will rotate back to the original position 
before data reading starts.

• If the [Save CDM] checkbox was checked at step 
13, the [Remote-Save] dialog box will appear 
before the dialog box that asks whether you want 
to perform fine-registration.
q Enter the desired file name.
w Click the [Save] button.

Note
The	file	name	must	consist	of	alphanumeric	characters	
only.

15 Click the [OK] button.
Fine-registration of the element position will 
be performed and the data will be displayed 
again.
• If a rotating stage has been selected by the Turn-

table, the stage will turn to the next angle and 
then the object will be scanned.

• If you are not going to perform fine-registration, 
click the [Cancel] button instead of the [OK] button.

Memo

Fine-registration can be cancelled even if it has started, by 
clicking the [Cancel] button in the dialog box that appears

during fine-registration.   
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n When Using the Bench Top Frame Set
Memo

The VIVID 910 or VIVID 900 can be mounted on the bench top frame set vertically or horizontally.
For the mounting method, refer to the instruction manual of the frame set.
Saving the calibration chart data helps you reduce work time when scanning different objects under the same conditions.

 Operating Procedure 

1 From the [File] menu, select [Import], 
[Digitizer] and then [Step Scan].
The [File-Import-Digitizer-Step Scan] dialog 
box will appear.

• The monochrome monitor image currently cap-
tured by the VIVID 910 or VIVID 900 will ap-
pear in the image area of the dialog box.

3 Place the object on the rotating stage.
Note

If	the	VIVID	digitizer	is	mounted	on	the	frame	set	hori-
zontally,	the	object	will	be	affected	by	repeated	reflection	
on	the	rotating	stage	surface,	preventing	correct	scan	
operation.	To	prevent	this,	place	an	appropriate	item	of	
the	following	thickness	under	the	object	to	raise	it.

Measurement Distance Thickness of Item

600 mm Approx. 30 mm

1000 mm Approx. 20 mm

4 To display the object in the middle of 
the image area, change the position of 
the object or move the instrument back 
and forth to change the view angle.

Memo

If necessary, replace the lens attached to the VIVID 
digitizer.

2 Select the desired installation direction 
of the VIVID digitizer.
From the [Hardware] tab, check the [Bench 
Top Frame set] checkbox, and select the VIVID 
digitizer installation direction by clicking the 
corresponding [Mounted] radio button.
Select [Vertical] if the VIVID 910 or VIVID 900 is 
mounted vertically, or select [Horizontal] if it is 
mounted horizontally.

Memo

If the VIVID digitizer is mounted horizontally, the pre-
view image will be in portrait form.
After the image is converted to 3D, it will be displayed 
according to the coordinate system of the VIVID.
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5 In the [Hardware] tab, select the de-
sired rotation step from “90”, “60” and 
“Other” so that the rotating stage will 
rotate at the selected step.
If “Other” is selected, enter the desired rota-
tion angle.

Memo

To check whether the object is scanned properly when it 
is rotated, click [Check scanning area].
While the rotating stage rotates at the step selected by Ro-
tation Step, the monochrome image acquired from each 
angle will be displayed in the preview area.
When the rotating stage completes one turn, it will return 
to the home position and the check is complete.
If any problem is detected, repeat step 4.

Note
The	rotating	stage	may	rotate	in	the	opposite	direction	
during	measurement	depending	on	its	type.

6 In the [Camera1] tab, select the desired 
scan mode (Fine or Fast).

7 Set optional parameters.

Note
If	high	measurement	accuracy	is	required,	set	the	dis-
tance	parameter	in	the	[General]	tab.

8 In the [Geneal] tab, click the [Scan] 
button.
Scan will start, and both color and range im-
ages will be displayed.
The “Next angle: **degree” message dialog 
box will also appear.
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• If the color and range images are not scanned at 
the same time, clicking the [Color Read] button or 
double-clicking on the image will capture a color 
image in the [General] tab in the [File-Import-
Digitizer-Step Scan] dialog box and display it.

• Dragging the mouse on the color image will 
enlarge the image. If necessary, enable color cor-
rection such as “Dark”, “Log” and “Smooth”, and 
load the color image again.

• If the type of rotating stage has not been desig-
nated, turn the rotating stage manually to the next 
angle displayed in the “Next angle: **degree” 
message dialog box.

Memo

Step 8 and subsequent steps can be processed automati-
cally. (For details, refer to page 90.)

9 Click the [OK] button.
The next specified angle will appear in [Current 
angle], and the object will be scanned for the 
next image.
• If a rotating stage has been selected by the Turn-

table, the stage will turn to the next angle and 
then the object will be scanned.

• To cancel scan, click the [Cancel] button instead 
of the [OK] button, and repeat steps 6 to 8.

Note
The	rotating	stage	may	rotate	in	the	opposite	direction	
during	measurement	depending	on	its	type.

10 Repeat step 9 until shots from all the 
desired angles are captured.
When shots from all the desired angles are 
captured, the “Read the chart data ?” mes-
sage dialog box will appear.
If calibration chart data already exists, click 
the [OK] button to import it. After the data has 
been imported, proceed to step 13.
If you click the [Cancel] button, the CScan 
the chart? The turntable will be move.” mes-
sage dialog box will appear. If you click [OK] 
button the stage will move to the angle that 
allows measurement of the calibration, and 
the “Scanning the Calibration Chart.” message 
dialog box will appear.

Note
If	no	chart	data	exists	or	the	existing	chart	data	does	not	
match	the	measurement	conditions,	the	following	error
messages	will	appear.
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11 Place the calibration chart on the rotat-
ing stage.
Position the chart with the black line facing 
the VIVID digitizer, and place it on the rotat-
ing stage so that both entire side surfaces are 
observed in the viewfinder.
• If “Chart” is not displayed in [Current angle], 

click the left mouse button and select “Chart” 
from the pull-down menu that appears. Memo

If it is not possible to perform calibration using calibra-
tion chart S, use calibration chart M.

12 Click the [OK] button.
The calibration chart will be scanned, and the 
“Save the chart data ?” message dialog box 
will appear.
To save the calibration chart data, click the 
[OK] button.

Memo

Saving the calibration chart data helps you reduce work 
time when scanning different objects under the same 
conditions.

Note
•	 If	accurate	data	is	required,	it	is	recommended	that	
calibration	be	performed	each	time.

•	 Make	sure	that	the	acquired	range	image	looks	like	
the	good	example	given	below.	If	it	resembles	the	bad	
example,	click	the	[Scan]	button	again	to	re-scan	the	
calibration	chart.

Calibration chart S

Good example Bad example

Download from Www.Somanuals.com. All Manuals Search And Download.



88

Chapter 2
File
Menu

900
910

File – Import – Digitizer – Step Scan (When VIVID 900/910 is Selected)

15 Click the [OK] button.
Each scanned image will be subjected to reg-
istration and displayed, and the “Proceed to 
registration?” message dialog box will appear.
The element list will also show the element 
name specified at step 14 plus “rotation step”. 
The element name is highlighted, indicating 
that it is currently selected.
• The loaded data will be ready to be displayed in 

all windows. It will be displayed in the active 
window and the windows for which all the ele-
ments are set to be displayed (i.e. the windows 
that are not set to “Selective”).

• When the data is loaded for the first time after 
the software is started, it will be fully framed in 
all the windows including those that are hidden 
automatically.

• If a rotating stage has been designated, the rotat-
ing stage will rotate back to the original position 
before data reading starts.

13 Click the [Convert] button.
The [File-Import-Digitizer-Step Scan-Convert] 
dialog box will appear.

14 Enter the desired element name, and 
set parameters.

• Select the desired rate from “1/1”, “1/4”, “1/9”, 
“1/16”, and “No polygon”, by selecting from the 
[Reduction Rate] pull-down menu.

• If you want to generate points to fill in holes caused 
by missing data, set the [File Holes] setting to “On”.

• The [Remove] pull-down menu lets you select 
which points to remove from the imported data. 
You can set this to any of the following: “None”, 
“Boundary(B.)”, “5deg. & B.”, “10deg. & B.”, 
“15deg. & B.”, or “20deg. & B.”

• If you want to filter the imported data, select the ap-
propriate parameter from the [Filter] pull-down menu.

• If you want to save the raw scan data (.cdm) when 
importing, check the [Save CDM] checkbox.

Note
The	element	name	must	consist	of	up	to	31	alphanu-
meric	characters.

• If the [Save CDM] checkbox was checked at step 
14, the [Remote-Save] dialog box will appear 
before the dialog box that asks whether you want 
to perform fine-registration.
q Enter the desired file name.
w Click the [Save] button.

Note
The	file	name	must	consist	of	alphanumeric	characters	
only.
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16 Click the [OK] button.
Fine-registration of the element position will 
be performed and the data will be displayed 
again.
• If a rotating stage has been selected by the Turn-

table, the stage will turn to the next angle and 
then the object will be scanned.

• If you are not going to perform fine-registration, 
click the [Cancel] button instead of the [OK] but-
ton.

Memo

Fine-registration can be cancelled even if it has started, by 
clicking the [Cancel] button in the dialog box that appears
during fine-registration.
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n Performing Scan Operations Automatically
If the bench top frame set is used and calibration chart data exists, a series of scan operations can be pro-
cessed automatically.

1 From the [File] menu, select [Import], 
[Digitizer] and then [Step Scan].
The [File-Import-Digitizer-Step Scan] dialog 
box will appear.

2 Select the desired installation direction 
of the VIVID digitizer.
From the [Hardware] tab, check the [Bench 
Top Frame set] checkbox, and select the VIVID 
digitizer installation direction by clicking the 
corresponding [Mounted] radio button.

Check the [Auto Scan] checkbox under the 
[Hardware] tab.

Select [Vertical] if the VIVID digitizer is 
mounted vertically, or select [Horizontal] if it is 
mounted horizontally.

• The monochrome monitor image currently cap-
tured by the VIVID 910 or VIVID 900 will ap-
pear in the image area of the dialog box.

Memo

If the VIVID digitizer is mounted horizontally, the pre-
view image will be in portrait form.
After the image is converted to 3D, it will be displayed ac-
cording to the coordinate system of the VIVID.

Memo

For details of how to save the calibration chart data, refer 
to page 87,88.

 Operating Procedure 

3 Place the object on the rotating stage.

Note
If	the	VIVID	digitizer	is	mounted	on	the	frame	set	hori-
zontally,	the	object	will	be	affected	by	repeated	reflection
on	the	rotating	stage	surface,	preventing	correct	scan	
operation.	To	prevent	this,	place	an	appropriate	item	of
the	following	thickness	under	the	object	to	raise	it.

Measurement
Distance

Thickness of Item 

600 mm Approx. 30 mm

1000 mm Approx. 20 mm

4 To display the object in the middle of the 
image area, change the position of the 
object or move the rotating stage back 
and forth to change the view angle.

Memo

If necessary, replace the lens attached to the VIVID 
digitizer.
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5 In the [Hardware] tab, select the de-
sired rotation step from “90”, “60” and 
“Other” so that the rotating stage will 
rotate at the selected step.
If “Other” is selected, enter the desired rota-
tion angle.

Memo

To check whether the object is scanned properly when it 
is rotated, click [Check scanning area].
While the rotating stage rotates at the step selected by Ro-
tation Step, the monochrome image acquired from each 
angle will be displayed in the preview area.
When the rotating stage completes one turn, it will return 
to the home position and the check is complete.
If any problem is detected, repeat step 4.

Note
The	rotating	stage	may	rotate	in	the	opposite	direction	
during	measurement	depending	on	its	type.

6 In the [General] tab, select the desired 
scan mode (Fine or Fast).

7 Set optional parameters.
• Check the [Convert] checkbox of  the [Scan & 

Functions] in the [General] tab.

Note
If	high	measurement	accuracy	is	required,	set	the	dis-
tance	parameter	in	the	[General]	tab.
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9 Enter the desired element name, and 
set parameters.

• Select the desired rate from “1/1”, “1/4”, “1/9”, 
“1/16” and “No polygon” by selecting from the 
[Reduction Rate] pull-down menu.

• If you want to generate points to fill in holes 
caused by missing data, set the [File Holes] set-
ting to “On”.

• The [Remove] pull-down menu lets you select 
which points to remove from the imported data.
You can set this to any of the following: “None”, 
“Boundary(B.)”, “5deg. & B.”, “10deg. & B.”, 
“15deg. & B.”, or “20deg. & B.”

• If you want to filter the imported data, select the 
appropriate parameter from the [Filter] pull-down 
menu.

• If you want to save the raw scan data (.cdm) when 
importing, check the [Save CDM] checkbox.

Note
The	element	name	must	consist	of	up	to	31	alphanu-
meric	characters.

8 In the [General] tab, click the [Go] but-
ton.
The [File-Import-Digitizer-Step Scan-Convert] 
dialog box will appear.

Note
If	no	chart	data	exists	or	the	existing	chart	data	does	not	
match	the	measurement	conditions,	the	following	error	
messages	will	appear.
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10 Click the [OK] button.
the “Proceed to registration?” message dialog 
box will appear.
The element list will also show the element 
name specified at step 9 plus “rotation step”. 
The element name is highlighted, indicating 
that it is currently selected.

• The loaded data will be ready to be displayed in 
all windows. It will be displayed in the active 
window and the windows for which all the ele-
ments are set to be displayed (i.e. the windows 
that are not set to “Selective”).

• When the data is loaded for the first time after 
the software is started, it will be fully framed in 
all the windows including those that are hidden 
automatically.

• If a rotating stage has been designated, the rotat-
ing stage will rotate back to the original position 
before data reading starts.

• If the [Save CDM] checkbox was checked at 
step 9, the [Remote-Save] dialog box will appear 
before the dialog box that asks whether you want 
to perform fine-registration.
q Enter the desired file name.
w Click the [Save] button.

Note
The	file	name	must	consist	of	alphanumeric	characters	
only.

11 Click the [OK] button.
The object will be scanned sequentially at the 
step selected by Rotation Step. Registration of 
the scanned images will be performed using 
the saved chart data to convert them to 3D 
data, and the result will be displayed.

• If you are not going to perform fine-registration, 
click the [Cancel] button instead of the [OK] but-
ton.

Note
The	rotating	stage	may	rotate	in	the	opposite	direction	
during	measurement	depending	on	its	type.
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Parameters for [File-Import-Digitizer-Step Scan]Dialog Box

AF Executes auto-focus.

Mono Displays a monochrome monitoring image.

Color Takes and displays a color picture.

General Tab

Distance Checking this checkbox sets [Distance] on.

Intensity Checking this checkbox sets [LD] and [Gain] on.

LD Sets the intensity of the laser beam.

Gain Sets the gain.

Focus Lock Locks the focus. When you select this item, the program automatically places checks in the [Dis-
tance] and [Intensity] checkboxes, and displays the currently set position, the current laser-beam 
intensity, and the gain value.

Scan (Auto Scan) Causes the VIVID unit to execute a scan.
If [Auto Scan] (in the [Hardware] tab) is checked, this name for this control becomes [Auto Scan].

Color Read When you press this button after taking a scan, the program takes a color shot and updates the 
picture on the display. This button is effective only after scanning, and only if [Use Texture] is 
checked and [Auto Read] is unchecked.

Convert Use when you want the program to load camera data. Opens the [File-Import-Digitizer-Step 
Scan-Convert] dialog box.

Export Export scanned data in various data formats.

Go Sequentially executes those of the following functions that are checked: [AF], [Scan], [Convert], 
[Export], and [Close].

Camera 1 Tab

Log If this checkbox is checked, the program applies log correction for color data. Use when you 
want to brighten up neutral color.

Smooth If this checkbox is checked, the program applies smoothing to color data. Use if illumination is 
low and the image is unclear.

Dark If this checkbox is checked, the program applies dark correction to color data. Use if you are get-
ting striation-type noise in the images.

Color Level Checking this checkbox sets the program to use color exposure level.

Threshold Checking this checkbox sets the program to use a threshold for distance-image creation.

Fine/Fast Selects the scan mode.

Dynamic Range Expan-
sion Mode

If this checkbox is checked, the program takes multiple shots so as to expand the dynamic range 
and reduce data loss. This checkbox is displayed only for the VIVID 910.

High Quality Mode If this box is checked, the program includes display of low-reliability data. On the range image, 
data for which laser intensity was too high appear in light gray, while data for which intensity 
was too low are shown in dark gray. This checkbox appears only if you using the VIVID 910.

Use Texture Checking this checkbox enables use of color images when converting and exporting.

Memo

Note that if you use the [Go] button, the program will automatically load color data after scan-
ning, regardless of whether [Auto Read] is checked.

Auto read Checking this checkbox enables auto-read operation. If auto-read is enabled, the program will 
load data after scanning (after the [Scan] button is clicked), with no need to click the [Color 
Read] button.

Auto Load Parameters Causes the command to automatically load the parameter settings saved by the [Save Parameters] 
feature.

Save Parameters Saves the parameter settings entered in the [Camera 1] tab.

Load Parameters Loads the parameter settings saved by the Save [Parameters] feature.
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Parameters for [File-Import-Digitizer-Step Scan]  Dialog Box

Hardware Tab

Auto SCSI ID Check this checkbox if you want the program to automatically check SCSI connections for 
VIVID units. If this checkbox is not checked, the program will recognize VIVID units at specified 
SCSI IDs only.

Mounted • Vertical : Check this checkbox if using the VIVID unit in vertical orientation.

• Horizontal : Check this checkbox if using the VIVID unit in horizontal orientation.

Apply To change the rotation stage being controlled: Select the appropriate serial port and rotation 
stage, and then click [Apply].

Note
If	connecting	to	a	SKIDS-60YAW	unit,	select	“CSG-602R(Ver.1.0)”	from	the	pull-down	menu.	If	con-
necting	to	a	SKIDS-60YAW	(Ver.	2.0)	unit,	select	“CSG-602(Ver.2.0)”.

Rotation Step Sets the rotational step, in degrees. You can set this to 90, to 60, or to “Other”. If you select 
“Other”, you can proceed to enter your own custom setting.

Current angle Selects the scanning step (the scan angle). When the dialog box opens, the setting is “0”.
To change the setting, left-click on the angle to open the pull-down menu, and then enter the 
scanning step (angle) that you wish to use. If you enter an angle that was already used for a scan 
and then proceed to click the [Scan] button, the new scan data will overwrite the previous data 
for that angle.

Check Scanning area Turns	the	rotating	stage	through	the	angle	set	by	the	Rotation	Step	setting,	while	displaying
a	monochrome	image	in	the	preview	window.

Bench Top Frame Set Checking this item enables the [Auto Scan] function.

Auto Scan The program automatically scans over the angle set by the [Rotation Step] setting, and automati-
cally reads in the resulting camera data.

Chart File Data Displays the information ([Lens Type], [Mode], [Distance], [Setting]) of the saved calibration data.

Parameters for [File-Import-Digitizer-Step Scan-Convert] Dialog Box

Reduction Rate Selects the reduction rate to be applied when importing the data. You can select any of the follow-
ing: “1/1”, “1/4”, “1/9”, “1/16”, or “No polygon”.

Fill Holes Selects whether the programs fill in holes when importing the data. If the setting is “On”, the pro-
gram will automatically generate points to fill in holes left by missing data.

Remove Selects which the data the program excludes when carrying out the import. Select from an of the 
following: “None”, “Boundary (B.)”, “5deg. & B.”, “10deg. & B.”, “15deg. & B.”, or “20deg. & B.”

None:  Removal is not carried out when importing the data.
Boundary(B.): The program removes boundary points.
5deg. & B.,10deg. & B., 15deg. & B., 20deg. & B.:

The program removes boundary points, and also removes polygons within the 
specified angular range (5°, 10 °, 15°, or 20°) to the view vector

Filter None: The program does not perform filtering when importing the data.

Noise Filter (N.F.): When importing the data, the points that appear to be noise will be corrected 
according to other data.

High Quality (H.Q.): The program filters out unreliable data. (Effective only when importing data 
that was scanned using the VIVID 910.)

H.Q & N.F.: Applies both noise filter and high quality filter. (Effective only when importing 
data that was scanned using the VIVID 910.)

Save CDM Save the images as camera data.
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Importing Data from the Memory Card of VIVID 910 or VIVID 900

This command is used to remote-control the data stored in the memory card of the VIVID 910 (VI-910) or 
VIVID 900 (VI-900).

Note
This command does not operate on step-shot scan data 
in the memory card.

Parameters for [File-Import-Digitizer-PC Card] Dialog Box

File name Displays file names stored in the memory card.

Date Displays the dates on which the files are stored in the memory card.

Size Displays the size of each file (in bytes).

Total **files Displays the total number of camera data files stored in the memory card.

** MB/ ** MB Displays the unoccupied capacity and total capacity of the memory card.

Memo

• Before performing the procedure below, make sure that 
the digitizer you are going to use is selected by the File 
– Select Digitizer command.

• Note that if multiple VIVID units are connected, 
the software can only access the memory card in the 
VIVID unit with the highest SCSI ID setting.

Ref.  For details of the File	–	Select	Digitizer command, 
refer to page 144.

 Operating Procedure 

1 From the [File] menu, select [Import], 
[Digitizer] and then [PC Card].
The [File-Import-Digitizer-PC Card] dialog box 
will appear.

Memo

• Only the raw image data (.cdm) scanned by the VIVID 
910(VI-910) or VIVID 900(VI-900) will be displayed.

• Upper-case file names specified using the camera will 
be converted to lower-case file names when the files are 
imported to this software.

2 Select the file you want to import.
• To perform dark correction for the color data, 

check the [Dark Correction] checkbox.
• To display the preview image, check the [Pre-

view] checkbox (so that a check mark appears in 
the check box). A color image of the selected file 
will be displayed.

Memo

A clock icon will be displayed during loading.
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n Sorting the Files (Sort radio button)
The [Name] and [Date] radio buttons are used to select whether file names are displayed alphabetically or 
by date.

 Operating Procedure 

Before starting the following procedure, make sure that the [File-Import-Digitizer-PC Card] dialog box is 
displayed.

1 Click the [Name] radio button to sort 
the files alphabetically or [Date] radio 
button to sort by date.
Clicking the [Name] radio button will sort the 
files alphabetically, and clicking the [Date] 
radio button will sort them by date.

• When sort is complete, selection state of each file 
in the file list and preview image will be cleared.

n Updating the File List ([Update] button)
The [Update] button is used to load the file names from the memory card to this software and update the 
file list. If the memory card is replaced while the [File-Import-Digitizer-PC Card] dialog box is open, be 
sure to clickthis button to update the file list.

 Operating Procedure 

Before starting the following procedure, make sure that the [File-Import-Digitizer-PC Card] dialog box is 
displayed.

1 Click the [Update] button.
All the file names in the memory card will be 
loaded to the software and a new file list will 
be displayed.
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n Loading the Selected Data ([Load] button)
The [Load] button is used to load the data of the selected file from the memory card to the software.

 Operating Procedure 

Before starting the following procedure, make sure that the [File-Import-Digitizer-PC Card] dialog box is 
displayed.

1 From the file list, select the name of the 
file you want to load.

2 Click the [Load] button.
A dialog box will appear, allowing you to enter 
the desired element name.
The file name in the memory card will be dis-
played as an element name.

3 Change the element name if necessary, 
and set the parameters.

• Select the desired rate from “1/1”, “1/4”, “1/9”, 
“1/16” and “No polygon” by selecting from the 
[Reduction Rate] pull-down menu.

• If you want to program to generate points to fill in 
holes caused by missing data, set the [File Holes] 
setting to “On”.

• Use the [Remove] pull-down menu to select 
which points to remove from the imported data.

  You can set this to any of the following: “None”, 
“Boundary(B.)”, “5deg. & B.”, “10deg. & B.”, 
“15deg. & B.”, or “20deg. & B.”

• If you want to filter the imported data, select the 
appropriate parameter from the [Filter] pull-down 
menu.

4 Click the [OK] button.
The data of the selected file will be loaded 
and displayed in the element view window. 
The names of the imported elements will also 
appear in the element list, indicating that the 
elements have been selected (highlighted).

• The loaded data will be ready to be displayed in 
all windows. It will be displayed in the active 
window and the windows for which all the ele-
ments are set to be displayed.

• When the data is loaded for the first time after the 
software is started, it will be fully framed in all 
the windows including those that are hidden.

Memo

A clock icon will be displayed during loading.
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Parameters for [File-Import-Digitizer-PC Card-Load] Dialog Box

Element name Enter the desired element name.

Reduction Rate Selects the reduction rate to be applied when importing the data. You can select any of the following: 
“1/1”, “1/4”, “1/9”, “1/16”, or “No polygon”.

Fill Holes Selects whether the programs fill in holes when importing the data. If the setting is On, the pro-
gram will automatically generate points to fill in holes left by missing data.

Remove Selects which the data the program excludes when carrying out the import. Select from an of the fol-
lowing: “None”, “Boundary (B.)”, “5deg. & B.”, “10deg. & B.”, “15deg. & B.”, or “20deg. & B.”

None:  Removal is not carried out when importing the data.
Boundary(B.): The program removes boundary points.
5deg. & B.,10deg. & B., 15deg. & B., 20deg. & B.:

The program removes boundary points, and also removes polygons within the 
specified angular range (5°, 10 °, 15°, or 20 °) to the view vector.

Filter None: The program does not perform filtering when importing the data.

Noise Filter (N.F.): When importing the data, the points that appear to be noise will be corrected 
according to other data.

High Quality (H.Q.): The program filters out unreliable data. (Effective only when importing data 
that was scanned using the VIVID 910.)

H.Q & N.F.: Applies both noise filter and high quality filter. (Effective only when importing 
data that was scanned using the VIVID 910.)

n Deleting the Selected File ([Delete] button)
The [Delete] button is used to delete the selected file from the memory card.

 Operating Procedure 

Before starting the following procedure, make sure that the [File-Import-Digitizer-PC Card] dialog box is 
displayed.

1 From the file list, select the name of the 
file you want to delete.

2 Click the [Delete] button.
A message dialog box will appear.

3 Click the [Delete] button.
The file will be deleted.
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n Deleting All the Files ([Delete All] button)
The [Delete All] button is used to delete all the files from the memory card.

 Operating Procedure 

Before starting the following procedure, make sure that the [File-Import-Digitizer-PC Card] dialog box is 
displayed.

1 Click the [Delete All] button.
A message dialog box will appear.

2 Click the [Delete All] button.
All the files in the memory card will be deleted.

Note
All	the	files	in	the	memory	card	will	be	deleted,	irrespec-
tive	of	whether	or	not	they	are	currently	selected	in	the
file	list.

n Saving the Selected File ([Copy] button)
The [Copy] button is used to copy the selected file from the memory card and save it as camera data.

 Operating Procedure 

Before starting the following procedure, make sure that the [File-Import-Digitizer-PC Card] dialog box is 
displayed.

1 From the file list, select the name of the 
file you want to save.

2 Click the [Copy] button.
The [PC Card-Copy] dialog box will appear.
The copy destination directory and names of 
the files present in that directory will be dis-
played.

3 Change the directory and file name if 
necessary.

Note
The	file	name	must	consist	of	alphanumeric	characters	
only.

4 Click the [Save] button.
All the files will be saved as camera data.
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n Saving All the Files ([Copy All] button)
The [Copy All] button is used to copy the data of all the files from the memory card and save them as 
camera data.

 Operating Procedure 

Before starting the following procedure, make sure that the [File-Import-Digitizer-PC Card] dialog box is 
displayed.

1 Click the [Copy All] button.
The [File-Import-Digitizer-PC Card-Copy All] 
dialog box will appear.
The copy destination directory will be dis-
played.

2 Change the directory if necessary.

3 Click the [Copy All] button.
All the files will be saved as camera data. • If a file(s) having the same name exists, a mes-

sage dialog box will appear.

 • Clicking the [Overwrite] button will overwrite 
the file which is currently displayed in the mes-
sage dialog box.

 • Clicking the [Overwrite All] button will over-
write the file which is currently displayed in the 
message dialog box as well as all the remaining 
files having the same names at once. The mes-
sage dialog box will not be displayed for those 
remaining files.

 • Clicking the [Skip] button will ignore the file 
displayed in the dialog box and proceed to the 
next file on the file list.

 • Clicking the [Cancel] button will close the 
dialog box without saving the files displayed in 
the dialog box.
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n Changing the Selected File Name ([Rename] button)
The [Rename] button is used to change the name of the file selected from the memory card.

 Operating Procedure 

Before starting the following procedure, make sure that the [File-Import-Digitizer-PC Card] dialog box is 
displayed.

1 From the file list, select the name of the 
file you want to save.

2 Click the [Rename] button.
The [File-Import-Digitizer-PC Card-Rename] 
dialog box will appear.

3 Enter the new name and click the [Re-
name] button.
The file name will be changed.

Note
Names	of	the	files	stored	in	the	memory	card	must	con-
sist	of	up	to	eight	characters.	Only	alphabets,	numeri-
cal numbers,	bars	“–”	and	underbars	“_”	can	be	used.	
Lower-case	characters	contained	in	file	names	will	be	
converted	to	upper-case	characters.
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Performing One Scan with the VIVID 700

This command is used to cause the VIVID 700 (VI-700) to scan the object one scan at a time using the remote
control function of this software.

Warning

Never stare into the laser emitting window.

Do not place a lens, mirror or optical element in the passage of the laser beam. Doing so may converge the 
laser beam, resulting in damage to your eyes, burns or fire. To prevent the above accidents, make sure that a 
wall or similar which can block the laser beam is located behind the object. 

 Operating Procedure 

1 From the [File] menu, select [Import], 
[Digitizer] and then [One Scan].
The [File-Import-Digitizer-One Scan] dialog 
box will appear.

Memo

Before performing the procedure below, make sure that 
the digitizer you are going to use is selected by the File 
– Select Digitizer command.

Ref.  For details of the File	–	Select	Digitizer	command, 
refer to page 144.

• The color monitor image currently captured by 
the VIVID 700 will appear in the “Color” area of 
the dialog box. (No color image will appear if the 
[Auto read] checkbox is unchecked even if the 
[Option] checkbox is checked.)

2 Set an object in place.

3 Move the Zoom bar to set the desired 
view angle.
A new color image captured from the speci-
fied view angle will appear. (No color image 
will appear if the [Auto read] checkbox is un-
checked.)

4 Set optional parameters.
Check the [Option] checkbox, and make nec-
essary parameters.

• To set the scan reference position ([Distance]) 
and laser intensity ([Laser Intensity] ), perform 
the following procedure.
q Check the [Option] checkbox.
w Check the [Manual] checkbox.
e Move the Distance bar or Laser Intensity bar to 

the desired position.
• If you are not going to scan both color and range 

images at the same time, uncheck the [Auto read] 
checkbox.
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• If the color and range images are not scanned at 
the same time, clicking the [Read] button will 
capture a color image and display it.

• To restart scan, repeat steps 2 to 4.

5 Click the [Scan] button.
Scan will start, and both color and range im-
ages will be displayed.

6 Click the [Convert] button.
The [File-Import-Digitizer-One Scan-Convert] 
dialog box will appear.

7 Enter the desired element name, and 
set parameters.

• Select the desired rate from “1/1”, “1/4”, “1/9”, 
“1/16” and “No polygon” by selecting from the 
[Reduction Rate] pull-down menu.

• If you want to generate points to fill in holes caused 
by missing data, set the [File Holes] setting to “On”.

• The [Remove] pull-down menu lets you select 
which points to remove from the imported data.

  You can set this to any of the following: “None”, 
“Boundary(B.)”, “5deg. & B.”, “10deg. & B.”, 
“15deg. & B.”, or “20deg. & B.”

• If you want to filter the imported data, select the ap-
propriate parameter from the [Filter] pull-down menu.

• To save the raw scan data (.cam) when importing 
data, check the [Save camera data] checkbox.

Note
The	element	name	must	consist	of	up	to	31	alphanu-
meric	characters.

8 Click the [OK] button.
The scanned image will be displayed. The 
names of the imported elements will also 
appear in the element list, indicating that the 
elements have been selected (highlighted).
• The loaded data will be ready to be displayed in 

all windows. It will be displayed in the active 
window and the windows for which all the ele-
ments are set to be displayed.

• When the data is loaded for the first time after 
the software is started, it will be fully framed in 
all the windows including those that are hidden 
automatically.

• If the [Save camera data] checkbox was checked 
at step 7, the [Remote-Save] dialog box will ap-
pear
q Enter the desired file name.
w Click the [Save] button.

Note
The	file	name	must	consist	of	alphanumeric	characters
only.
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Parameters for [File-Import-Digitizer-One Scan] Dialog Box

Zoom Used to set zoom level of the VIVID 700 (VI-700) series digitizer.

Scan Causes the VIVID 700 (VI-700) to acquire a shot.

Option If this checkbox is checked, the lower section of the [Digitizer-One Scan] dialog box will be active, al-
lowing you to set various parameters including [Distance], [Laser Intensity] and [Auto read].

Manual If this checkbox is checked, the [Distance] and [Laser Intensity] parameters can be set.

Distance Used to set the instrument’s scan reference position.

Laser Intensity Used to set the laser beam intensity of the VIVID.

Auto read If this checkbox is checked, a color image will be read automatically when the dialog box is 
opened. Even if the [Read] button is not clicked after the [Scan] button is clicked, the data will be 
read automatically after images are acquired, and the color image and range image will be dis-
played in the dialog box. If there is no check mark in the [Option] checkbox, for instance when the 
software is just started up, the [Auto read] checkbox will be checked automatically.

Read Clicking this checkbox while there is no check mark in the [Auto read] checkbox will read data 
from the instrument and display the range image and the latest color image that were acquired 
when the [Scan] button was clicked last time in the dialog box. This button is effective only if the 
[Auto read] checkbox is unchecked.

Focus Lock Sets the focus lock. The [Manual] checkbox will be checked automatically, and the current posi-
tion and Laser Intensity will be displayed.

Convert Causes the [File-Import-Digitizer-One Scan-Convert] dialog box to appear, allowing import of the 
camera data to this software.

Parameters for [File-Import-Digitizer-One Scan-Convert] Dialog Box

Reduction Rate Selects the reduction rate to be applied when importing the data. You can select any of the follow-
ing: “1/1”, “1/4”, “1/9”, “1/16”, or “No polygon”.

Fill Holes Selects whether the programs fill in holes when importing the data. If the setting is “On”, the pro-
gram will automatically generate points to fill in holes left by missing data.

Remove Selects which the data the program excludes when carrying out the import. Select from an of the fol-
lowing: “None”, “Boundary (B.)”, “5deg. & B.”, “10deg. & B.”, “15deg. & B.”, or “20deg. & B.”

None:  Removal is not carried out when importing the data.
Boundary(B.): The program removes boundary points.
5deg. & B.,10deg. & B., 15deg. & B., 20deg. & B.:

The program removes boundary points, and also removes polygons within the 
specified angular range (5°, 10 °, 15°, or 20 °) to the view vector.

Filter None:  Removal is not carried out when exporting the data.
Noise Filter (N.F.): When importing the data, the points that appear to be noise will be corrected 

according to other data.

Save camera data Save the images as camera data.
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Performing Step Scan with the VIVID 700

This command is used to take two or more shots using the optional rotating stage via the remote control func-
tion of this software. If a rotating stage has been selected by the rotating table, rotation of the stage can also be
controlled.
After the necessary shots are taken, scan the calibration chart. Data acquired from different angles will be 
subjected to registration, and the resulting data will appear.

Warning

Never stare into the laser emitting window.

Do not place a lens, mirror or optical element in the passage of the laser beam. Doing so may converge the 
laser beam, resulting in damage to your eyes, burns or fire. To prevent the above accidents, make sure that a 
wall or similar which can block the laser beam is located behind the object.

Note
If	the	rotating	stage	does	not	operate	correctly	from	the	
dialog	box,	turn	OFF	the	stage,	turn	it	ON	again,	and	
then	try	to	operate	it.

 Operating Procedure 

1 From the [File] menu, select [Import], 
[Digitizer] and then [Step Scan].
The [File-Import-Digitizer-Step Scan] dialog 
box will appear.

Memo

• The calibration chart is an accessory of the rotating 
stage set.

• Before performing the procedure below, make sure that 
the digitizer you are going to use is selected by the File 
– Select Digitizer command.

Ref.  For details of the File	–	Select	Digitizer	command, 
refer to page 144.

2 Place the object on the rotating stage.

3 Select the desired rotation step from 
“90”, “60” and “Other”. The rotating 
stage will rotate at the selected step.
If “Other” is selected, enter the desired rota-
tion angle.

4 Move the Zoom bar to set the desired 
view angle.
A new color image captured from the speci-
fied view angle will appear. (No color image 
will appear if the [Auto read] checkbox is un-
checked.)

• The color monitor image currently captured by 
the VIVID 700 will appear in the “Color” area of 
the dialog box. (No color image will appear if the 
[Auto read] checkbox is unchecked even if the 
[Option] checkbox is checked.)
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• To set the scan reference position (Distance) and 
laser intensity (Laser Intensity), perform the fol-
lowing procedure.
q Check the [Option] checkbox.
w Check the [Manual] checkbox.
e Move the Distance bar or Laser Intensity bar to 

the desired position.
• If you are not going to scan both color and range 

images at the same time, uncheck the [Auto read] 
checkbox.

5 Set optional parameters.
Check the [Option] checkbox, and make nec-
essary parameters.

6 Click the [Scan] button.
Scan will start, and both color and range im-
ages will be displayed.
The “Next shot? (angle:**)” message dialog 
box will also appear.

• If the color and range images are not scanned at 
the same time, clicking the [Read] button will 
capture a color image and display it.

• If the type of rotating stage has not been desig-
nated, turn the rotating stage manually to the next 
angle displayed in the “Next shot? (angle:**)] 
message dialog box.

7 Click the [OK] button.
The next specified angle will appear in [Current 
Angle],
and the object will be scanned for the next 
image.
• If a rotating stage has been selected by the Turn-

table, the stage will turn to the next angle and 
then the object will be scanned.

• To cancel scan, click the [Cancel] button instead 
of the [OK] button, and repeat steps 4 to 6.

8 Repeat step 7 until shots from all the 
desired
angles are captured.
When shots from all the desired angles are 
captured,
the “Next shot? Please set the chart.” mes-
sage dialog box will appear.

• If you want to acquire a shot from a certain angle 
again, click the angle currently displayed in [Cur-
rent Angle] with the left mouse button, then select 
the desired angle from the pull-down menu that 
appears.

Memo

If an angle (rotation step) has been selected at step 3, 
necessary steps (angles) to complete 360 degrees will 
be displayed in the pull-down menu. However, it is not 
necessary to scan at all the angles. You can select neces-
sary steps (angles) only.
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9 Place the calibration chart on the rotat-
ing stage.
Position the chart with the black line facing the 
instrument
and place it on the rotating stage so that both 
entire side surfaces are observed in the view-
finder.
• If “Chart” is not displayed in [Current Angle], 

click the left mouse button and select “Chart” 
from the pull-down menu that appears.

Memo

The calibration chart can be scanned at any angle of the 
rotating stage.

10 Click the [OK] button.
The calibration chart will be scanned.
 
Note
Make	sure	that	the	acquired	range	image	looks	like	
the	good	example	given	below.	If	it	resembles	the	bad	
example,	click	the	[Scan]	button	again	to	re-scan	the	
calibration	chart.

11 Click the [Convert] button.
The [File-Import-Digitizer-Step Scan-Convert] 
dialog box will appear.

Good example Bad example
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12 Enter the desired element name, and 
set parameters.

• Select the desired rate from “1/1”, “1/4”, “1/9”, 
“1/16” and “No polygon” by selecting from the 
[Reduction Rate] pull-down menu.

• If you want to generate points to fill in holes 
caused by missing data, set the [File Holes] set-
ting to “On”.

• The [Remove] pull-down menu lets you select 
which points to remove from the imported data.

  You can set this to any of the following: “None”, 
“Boundary(B.)”, “5deg. & B.”, “10deg. & B.”, 
“15deg. & B.”, or “20deg. & B.”

• If you want to filter the imported data, select the 
appropriate parameter from the [Filter] pull-down 
menu.

• To save the raw scan data (.cam) when importing 
data, check the [Save camera data] checkbox.

Note
The	element	name	must	consist	of	up	to	31	characters.

13 Click the [OK] button.
Each scanned image will be subjected to reg-
istration and displayed, and the “Proceed to 
registration?” message dialog box will appear.
The element list will also show the element 
name specified at step 12 plus “rotation step”. 
The element name is highlighted, indicating 
that it is currently selected.
• The loaded data will be ready to be displayed in 

all windows. It will be displayed in the active 
window and the windows for which all the ele-
ments are set to be displayed.

• When the data is loaded for the first time after 
the software is started, it will be fully framed in 
all the windows including those that are hidden 
automatically.

• If a rotating stage has been designated, the rotat-
ing stage will rotate back to the original position 
before data reading starts.

• If the [Save camera data] checkbox was checked 
at step 12, the [Remote-Save] dialog box will ap-
pear before the one that asks whether you want to 
perform fine-registration.
q Enter the desired file name.
w Click the [Save] button.

Note
The	file	name	must	consist	of	alphanumeric	characters	only.

14 Click the [OK] button.
Fine-registration will be performed and the 
data will be displayed again.
• If a rotating stage has been selected by the Turn-

table, the stage will turn to the next angle and 
then scan will be performed.

• If you are not going to perform fine-registration, 
click the [Cancel] button instead of the [OK] button.

Memo

Fine-registration can be cancelled even if it has started, by 
clicking the [Cancel] button in the dialog box that appears 
during fine-registration.
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Parameters for [File-Import-Digitizer-Step Scan]  Dialog Box

Turntable Used to set the serial port and rotating stage type to be used for remote operation.
Note
If	connecting	to	a	SKIDS-60YAW	unit,	select	“CSG-602R(Ver.1.0)”	from	the	pull-down	menu.	
If	connecting	to	a	SKIDS-60YAW	(Ver.	2.0)	unit,	select	“CSG-602(Ver.2.0)”.

Rotation step Used to select the desired angle (degree) of the rotating stage from “90”, “60” and “Other”. If 
“Other” is selected, enter the desired rotation step.

Current Angle Used to select the desired scan step (i.e. the angle at which scan is to be performed). “0” will be 
selected first when the dialog box is opened. It is possible to select the desired angle by clicking 
the angle currently displayed in [Current Angle] and selecting the desired angle from the pull-
down menu that appears. If an angle at which scan has already been performed is selected again 
and the [Scan] button is clicked, the previously acquired image data will be overwritten.

Zoom Used to set zoom level of the VIVID 700 (VI-700).

Scan Causes the VIVID 700 (VI-700) to acquire a shot.

Option If this checkbox is checked, the lower section of the [Remote-Step Scan] dialog box will be active, 
allowing you to set various parameters including [Distance], [Laser Intensity] and [Auto read].

Manual If this checkbox is checked, the [Distance] and [Laser Intensity] parameters can be set.

Distance Used to set the instrument’s scan reference position.

Laser Intensity Used to set the laser beam intensity of the VIVID.

Auto read If this checkbox is checked, a color image will be read automatically when the dialog box is 
opened. Even if the [Read] button is not clicked after the [Scan] button is clicked, the data will be 
read automatically after images are acquired, and the color image and range image will be dis-
played in the dialog box. If there is no check mark in the [Option] checkbox, for instance when the 
software is just started up, the [Auto read] checkbox will be checked automatically.

Read Clicking this button while there is no check mark in the [Auto read] checkbox will read data from 
the instrument and display the range image and the latest color image that were acquired when 
the [Scan] button was clicked last time in the dialog box. This button is effective only if the [Auto 
read] checkbox is unchecked.

Focus Lock Sets the focus lock. The [Manual] checkbox will be checked automatically, and the current posi-
tion and Laser Intensity will be displayed.

Convert Causes the [File-Import-Digitizer-Step Scan-Convert] dialog box to appear, allowing import of the 
camera data to this software.

Parameters for [File-Import-Digitizer-Step Scan-Convert] Dialog Box

Reduction Rate Selects the reduction rate to be applied when importing the data. You can select any of the follow-
ing: “1/1”, “1/4”, “1/9”, “1/16”, or “No polygon”.

Fill Holes Selects whether the programs fill in holes when importing the data. If the setting is “On”, the pro-
gram will automatically generate points to fill in holes left by missing data.

Remove Selects which the data the program excludes when carrying out the import. Select from an of the fol-
lowing: “None”, “Boundary (B.)”, “5deg. & B.”, “10deg. & B.”, “15deg. & B.”, or “20deg. & B.”

None:  Removal is not carried out when importing the data.
Boundary(B.):  The program removes boundary points.
5deg. & B.,10deg. & B., 15deg. & B., 20deg. & B.:

The program removes boundary points, and also removes polygons within the 
specified angular range (5°, 10 °, 15°, or 20 °) to the view vector

Filter None:  The program does not perform filtering when importing the data.
Noise Filter (N.F.): When importing the data, the points that appear to be noise will be corrected 

according to other data.

Save camera data Save the images as camera data.

Download from Www.Somanuals.com. All Manuals Search And Download.



111

Chapter 2
File
Menu

700

File – Import – Digitizer – PC Card (When VIVID 700 is Selected)
Importing Data from the Memory Card of VIVID 700

This command is used to remote-control the data stored in the memory card of the VIVID 700 (VI-700).

Note
This command does not operate on step-scan scan data 
in the memory card.

Parameters for [File-Import-Digitizer-PC Card] Dialog Box

File name Displays file names stored in the memory card.

Date Displays the dates on which the files are stored in the memory card.

Size Displays the size of each file (in bytes).

Total ** files Displays the total number of camera data files stored in the memory card.

** MB/ ** MB Displays the unoccupied capacity and total capacity of the memory card.

Memo

Before performing the procedure below, make sure that 
the digitizer you are going to use is selected by the File 
– Select Digitizer command.

Ref.  For details of the File	–	Select	Digitizer command, 
refer to page 144.

 Operating Procedure 

1 From the [File] menu, select [Import], 
[Digitizer] and then [PC Card].
The [File-Import-Digitizer-PC Card] dialog box 
will appear.

Memo

Upper-case file names specified using the camera will 
be converted to lower-case file names when the files are 
imported to this software.

2 Select the file you want to import. • To display the preview image, check the [Preview 
Image] checkbox (so that a check mark appears in 
the check box). A color image of the selected file 
will be displayed.

Memo

A clock icon will be displayed during loading.
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n Sorting the Files (Sort radio button)
The [Name] and [Date] radio buttons are used to select whether file names are displayed alphabetically or 
by date.

 Operating Procedure 

Before starting the following procedure, make sure that the [File-Import-Digitizer-PC Card] dialog box is 
displayed.

1 Click the [Name] radio button to sort 
the files alphabetically or [Date] radio 
button to sort by date.
The files will be sorted alphabetically if the 
[Name] radio button is selected or by date if 
the [Date] radio button is selected.
• When sort is complete, selection state of each file 

in the file list and preview image will be cleared.

n Updating the File List ([Update] button)
The [Update] button is used to load the file names from the memory card to this software and update the 
file list. If the memory card is replaced while the [File-Import-Digitizer-PC Card] dialog box is open, be 
sure to click this button to update the file list.

 Operating Procedure 

Before starting the following procedure, make sure that the [File-Import-Digitizer-PC Card] dialog box is 
displayed.

1 Click the [Update] button.
All the file names in the memory card will be 
loadedto the software and a new file list will be 
displayed.
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n Loading the Selected Data ([Load] button)
The [Load] button is used to load the data of the selected file from the memory card to the software.

 Operating Procedure 

Before starting the following procedure, make sure that the [File-Import-Digitizer-PC Card] dialog box is 
displayed.

1 From the file list, select the file you 
want to load.

2 Click the [Load] button.
A dialog box will appear, allowing you to enter 
the desired element name.
The file name in the memory card will be dis-
played as an element name.

3 Change the element name if necessary, 
and set the parameters.

• Select the desired rate from “1/1”, “1/4”, “1/9”, 
“1/16” and “No polygon” by selecting from the 
[Reduction Rate] pull-down menu.

• If you want to generate points to fill in holes 
caused by missing data, set the [File Holes] set-
ting to “On”.

• The [Remove] pull-down menu lets you select 
which points to remove from the imported data. 
You can set this to any of the following: “None”, 
“Boundary(B.)”, “5deg. & B.”, “10deg. & B.”, 
“15deg. & B.”, or “20deg. & B.”

• If you want to filter the imported data, select the 
appropriate parameter from the [Filter] pull-down 
menu.

4 Click the [OK] button.
The data of the selected file will be loaded 
and displayed in the element view window. 
The names of the imported elements will also 
appear in the element list, indicating that the 
elements have been selected (highlighted).

• The loaded data will be ready to be displayed in 
all windows. It will be displayed in the active 
window and the windows for which all the ele-
ments are set to be displayed.

• When the data is loaded for the first time after the 
software is started, it will be fully framed in all 
the windows including those that are hidden.

Memo

A clock icon will be displayed during loading.
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Parameters for [File-Import-Digitizer-PC Card-Load] Dialog Box

Reduction Rate Selects the reduction rate to be applied when importing the data. You can select any of the following: 
“1/1”, “1/4”, “1/9”, “1/16”, or “No polygon”.

Fill Holes Selects whether the programs fill in holes when importing the data. If the setting is “On”, the pro-
gram will automatically generate points to fill in holes left by missing data.

Remove Selects which the data the program excludes when carrying out the import. Select from an of the 
following: “None”, “Boundary (B.)”, “5deg. & B.”, “10deg. & B.”, “15deg. & B.”,

None:  Removal is not carried out when importing the data.
Boundary(B.): The program removes boundary points.
5deg. & B.,10deg. & B., 15deg. & B., 20deg. & B.:

The program removes boundary points, and also removes polygons within the 
specified angular range (5°, 10 °, 15° or 20 °) to the view vector.

Filter None:  The program does not perform filtering when importing the data.
Noise Filter (N.F.): When importing the data, the points that appear to be noise will be corrected 

according to other data.

n Deleting the Selected File ([Delete] button)
The [Delete] button is used to delete the selected file from the memory card.

 Operating Procedure 

Before starting the following procedure, make sure that the [File-Import-Digitizer-PC Card] dialog box is 
displayed.

1 From the file list, select the file you 
want to delete.

2 Click the [Delete] button.
A message dialog box will appear.

3 Click the [Delete] button.
The file will be deleted.
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n Deleting All the Files ([Delete All] button)
The [Delete All] button is used to delete all the files from the memory card..

 Operating Procedure 

Before starting the following procedure, make sure that the [File-Import-Digitizer-PC Card] dialog box is 
displayed.

1 Click the [Delete All] button.
A message dialog box will appear.

2 Click the [Delete All] button.
All the files in the memory card will be deleted.
Note
All	the	files	in	the	memory	card	will	be	deleted,	irrespec-
tive	of	whether	or	not	they	are	currently	selected	in	the
file	list.

n Saving the Selected File ([Copy] button)
The [Delete All] button is used to delete all the files from the memory card..

 Operating Procedure 

Before starting the following procedure, make sure that the [File-Import-Digitizer-PC Card] dialog box is 
displayed.

1 From the file list, select the file you 
want to copy.

2 Click the [Copy] button.
The [PC Card-Copy] dialog box will appear.
The copy destination directory and names of 
the files present in that directory will be dis-
played.

3 Change the directory and file name if 
necessary.
Note
The	file	name	must	consist	of	alphanumeric	characters	
only.

4 Click the [Save] button.
The file will be saved as camera data.
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n Saving All the Files ([Copy All] button)
The [Copy All] button is used to copy the data of all the files from the memory card and save them as 
camera data.

 Operating Procedure 

Before starting the following procedure, make sure that the [File-Import-Digitizer-PC Card] dialog box is 
displayed..

1 Click the [Copy All] button.
The [File-Import-Digitizer-PC Card-Copy] dia-
log box will appear.
The copy destination directory will be dis-
played.

2 Change the directory if necessary.

3 Click the [Copy All] button.
All the files will be saved as camera data. • If a file(s) having the same name exists, a mes-

sage dialog box will appear.

 • Clicking the [Overwrite] button will overwrite 
the file which is currently displayed in the mes-
sage dialog box.

 • Clicking the [Overwrite All] button will over-
write the file which is currently displayed in the 
message dialog box as well as all the remaining 
files having the same names at once. The mes-
sage dialog box will not be displayed for those 
remaining files.

 • Clicking the [Skip] button will ignore the file 
displayed in the dialog box and proceed to the 
next file on the file list.

 • Clicking the [Cancel] button will close the dia-
log box without saving all the remaining files 
(including the one displayed in the dialog box).
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n Changing the Selected File Name ([Rename] button)
The [Rename] button is used to change the name of the file selected from the memory card.

 Operating Procedure 

Before starting the following procedure, make sure that the [File-Import-Digitizer-PC Card] dialog box is 
displayed..

1 From the file list, select the name of the 
file you want to change.

2 Click the [Rename] button.
The [File-Import-Digitizer-PC Card-Rename] 
dialog box will appear.

3 Enter the new name and click the [Re-
name] button.
The file name will be changed.
Note
Names	of	the	files	stored	in	the	memory	card	must	con-
sist	of	up	to	eight	characters.	Only	alphabets,	numeri-
cal	numbers,	bars	“–”	and	underbars	“_”	can	be	used.	
Lower-case	characters	contained	in	file	names	will	be	
converted	to	upper-case	characters.
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Performing One Scan with the VIVID 300

This command is used to cause the VIVID 300 (VI-300) to scan the object one scan at a time using the remote
control function of this software.

Warning

Never stare into the laser emitting window.

Do not place a lens, mirror or optical element in the passage of the laser beam. Doing so may converge the 
laser beam, resulting in damage to your eyes, burns or fire. To prevent the above accidents, make sure that a 
wall or similar which can block the laser beam is located behind the object.

 Operating Procedure 

1 From the [File] menu, select [Import], 
[Digitizer] and then [One Scan].
The [File-Import-Digitizer-One Scan] dialog 
box will appear.

Memo

Before performing the procedure below, make sure that 
the digitizer you are going to use is selected by the File 
– Select Digitizer command.

Ref.  For details of the File – Select Digitizer command, 
refer to page 144.

• To set the scan reference position (Distance) and 
laser intensity (Laser Intensity), perform the fol-
lowing procedure.
q Check the [Option] checkbox.
w Check the [Manual] checkbox.
e Move the Distance bar or Laser Intensity bar to 

the desired position.
• If you are not going to scan both color and range 

images at the same time, uncheck the [Auto read] 
checkbox.

• The color monitor image currently captured by 
the VIVID 300 will appear in the “Color” area of 
the dialog box. (No color image will appear if the 
[Auto read] checkbox is unchecked even if the 
[Option] checkbox is checked.)

2 Set an object in place.

3 Set optional parameters.
Check the [Option] checkbox, and make nec-
essary parameters.
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5 Click the [Convert] button.
The [File-Import-Digitizer-One Scan-Convert] 
dialog box will appear.

6 Enter the desired element name, and 
set parameters.

4 Click the [Scan] button.
Scan will start, and both color and range im-
ages will be displayed.

• If the color and range images are not scanned at 
the same time, clicking the [Read] button will 
capture a color image and display it.

• To restart scan, repeat steps 2 to 3.

• Select the desired rate from “1/1”, “1/4”, “1/9”, 
“1/16” and “No polygon” by selecting from the 
[Reduction Rate] pull-down menu.

• If you want to generate points to fill in holes caused 
by missing data, set the [File Holes] setting to “On”.

• The [Remove] pull-down menu lets you select 
which points to remove from the imported data.

  You can set this to any of the following: “None”, 
“Boundary(B.)”, “5deg. & B.”, “10deg. & B.”, 
“15deg. & B.”, or “20deg. & B.”

• If you want to filter the imported data, select the 
appropriate parameter from the [Filter] pull-down 
menu.

• To save the raw scan data (.cam) when importing 
data, check the [Save camera data] checkbox.

Note
The	element	name	must	consist	of	up	to	31	alphanu-
meric	characters.

7 Click the [OK] button.
The scanned image will be displayed. The 
names of the imported elements will also 
appear in the element list, indicating that the 
elements have been selected (highlighted).
• The loaded data will be ready to be displayed in 

all windows. It will be displayed in the active 
window and the windows for which all the ele-
ments are set to be displayed.

• When the data is loaded for the first time after 
the software is started, it will be fully framed in 
all the windows including those that are hidden 
automatically.

• If the [Save camera data] checkbox was checked at 
step 7, the [Remote-Save] dialog box will appear.
q Enter the desired file name.
w Click the [Save] button.

Note
The	file	name	must	consist	of	alphanumeric	characters	
only.
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Parameters for [File-Import-Digitizer-One Scan] Dialog Box

Scan Causes the VIVID 300 (VI-300) to acquire a shot.

Option If this checkbox is checked, the lower section of the [Digitizer-One Scan] dialog box will be 
active, allowing you to set various parameters including [Distance], [Laser Intensity] and [Auto 
read].

Manual If this checkbox is checked, the [Distance] and [Laser Intensity] parameters can be set.

Distance Used to set VIVID’s scan reference position.

Laser Intensity Used to set the laser beam intensity of the VIVID.

Auto read If this checkbox is checked, a color image will be read automatically when the dialog box is 
opened. Even if the [Read] button is not clicked after the [Scan] button is clicked, the data will be 
read automatically after images are acquired, and the color image and range image will be dis-
played in the dialog box. If there is no check mark in the [Option] checkbox, for instance when the 
software is just started up, the [Auto read] checkbox will be checked automatically.

Read Clicking this button while there is no check mark in the [Auto read] checkbox will read data from 
the instrument and display the range image and the latest color image that were acquired when 
the [Scan] button was clicked last time in the dialog box. This button is effective only if the [Auto 
read] checkbox is unchecked.

Focus Lock Sets the focus lock. The [Manual] checkbox will be checked automatically, and the current posi-
tion and Laser Intensity will be displayed.

Convert Causes the [File-Import-Digitizer-One Scan-Convert] dialog box to appear, allowing import of the 
camera data to this software.

Parameters for [File-Import-Digitizer-One Scan-Convert] Dialog Box

Reduction Rate Selects the reduction rate to be applied when importing the data. You can select any of the follow-
ing: “1/1”, “1/4”, “1/9”, “1/16”, or “No polygon”.

Fill Holes Selects whether the programs fill in holes when importing the data. If the setting is “On”, the pro-
gram will automatically generate points to fill in holes left by missing data.

Remove Selects which the data the program excludes when carrying out the import. Select from an of the 
following: “None”, “Boundary (B.)”, “5deg. & B.”, “10deg. & B.”, “15deg. & B.”, or “20deg. & B.”
None:  Removal is not carried out when importing the data.
Boundary(B.): The program removes boundary points.
5deg. & B.,10deg. & B., 15deg. & B., 20deg. & B.:

The program removes boundary points, and also removes polygons within the 
specified angular range (5°, 10 °, 15°, or 20 °) to the view vector.

Filter None:   The program does not perform filtering when importing the data.
Noise Filter (N.F.): When importing the data, the points that appear to be noise will be corrected ac-

cording to other data.

Save camera data Save the images as camera data.
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Performing Step Scan with the VIVID 300

This command is used to take two or more shots using the optional rotating stage via the remote control func-
tion of this software. If a rotating stage has been selected by the Turntable, rotation of the stage can also be 
controlled.
After the necessary shots are taken, scan the calibration chart. Data acquired from different angles will be 
subjected to registration, and the resulting data will appear.

Warning

Never stare into the laser emitting window.

Do not place a lens, mirror or optical element in the passage of the laser beam. Doing so may converge the 
laser beam, resulting in damage to your eyes, burns or fire. To prevent the above accidents, make sure that a 
wall or similar which can block the laser beam is located behind the object. 

Note
If	the	rotating	stage	does	not	operate	correctly	from	the	
dialog	box,	turn	OFF	the	stage,	turn	it	ON	again,	and	
then	try	to	operate	it.

Memo

• The calibration chart is an accessory of the rotating 
stage set.

• Before performing the procedure below, make sure that 
the digitizer you are going to use is selected by the File 
– Select Digitizer command.

Ref.  For details of the File	–	Select	Digitizer command, 
refer to page 144.

 Operating Procedure 

1 From the [File] menu, select [Import], 
[Digitizer] and then [Step Scan].
The [File-Import-Digitizer-Step Scan] dialog 
box will appear.

• The color monitor image currently captured by 
the VIVID 300 will appear in the “Color” area of 
the dialog box. (No color image will appear if the 
[Auto read] checkbox is unchecked even if the 
[Option] checkbox is checked.)

2 Place the object on the rotating stage.

3 Select the desired rotation step from 
“90”, “60” and “Other”. The rotating 
stage will rotate at the selected step.
If “Other” is selected, enter the desired rota-
tion angle.
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5 Click the [Scan] button.
Scan will start, and both color and range im-
ages will be displayed.
The “Next shot? (angle:**)” message dialog 
box will also appear.

4 Set optional parameters.
Check the [Option] checkbox, and make nec-
essary parameters.

• To set the scan reference position (Distance) and 
laser intensity (Laser Intensity), perform the fol-
lowing procedure.
q Check the [Option] checkbox.
w Check the [Manual] checkbox.
e Move the [Distance] bar or [Laser Intensity] 

bar to the desired position.
• If you are not going to scan both color and range 

images at the same time, uncheck the [Auto read] 
checkbox.

• If the color and range images are not scanned at 
the same time, clicking the [Read] button will 
capture a color image and display it.

• If the type of rotating stage has not been desig-
nated, turn the rotating stage manually to the next 
angle displayed in the “Next shot? (angle:**)” 
message dialog box.

6 Click the [OK] button.
The next specified angle will appear in [Current 

Angle], and the object will be scanned for the 
next image.

• If a rotating stage has been selected by the Turn-
table, the stage will turn to the next angle and 
then the object will be scanned.

• To cancel scan, click the [Cancel] button instead 
of the [OK] button, and repeat steps 4 to 5.

7 Repeat step 6 until shots from all the 
desired angles are captured.
When shots from all the desired angles are 
captured, the “Next shot? Please set the 
chart.” message dialog box will appear.

• If you want to acquire a shot from a certain angle 
again, click the angle currently displayed in [Cur-
rent Angle] with the left mouse button, then select 
the desired angle from the pull-down menu that 
appears.

Memo

If an angle (rotation step) has been selected at step 3, 
necessary steps (angles) to complete 360 degrees will 
be displayed in the pull-down menu. However, it is not 
necessary to scan at all the angles. You can select neces-
sary steps (angles) only.

Download from Www.Somanuals.com. All Manuals Search And Download.



123

Chapter 2
File
Menu

300

File – Import – Digitizer – Step Scan (When VIVID 300 is Selected)

8 Place the calibration chart on the rotat-
ing stage.
Position the chart with the black line facing the 
instrument and place it on the rotating stage 
so that both entire side surfaces are observed 
in the viewfinder.
• If “Chart” is not displayed in [Current Angle], 

click the left mouse button and select “Chart” 
from the pull-down menu that appears.

Memo

The calibration chart can be scanned at any angle of the 
rotating stage.

9 Click the [OK] button.
The calibration chart will be scanned.
Note
Make	sure	that	the	acquired	range	image	looks	like	
the	good	example	given	below.	If	it	resembles	the	bad	
example,	click	the	[Scan]	button	again	to	re-scan	the	
calibration	chart.

10 Click the [Convert] button.
The [File-Import-Digitizer-Step Scan-Convert] 
dialog box will appear.

Good example Bad example
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11 Enter the desired element name, and 
set parameters.

13 Click the [OK] button.
Fine-registration of the element position will 
be performed and the data will be displayed 
again.
• If a rotating stage has been selected by the Turn-

table, the stage will turn to the next angle and 
then scan will be performed.

• Select the desired rate from “1/1”, “1/4”, “1/9”, 
“1/16” and “No polygon” by selecting from the 
[Reduction Rate] pull-down menu.

• If you want to generate points to fill in holes caused 
by missing data, set the [File Holes] setting to “On”.

• The [Remove] pull-down menu lets you select 
which points to remove from the imported data.

  You can set this to any of the following: “None”, 
“Boundary(B.)”, “5deg. & B.”, “10deg. & B.”, 
“15deg. & B.”, or “20deg. & B.”

• If you want to filter the imported data, select the 
appropriate parameter from the [Filter] pull-down 
menu.

• To save the raw scan data (.cam) when importing 
data, check the [Save camera data] checkbox.

Note
The	element	name	must	consist	of	up	to	31	characters.

12 Click the [OK] button.
Each scanned image will be subjected to reg-
istration and displayed, and the “Proceed to 
registration?” message dialog box will appear.
The element list will also show the element 
name specified at step 11 plus “rotation step”. 
The element name is highlighted, indicating 
that it is currently selected.
• The loaded data will be ready to be displayed in 

all windows. It will be displayed in the active 
window and the windows for which all the ele-
ments are set to be displayed.

• When the data is loaded for the first time after 
the software is started, it will be fully framed in 
all the windows including those that are hidden 
automatically.

• If a rotating stage has been designated, the rotat-
ing stage will rotate back to the original position 
before data reading starts.

• If the [Save camera data] checkbox was checked 

at step 11, the [Remote-Save] dialog box will ap-
pear before the one that asks whether you want to 
perform fine-registration.
q Enter the desired file name.
w Click the [Save] button.

Note
The	file	name	must	consist	of	alphanumeric	characters	
only.

• If you are not going to perform fine-registration, 
click the [Cancel] button instead of the [OK] but-
ton.

Memo

Fine-registration can be cancelled even if it has started, by 
clicking the [Cancel] button in the dialog box that appears 
during fine-registration.
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Parameters for [File-Import-Digitizer-Step Scan]  Dialog Box

Turntable Used to set the serial port and rotating stage type to be used for remote operation.

Note
If	connecting	to	a	SKIDS-60YAW	unit,	select	“CSG-602R(Ver.1.0)”	from	the	pull-down	menu.	
If	connecting	to	a	SKIDS-60YAW	(Ver.	2.0)	unit,	select	“CSG-602R(Ver.2.0)”.

Rotation step Used to select the desired angle (degree) of the rotating stage from “90”, “60” and “Other”. If 
“Other” is selected, enter the desired rotation step..

Current Angle Used to select the desired scan step (i.e. the angle at which scan is to be performed). “0” will be 
selected first when the dialog box is opened. It is possible to select the desired angle by clicking 
the angle currently displayed in [Current Angle] and selecting the desired angle from the pull-
down menu that appears. If an angle at which scan has already been performed is selected again 
and the [Scan] button is clicked, the previously acquired image data will be overwritten.

Scan Causes the VIVID 300 (VI-300) to acquire a shot.

Option If this checkbox is checked, the lower section of the [Remote-Step Scan] dialog box will be active, 
allowing you to set various parameters including [Distance], [Laser Intensity] and [Auto read].

Manual If this checkbox is checked, the [Distance] and [Laser Intensity] parameters can be set.

Distance Used to set the VIVID’s scan reference position.

Laser Intensity Used to set the laser beam intensity of the VIVID.

Auto read If this checkbox is checked, a color image will be read automatically when the dialog box is 
opened. Even if the [Read] button is not clicked after the [Scan] button is clicked, the data will be 
read automatically after images are acquired, and the color image and range image will be dis-
played in the dialog box. If there is no check mark in the [Option] checkbox, for instance when the 
software is just started up, the [Auto read] checkbox will be checked automatically.

Read Clicking this button while there is no check mark in the [Auto read] checkbox will read data from 
the instrument and display the range image and the latest color image that were acquired when 
the [Scan] button was clicked last time in the dialog box. This button is effective only if the [Auto 
read] checkbox is unchecked.

Focus Lock Sets the focus lock. The [Manual] checkbox will be checked automatically, and the current posi-
tion and Laser Intensity will be displayed.

Convert Causes the [File-Import-Digitizer-Step Scan-Convert] dialog box to appear, allowing import of the 
camera data to this software.

Parameters for [File-Import-Digitizer-Step Scan-Convert] Dialog Box

Reduction Rate Selects the reduction rate to be applied when importing the data. You can select any of
the following: “1/1”, “1/4”, “1/9”, “1/16”, or “No polygon”.

Fill Holes Selects whether the programs fill in holes when importing the data. If the setting is “On”,
the program will automatically generate points to fill in holes left by missing data.

Remove Selects which the data the program excludes when carrying out the import. Select from
an of the following: “None”, “Boundary (B.)”, “5deg. & B.”, “10deg. & B.”, “15deg. &B.”, or 
“20deg. & B.”
None:  Removal is not carried out when importing the data.
Boundary(B.): The program removes boundary points.
5deg. & B.,10deg. & B., 15deg. & B., 20deg. & B.:

The program removes boundary points, and also removes polygons within the 
specified angular range (5°, 10 °, 15°, or 20 °) to the view vector.

Filter None:  Removal is not carried out when exporting the data.
Noise Filter (N.F.): When importing the data, the points that appear to be noise will be corrected 

according to other data.

Save camera data Save the images as camera data.
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Aligning Multiple Scans (for VIVID 910 only)

This program allows you to take and align multiple shots (multiple scans) of a single object using a VIVID 
910. You use the program to remotely control the scans, and you attach markers onto the object so that the 
program can correlate the data taken from multiple shots (at multiple angles). The program aligns the data 
based on the markers, and displays the result.

Left :  Set marker correspondence
Right :  Edit/Add marker
[Ctrl] + Right : Delete marker

 Operating Procedure 

1 From the [File] menu, select [Import] 
– [Digitizer] and click [Easy Align].
The program opens the [File-Import-Digitizer-
Easy Align] dialog and a temporary window.

Memo

• This command works only with the VIVID 910.
• To use all function of this command, connecting to 

VIVID 910 and the license will be required.
• Prior preparation (calibration) is required for the 

marker to be automatically recognized.

Ref.  For details about the Automatic Marker	Recogni-
tion, refer to page 131.

• If the VIVID 910 is connected, the monochrome 
monitor image currently captured by the VIVID 
910 will appear in the work window area on the 
left of the dialog box.

• The very first time you use this command (with 
the VIVID 910 connected), the command begins 
by displaying the [License Failure] dialog box.

Memo

If the VIVID 910 is not connected when you first execute 
this command, the [License Failure] dialog box will not 
appear and the program will not check for a license. You 
can continue directly from step 2 below.

q Click the [OK] button.
 The [File-Import-Digitizer-Easy Align-Li-

cense] dialog box opens.
w At the dialog, enter the license code that cor-

responds to the displayed VIVID 910 serial 
number, and then click [OK].
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Note
If	you	do	not	enter	the	correct	lisence	code,	the	[Con-
vert]	button	will	not	be	enabled.	This	means	that	you	
will	not	be	able	to	make	use	of	the	aligned	data.

File – Import – Digitizer – Easy Align

2 Adhere markers onto the object.
Memo

Note that some objects have delicate surfaces that may 
be damaged when markers are peeled off after use. In 
particular, the markers we provide have fairly strong ad-
hesive and will become difficult to peel off if left attached 
for more than 24 hours.

3 Adjust the position of the object and 
move the VIVID 910 forward or back so 
that the object appears at the middle of 
the image area at the appropriate view 
angle.

4 Click the [Scan Mode] tab, and set the 
scan mode to either Fine or Fast.

5 If you are using a turntable, click the 
[Turntable] tab and set the serial port, 
the rotating stage type, and the rotation 
angle.

6 Set other parameters as necessary.
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8 If necessary, adjust the marker corre-
spondences.

7 Click the [Scan] button.

The program takes the scan and displays the 
resulting color image in the work window area 
on the left of the dialog. It also automatically 
detects the markers, and displays a single 
character (0 to 9 or A to Y) for each “marker 
ID” (0 to 34) in each location at which a marker 
was detected.
  
If the program determines that the scanned 
data is good enough for alignment processing, 
the condition bar (under the work window) be-
comes blue and displays the “Good condition” 
message. If the program determines that the 
scan results are not good enough for align-
ment, the condition bar turns red and displays 
“No good”.

Memo

On the color image, areas that have no distance data are 
displayed as black.

• When [Auto Marker Detection] checkbox is un-
checked, the automatic marker detection will not 
be carried out.

• As an alternative to taking the scan at this time, 
you can import a saved scan (CDM file) that was 
previously taken with the VIVID 910. Just click 
the [Import] button and load the appropriate file.

• If any of the detected marker IDs does not match 
the corresponding marker on the actual object, 
correct as follows: right-click the marker ID on 
the image, and then enter the correct marker ID at 
the dialog that opens.

• If any of the marker IDs displayed on the previ-
ously stored image (the image stored at step 9 be-
low) does not match the corresponding marker ID 
displayed on the image scanned at step 7 above, 
correct as follows: Left-click the mismatched ID 
in either of these two images, and then left-click 
on the correct corresponding marker ID in the 
other image. The program will change the IDs so 
that they are identical.

• To set up a “new” marker ID on images from 
Step 7 on Step 9 in a location where there was 
no physical marker on the object (or where the 
program failed to detect a marker), left-click the 
corresponding points in the two images. The 
program will display a marker ID of “*” at these 
points.

Note
If	the	condition	bar	(under	the	work	window)	is	red,	this	
means	that	the	data	is	not	yet	suitable	for	alignment.
Adjust	the	marker	correspondences	and	take	other	steps	
as	necessary	until	the	bar	becomes	blue.
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9 Click the [Store] button.
The data displayed in the work window moves 
over into the store window on the right side of 
the dialog.
Marker detection results are indicated in the 
condition bar. The temporary window shows a 
preliminary
converted image (“pre-converted” image) of all 
of the stored data.

10 Repeat steps 7 to 9 as necessary to 
scan at all desired angles. • You can use the [<<Prev] button or [Next>>] but-

ton to move through the stored-data displays.
• You can use the [Delete] button to delete unnec-

essary stored data.
• You can use the [View] button to move through 

the data display or hiding in the temporary win-
dow.

11 If you have adjusted the marker cor-
respondences, click the [Pre-Convert] 
button.
The image displayed in the store window area 
(on the right of the dialog box) is realigned 
based on the change in the marker correspon-
dence, and the result appears in the temporary 
window.

12 Click the [Convert] button.
The program opens the [File-Import-Digitizer-
Easy Align-Convert] dialog.
• If you did not enter a valid license code at Step 1 

above, the [Convert] button will not appear.
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13 Enter an element name and set the ele-
ment parameters.

14 Click the [OK] button.
The temporary window (the window that was 
showing the pre-converted image) closes. The 
program converts the data that was displayed 
in the store window, and displays the resulting 
aligned data.
• The loaded data will be ready for display in all 

windows. It will be shown in the active window 
and in those windows for which all elements are 
set to be displayed (i.e., in those windows that are 
not set to “Selective”).

• The first time the program loads data after starting 
up, it will be fully framed in all windows (includ-
ing those that are hidden automatically).

• If you are using the rotating stage, the stage now 
rotates back to its origin.

• For elements that existed prior to execution of 
this command, the selection status and display 
states remain unchanged.

• Select the data resolution from the [Reduction 
Rate] pull-down menu. Choices are: “1/1”, “1/4”, 
“1/9”, “1/16”, or “No polygon”.

• If you want the program to fill-in lost data areas 
when loading the data, set [Fill Holes] to “On”.

• At the [Remove] pull-down menu, select the 
data to be excluded at time of loading. Choices 
are: “None”, “Boundary (B.)”, “5deg.& B.”, 
“10deg.& B.”, “15deg.& B.”, and “20deg.& B.”

• If you want to filter the data when loading it, 
make the appropriate selection at the [Filter] pull-
down menu.

• If you want to apply 3D processing to the marker 
sections, make the appropriate selection at the 
[Marker Correction] pull-down menu.

• If you want to use texturing, check the [Use Tex-
ture] checkbox.

• If you want to save the data at the time of conver-
sion, check the [Save Data] checkbox.

Note
Enter	an	element	name	of	up	to	31	alphanumeric	char-
acters.

• If you checked [Save Data] (at Step 13 above), 
the program opens the [Easy Align-Save] dialog 
box (shown above).
q Enter a filename for the saved file.
w Click the [Save] button.

Note
The	filename	must	be	alphanumeric	characters	only.
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n Calibration to Facilitate Automatic Marker Recognition

n VIVID 910 White Balance Adjustment

In the Easy Align, position alignment is carried 
out based on the marker information gotten 
from the markers affixed to the object to be 
measured. The program identifies markers 
by color patterns. Under some scan lighting 
conditions, however, the program is unable 
to distinguish the markers correctly. Accord-
ingly, adjustment is necessary to carry out by 
implementing calibration of the White Balance 
adjustment and Color Chart under the same 
lighting conditions as those used for the actual 
scan in order to get stable and correct marker 
information, as you will use for scanning the 
marked object.
The calibration procedure described below 
generates the reference file. Once the file 
has been created, the program will use it as 
reference when detecting markers from the 
scanned images.

Memo

In performing calibration, always be sure to attach the 
same lens that will be used during the actual scan of the 
object to be measured.

Because the Easy Align command must au-
tomatically detect the markers adhered to 
the scanned object, lighting conditions are of 
critical important. This means that it is neces-
sary to adjust the white balance at the VIVID 
910 unit before using the command, and it is 
important to keep the illumination conditions 
constant during measurements.

Note
The	Easy	Align	command	cannot	be	used	if	you	are	
working	near	a	window	exposed	to	the	midday	sun,	or	if	
you	are	using	a	tungsten-color	fluorescent	light	source.

Memo

The recommended light source is a daylight-colored 
fluorescent lamp with a brightness that is appropriate for a 
typical office environment (about 500 lux).

Ref.  For information about how to carry out white-bal-
ance adjustment, refer to page 43, in the VIVID 910 
unit’s Instruction Manual.

Download from Www.Somanuals.com. All Manuals Search And Download.



132

Chapter 2
File
Menu

910

File – Import – Digitizer – Easy Align

n Color Chart Calibration

 Operating Procedure 

To carry out the following procedure, you must first open the [File-Import-Digitizer-Easy Align] dialog.

1 Click the [Parameters] tab.

Note
The	[Settings]	button	will	not	appear	if	[Auto	Maker	
Detection]	is	unchecked.

2 Click the [Settings] button.
The name of the button changes to [Calibra-
tion]. It is now possible to change the [Color 
Level].

3 Place the supplied color chart same 
position as the object to be scanned.
Set the lighting to the same conditions you will 
use when carrying out the actual scan. Set the 
color chart so that it is directly facing the VIVID 
910 lens.

Note
To	be	sure	that	you	scan	only	the	chart	and	not	any-
thing	else,	check	the	image	shown	in	dialog	to	confirm	
that	you	have	placed	the	chart	in	the	right	place.

Color chart
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4 Click the [Calibration] button.
The program executes calibration. If calibra-
tion is successful, the “Calibration success.” 
message dialog box will appear.

• If calibration is not successful, the “Calibration 
failure.” massage dialog box appears. If this hap-
pens, click the dialog’s [OK] button, and effect 
the measures listed below in accordance with the 
content given in the dialog.

  In the case of that the “Lighting is too bright.” 
message dialog box will appear, the light source 
is too strong, so decrease its intensity.

  In the case of that the “Lighting is too dark.” mes-
sage dialog box will appear, the light source is too 
dark, so increase its intensity.

  In the case of that the “Chart setting is improper. 
or Light source is improper.” message dialog box 
will appear, either the Color Chart has been im-
properly set or the light source is unstable. Make 
sure that the Color Chart directly faces the VIVID 
910 and that it fills the screen completely. Also 
check to make sure that the fluorescent light is not 
flickering.

5 Click the [OK] button.
The dialog closes. This completes the calibration.
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Parameters in the [File-Import-Digitizer-Easy Align] Dialog

Import Lets you import data that was previously scanned by a VIVID 910 and saved as a CDM file. 
Once you have imported the data, you can proceed just as you would when working with an 
actual scan. Note that if you are using saved CDM data from a step-scan, the program will only 
import the data currently shown in the preview. The data that is not in the color image or VIVID 
900 data cannot be imported

AF Executes auto-focus. To manually adjust the distance, exposure, or other settings, open the Gen-
eral tab and set as desired. This button is active only if the VIVID 910 is connected.

Scan Executes scanning. When [Auto Marker Detection] checkbox is checked, the automatic marker 
detection will be carried out. When the [Color Level] checkbox is unchecked at the time of auto-
matic marker detection, the automatic switching of color levels will be carried out, and there are 
cases when color images are taken multiple times. This button is active only if the VIVID 910 is 
connected.

Color Read Retakes a color shot and display the newest picture by clicking this button after scanning.
This button will be enabled after scanning.

Auto If this checkbox is checked, the program will automatically execute store processing on imported 
or scanned data that is determined to be in “good condition” (i.e., for which the condition bar 
appears blue). When the command starts, this checkbox is empty.

Store Registers the scanned data as stored data.

View marker ID Turns display of marker IDs in the work and store windows ON or OFF.

Mono/Color/Pitch Changes the type of the display in the work window.  
Mono : The window displays monochrome monitor data. (It is available only if the VIVID 

910 is connected.) 
Color : The window displays color data. 
Pitch : The window displays distance data for scanned or imported data.

Prev/Next Change display to the previous or next stored data by clicking the [Prev] or [Next] button.

Delete Deletes the stored data currently shown in the store window. If the program is showing the result 
as an element in the temporary window, this element is also deleted.

Pre-Convert Pre-converts and aligns the stored data, and displays the result in the temporary window.

View Turns the pre-converted element display in the temporary window ON or OFF.

Convert Converts all stored data in accordance with the specified parameter settings, and displays the 
aligned result.

General Tab

Distance Checking this checkbox sets [Distance] on.

Intensity Checking this checkbox sets [LD] and [Gain] on.

LD Sets the intensity of the laser beam.

Gain Sets the gain.

Focus Lock Executes focus lock. When you select this item, the program automatically places checks in the 
[Distance] and [Intensity] checkboxes, and displays the current set position, the laserbeam inten-
sity, and the gain value.

Scan Mode Tab

Fine/Fast Sets the scan mode.

Dynamic Range
Expansion

If this checkbox is checked, the program takes multiple shot so as to expand the dynamic range 
and reduce data loss.

High Quality If this checkbox is checked, the program includes display of low-reliability data. On the range 
image, data for which laser intensity was too high appear in light gray, while data for which 
intensity was too low are shown in dark gray.
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Parameters in the [File-Import-Digitizer-Easy Align] Dialog

Parameters Tab

Auto Maker Detection Check this checkbox if using markers.

Settings When you click this button, the button’s name changes to [Calibration]. You can then change 
the color level and carry out calibration. This button appears only if the [Auto Maker Detection] 
checkbox is checked

Color Level Checking this checkbox sets the program to use color exposure level.

Calibration If this checkbox is checked, the program gets a color image and generates a reference file from 
it. This check box appears only if the [Auto Maker Detection] checkbox is checked.

Log If this checkbox is checked, the program applies logarithmic correction to color data. Use if you 
want to brighten up neutral colors. This check box appears only if the [Auto Maker Detection] 
checkbox is unchecked.

Smooth If this checkbox is checked, the program applies smoothing to color data. Use if illumination is 
low and the image is unclear. This check box appears only if the [Auto Maker Detection] check-
box is unchecked.

Dark If this checkbox is checked, the program applies dark correction to color data. Use if you are get-
ting striation-type noise in the images. This check box appears only if the [Auto Maker Detec-
tion] checkbox is unchecked.

Turntable Tab

Apply When you click the [Apply] button after selecting the serial port and rotating stage, the [Angle] 
slidebar becomes effective and stage control is enabled.
Note
If	connecting	to	a	SKIDS-60YAW	unit,	select	“CSG-602R	(Ver.1.0)”	from	the	menu.	If	connecting	to	a	
SKIDS-60YAW	(Ver.2.0)	unit,	select	“CSG-602R	(Ver.2.0)”.

Angle The Angle slidebar becomes enabled when the program determines that the rotating stage is 
operating normally. You can use the slidebar to control the stage’s rotation.

Parameters in the [File-Import-Digitizer-Easy Align-Convert] Dialog

Reduction Rate Selects the reduction rate to be applied when importing data. You can select any of the following: 
“1/1”, “1/4”, “1/9”, “1/16”, or “No polygon”.

Fill Holes Selects whether the program fills in holes when importing the data. If the setting is On, the pro-
gram will automatically generate points to fill in holes left by missing data.

Remove Selects which data the program excludes when carrying out the import. Select from any of the fol-
lowing: “None”, “Boundary (B.)”, “5deg. & B.”, “10deg &B.”, “15deg & B.”, or “20deg. & B.”

None:    No removal when importing the data.
Boundary (B.):  The program removes boundary points.
5deg & B., 10deg & B., 15deg. & B., 20deg. & B.:

The program removes boundary points and also removes polygons within 
the specified angular range (5°,10°, 15°, or 20°) to the view vector.

Filter None:   The program does not perform filtering when importing the data.
Noise Filter (N.F.): When importing data, the program corrects the points that appear to be noise.
High Quality (H.Q.): The program filters out unreliable data. (Effective only when importing 

data that was scanned using the VIVID 910.)
H.Q & N.F.:  Applies both noise filter and high quality filter. (Effective only when im-

porting data that was scanned using the VIVID 910.)

Marker Correction None:   The program does not perform filtering the marker sections.
Cut marker:  The data in the marker section will be deleted and treated as a hole.
Smooth marker: Smoothing will be carried out for the marker section data.

Use Texture Check this checkbox when using texture.

Save Data If you check this checkbox, the program will automatically save the data into a camera data file 
when carrying out conversion.
Note
If	you	select	CDM	as	the	file	type	for	the	save	(at	the	Save	dialog	that	appears)	,	the	program	will	not	include	the	
above-described	data	corrections	and	data-coordinate	conversion	information	into	the	saved	file.	If	you	select	a	
file	type	other	than	CDM,	however,	the	program	does	incorporate	this	information	into	the	save.
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Performing Precision Registration of Scan Data

This command uses photogrammetry to enable precision registration of data scanned by VIVID 9i, by utiliz-
ing 3D data that is obtained from the 2D data taken by a digital camera.
To obtain 3D data from 2D data, the image data taken by a digital camera from different angles is processed 
using software called “PhotoModeler KM”.
Since this requires some experiences in operation and another software in addition to this Polygon Editing 
Tool software, a separate operation manual has been prepared. For details, refer to the Photogrametry System 
PSC-1 Instruction Manual.

Memo

• This command can only be used on the VIVID 9i.
• To use this command, a license of the Photogrametry 

System PSC-1 is required.
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File – Export – Elements
Exporting Element Data as Various Formats

This command is used to export the data of the selected elements in various data formats.

 Operating Procedure 

1 From the element list, select the ele-
ments to be exported.

2 From the [File] menu, select [Export] 
and then click [Elements].
The [File-Export-Elements] dialog box will appear.
• If two or more elements have been selected, their 

names will be displayed in the order they are 
displayed in the element list.

3 If you want to change the file name, 
enter a new file name.
Note
The	file	name	must	consist	of	alphanumeric	characters	only.

4 From the [File as type] pull-down menu, 
select the desired format.
The following file types are available.
• VRML1.0 (*.wrl)
• VRML2.0 (*.wrl)
• Softimage (*.hrc)
• Wavefront (*.obj)
• DXF (*.dxf)
• ASCII (*.asc)
• STL(ascii, binary) (*.stl)
• MGF (*.mgf)

• If a format (i.e. VRML1.0, VRML2.0, Softim-
age) that allows attachment of images is selected, 
the [With Images] checkbox will be effective. If 
you want to attach images to the data, check the 
checkbox.

Memo

If “Softimage” has been selected in [Export as type] and 
the [Export] button is clicked, four kinds of files will be 
exported (*.hrc, *.mtr, *.pic, *.txt). (Only “*.hrc” files 
will be exported if the [With Images] checkbox is not 
checked.)
To used exported data with “Softimage”, store the data 
files in the following directories of the “Softimage” 
database.
• “*.hrc” file -  [Models] directory
• “*.mtr” file -  [MATERIALS] directory
• “*.pic” file -  [Pictures] directory
• “*.txt” file -  [TEXTURES2D] directory

Note
If	the	element	data	contains	two	or	more	images,	an	error	
message	will	appear	when	the	[Export]	button	is	clicked	
with	“Softimage”	selected	in	[File	as	type],	[With	Images]	
checked	and	[With	Merged	Image]	unchecked.

5 Click the [Export] button.
The first element will be exported, and a dialog 
box for the next element will appear.
• When all the elements are exported, the dialog 

box will close.
• If you click the [Cancel] button, the next element 

and subsequent elements will not be exported.

Parameters for [File-Export-Elements] Dialog Box

Export in Select the folder for exporting data.

File name Input the name of data file to export.

File as type Select format for exporting data.

With Images Textures will also be output when the data is exported.

With Merged Image Textures will be merged and output when the data is exported.

Memo

It is possible to select two or more elements by clicking 
them while holding down the [Shift] or [Ctrl] key.
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File – Export – Elements

n Texture Merging
To merge textures and output the result when the element is exported, follow the procedure given below.

 Operating Procedure 

Before starting the following procedure, make sure that the desired file and output format have been se-
lectedin the [File-Export-Elements] dialog box.

1 Check the [With Images] and then [With 
Merged Image] checkbox in this order.

Note
If	two	or	more	elements	have	been	selected,	it	is	not	pos-
sible	to	check	the	[With	Merged	Image]	checkbox	(the
checkbox	will	be	ineffective).

2 Click the [Export] button.
The [File-Export-Elements] dialog box will 
close, and the dialog box shown on the right 
will appear instead.
• The loaded data will be ready to be displayed in 

all windows. It will be displayed in the active 
window and the windows for which all the ele-
ments are set to be displayed.

• The unselected elements which have been dis-
played when this command is executed will be hid-
den in all windows. The elements that have been 
hidden will be displayed when the menu is exited.

• A projection plane will be displayed in each 
window in such a way that it encloses the element 
(default projection plane: Cylindolical). The axis 
of the projection plane is indicated in red, the 
green end of the axis indicates the top side of the 
projection plane and the blue end indicates the 
bottom side. In addition, disconnections of tex-
tures are indicated by purple lines.

3 Select the desired projection and move 
or rotate it.
Dragging with the left mouse button will rotate 
the projection’s axis, and dragging with the left 
mouse button while holding down the [Shift] 
button will rotate the projection around the axis.
• Changing the “projection” type will cause the 

projection displayed inside the window to change 
to the selected type. The projection will be dis-
played so that it encloses the element.

• To fit the projection to the shape of the element, 
click the [Fit] button.

Note
It	is	possible	to	change	view	mode	for	the	element	view	
window,	but	not	to	close	the	element	view	window.
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File – Export – Elements

4 Set the size and background color.
• Clicking [Background color] with the left mouse 

button will open a color palette, allowing you to 
set the desired background color.

• Width and Height must be set within the range of 
“0” and “10000”. An error message will appear if 
they are outside the range.

5 Click the [Preview] button.
All the element view windows will be hidden, and 
the image and preview windows will appear.
• The image window shows the color image pro-

jected on the projection plane.
• The preview window shows the texture-mapped 

element in full frame. Dragging with the left 
mouse button inside the preview window rotates 
the camera.

• The [Preview] button in the [File-Export-Element], 
will change to the [Preview Close] button and also a 
name of the dialog box will change to [Merge Texture].

  In the [Merge Texture] dialog box, buttons except 
[OK], [Preview Close] and [Cancel] buttons will 
be ineffective.

• Clicking the [Preview Close] button will close the 
image and preview windows and display all the 
element view windows.

  The [Preview Close] button will change to the 
[Preview] button.

• If the image and preview windows are closed, the 
[Preview Close] button will change to the [Pre-
view] button.

  All the element view windows will be displayed.

Note
•	 It	is	not	possible	to	rotate/move	the	projection	plane	
inside	the	preview	window.

•	 Shortcut	keys	cannot	be	used	while	the	preview	win-
dow	is	active.

•	 It	is	not	possible	to	change	view	mode	for	the	element	
view	window.

6 Click the [OK] button.
The element containing the color image pro-
jected on the projection plane will be exported 
in the specified format.
• When the element has been exported, the [Merge 

Texture] dialog box will close.
  If the image window and temporary window are 

open, they will be closed and all the element view 
windows will open instead.

• Clicking the [Cancel] button will cancel all the 
operations that have been performed after the 
[Merge Texture] dialog box was opened.

  If the image window and preview window are 
open, they will be closed and all the element view 
windows will open instead.
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File – Export – Images
Exporting Image Data as Various Formats

This command is used to export the color image data of the selected elements in various data formats.

 Operating Procedure 

1 From the element list, select the ele-
ments to be exported.

2 From the [File] menu, select [Export] 
and then click [Images].
The [File-Export-Images] dialog box will ap-
pear.
If two or more elements have been selected, 
their names will be displayed in the order they 
are displayed in the element list.

3 If you want to change the file name, 
enter a new file name.
Note
The	file	name	must	consist	of	alphanumeric	characters	
only.

4 From the “File as type” pull-down 
menu, select the desired format.
The following image data file types are avail-
able.
• TIFF (*.tif)
• BMP (*.bmp)
• PPM/PGM (*.ppm)
• JPEG (*.jpg)

5 Click the [Export] button.
The first element will be exported, and a dialog 
box for the next element will appear.
When all the elements are exported, the dialog 
box will close.
If you click the [Cancel] button, the next ele-
ment and subsequent elements will not be 
exported.

Parameters for [File-Export-Images] Dialog Box

Export in Select the folder for exporting data.

File name Input the name of data file to export.

File as type Select format for exporting data.

Memo

It is possible to select two or more elements by clicking 
them while holding down the [Shift] or [Ctrl] key.
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 Operating Procedure 

1 From the element list, select the ele-
ment to be removed.

File – Remove Elements
Removing the Selected Element(s)

This command is used to remove element(s) selected in the element list.

Memo

The File – Remove Elements command has the same 
functions as the Edit – Delete – Elements command.

Ref.  For details of the Edit	–	Delete	–	Elements com-
mand, refer to page 169.

Memo

It is possible to select two or more elements by clicking 
them while holding down the [Shift] or [Ctrl] key.

2 Click [Remove Elements] on the [File] 
menu.
A message dialog box asking you whether to 
delete all the selected elements will appear.

3 Click the [OK] button.
All the selected elements and their corre-
sponding points will be removed.
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1 Click [Preferences] on the [File] menu.
The [File-Preferences] dialog box will appear, 
showing the setting conditions.

2 Click the desired tab and make the de-
sired setting for each parameter.

3 Click the [OK] button.
The dialog box will close and the settings 
made at step 2 will be saved.

File – Preferences
Displaying Information for Setting Conditions

This command is used to display information related to various settings.

 Operating Procedure 

Parameters for [General] Tab of [File-Preference] Dialog Box Default Settings

Data dir. Used to set the default directory in which data is to be saved. When 
you specify the default directory or click the [Browse] button, a 
dialog box allowing you to select a directory will appear, so select the 
desired default directory.

Directory from which 
the software is started

Undo Used to set the number of times Undo is to be performed (1 to 20).
Move the slide bar to set.

5

Decimal Digits Used to set the number of point coordinate digits to be displayed. The 
setting made here will be reflected for ASCII output, Info – Points 
and Info –Picked Point, that can be set when File – Export – Elements 
is selected.

2

Mouse Used to set the type of mouse to be used (3 buttons or 2 buttons). The 
status bar will vary with the number of buttons.

3 buttons

Memo

Clicking the [OK] button will effectuate all the changes 
made in the [General] and [Attribute] tabs immediately.
The settings made in the [Default Behavior] tab will be 
saved, and will be effective when this software is started 
next time.

Note
If	the	Undo	number	is	reduced,	the	old	information	
corresponding	to	the	amount	of	reduction	will	be	deleted	
and	cannot	be	restored.
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File – Preferences

Parameters for [Attribute] Tab of [File-Preference] Dialog Box Default Settings

Wireframe

Selected Used to set the wireframe color of the currently selected elements. Pink

Unselected Used to set the wireframe color of the currently unselected elements. Dark gray

Line width Used to set the wireframe line width (0~10). 1

Shading

Selected Used to set the shading color of the currently selected elements.
But note that if you have checked the [Auto] checkbox, the program 
will automatically set the shading color for each element using a 
prearranged color scheme.

Dark green

Unselected Used to set the shading color of the currently unselected elements. Dark gray

Vertex

Selected Used to set the color and size of the currently selected points. Red, Size: 2

Unselected Used to set the color and size of the currently unselected points. Blue, Size: 2

Auxiliary Used to set the color and size of auxiliary points White, Size: 2

Normal

Color Used to set the color and size of the normal. Green
Size: 10

Window

Background Color Used to set the window’s background color.

Parameters for [Default Behavior] Tab of [File-Preference] Dialog Box Default Settings

Simplify unselected
elements

Selects whether the program displays unselected elements in simpli-
fied form (On) or in detailed form (Off).

On

Move input elements
to origin

Effective when loading camera data. If the setting is On, the program 
moves input elements to the origin. If the setting is Off, the program 
displays the elements at their original input coordinates.

Off

Select points of
input elements

If this setting is On, the program sets the all input elements into 
selected state when loading the data.

Off

Use CAD views as
initial windows

Selects the window display mode used when the program starts up. If 
this setting is On, the program starts up using CAD views. If this set-
ting is Off, the program starts up using single-window (isometric) view.

On

Show points Sets display of points to On or Off. Off

Show normals Sets display of normals to On or Off. Off

Show axis Sets axis display to On or Off. On

Flat shading Selects the shading condition, flat shading (On) or smooth shading (Off). Off

Rendering mode Sets the default rendering mode. Shading

Use LOD Selects whether the program shows simplified display (On) or de-
tailed display (Off) during editing of elements. Also sets the level 
between 1 and 100%.

Off

Memo

• To set a color, click the color button and select the desired color from the dialog box that appears. Point and line sizes must be 
set numerically.

• The selected and unselected colors will be hidden if the size of “Selected Color” and “Unselected Color” for [Vertex] is set to 
“0”, respectively.

• If you set the wireframe line width to “0”, the display will show points only-and if you are using LOD at the same time, then 
no data at all will appear. If setting the line width to “0”, therefore, please also sure to set the [Use LOD] setting to “Off”.

Download from Www.Somanuals.com. All Manuals Search And Download.



144

Chapter 2
File
Menu

9i
910
900
700
300

1 Click [Select Digitizer] on the [File] 
menu.
The [File-Select Digitizer] dialog box will ap-
pear, showing the currently selected digitizer.

File – Select Digitizer
Selecting a Digitizer

This command is used to select the VIVID connected to the computer from the digitizer list.

 Operating Procedure 

Memo

After installed this software, the dialog box shows
“None” until selecting the File-Select Digitizer com-
mand.

2 Select the digitizer you want to use, and 
click the [OK] button.
The selected digitizer can be controlled via the 
menus that appear when File – Import – Digi-
tizer commands will be selected.

Memo

If a digitizer has already been selected and you switch it 
to another digitizer, the new digitizer will be usable when 
this software is started next time.

VIVID 9i (VI-9i) Select to use the “VIVID 9i (VI-9i)” 
digitizer.

VIVID 910 (VI-910) Select to use “VIVID 910 (VI-910)” 
digitizer with the new GUI like the one for 
“VIVID 9i (VI-9i)” digitizer.

VIVID 900/910 
(VI-900/910)

Select to use the “VIVID 900 (VI-900)” or 
“VIVID 910 (VI-910)” digitizer.
*	 	When using 2 or more “VIVID 910 (VI-910)” 

digitizers, select this item.

VIVID 700 (VI-700) Select to use the “VIVID 700 (VI-700)” 
digitizer.

VIVID 300 (VI-300) Select to use the “VIVID 300 (VI-300)” 
digitizer.

TS-1000 Select to use the “TS-1000” digitizer.
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1 Click [Exit] on the [File] menu.
The software will be exited.

File – Exit [Ctrl] + [Q]
Exiting the Polygon Editing Tool

This command is used to exit the Polygon Editing Tool.

 Operating Procedure 

• If modifications have been made to an element 
after it has been imported or saved, the “Some el-
ements are modified. Do you want to save them?” 
message dialog box will appear.

• To save the element data, click the [Yes] button.
• Clicking the [No] button will exit the software 

without saving the element data.

Ref.  For details of how to save elements, refer to the File 
– Save – Elements command (page 26).
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View – Orbit [O] (Effective while held down)
Rotating / moving camera (view point) position

This command is used to rotate the camera at the point of interest. In addition, camera position can also be 
moved (dragged).

Memo

Use of a mouse equipped with wheel function enables screen zoom-in/-out by turning the wheel. 

Note
•		 This	command	is	effective	only	for	the	“Isometric”	or	“Perspective”	element	view	window.
•		 View	–	Orbit	mode	will	be	active	when	this	command	is	selected.	To	cancel	the	View	–	Orbit	mode,	execute	the	View	–	Orbit	
command	again.	However,	if	you	are	executing	this	command	using	the	shortcut	key,	the	View	–	Orbit	mode	can	be	can-
celed	by	releasing	the	key.

Left : Rotates the camera in the desired direction.
Middle ([Shift] + Left) : -
Right  : Moves the camera position (Drags Camera).
 * Enables screen zoom-in/-out by turning the wheel.

 Operating Procedure 

1 Click [Orbit] on the [View] menu.

2 Drag the item in an element view win-
dow while holding down the left mouse 
button.
The element will rotate in the direction it is 
dragged. 

• Camera position can be moved while holding 
down the right mouse button and dragging. Use 
of a mouse equipped with wheel function enables 
screen zoom-in/-out by turning the wheel. 

• Dragging while holding down the right button 
will move the camera position.

Memo

Element will be displayed in simple form while camera 
position is moved (dragged). It will be displayed in de-
tailed form when dragging is canceled. 
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View – Zoom [Z] (Effective while held down)
Enlarging/Reducing the Displayed Item

This command is used to enlarge (zoom-in) or reduce (zoom-out) the displayed item, or to move the camera to
change the view angle.

Ref.  For a description of camera position, refer to the View	–	Camera	Settings command (page 155).

Note
View	–	Zoom	mode	will	be	active	when	this	command	is	selected.	To	cancel	the	View	–	Zoom	mode,	execute	the	View
–	Zoom	command	again.	However,	if	you	are	executing	this	command	using	the	shortcut	key,	the	View	–	Zoom	mode
can	be	canceled	by	releasing	the	key.

Left : zoom-in, zoom-out
Middle ([Shift] + Left) : –

Right  : Drags the camera.

 Operating Procedure 

1 Click [Zoom] on the [View] menu.

2 Drag the item in an element view win-
dow while holding down the left mouse 
button.
Dragging the item upward will enlarge it 
(zoom-in) and dragging it downward will re-
duce it (zoom-out).

• To move the camera (i.e. drag the camera), drag 
while holding down the right mouse button.

Memo

The element will be displayed in simple form during 
zoom and drag. It will be displayed in detailed form when
zooming or dragging is canceled.
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View – Full Frame All [Shift] + [F]
Displaying Data Fully in all Windows

This command is used to fully frame the data completely in each element view window.

 Operating Procedure 

1 Click [Full Frame All] on the [View] 
menu.
The currently displayed elements will be 
zoomed in so that they are fully framed in their 
corresponding windows.

View – Full Frame  [F]
Displaying Data Fully in Active  Windows

This command is used to fully frame the data displayed in the active window.

 Operating Procedure 

1 Click [Full Frame] on the [View] menu.
The element currently displayed in the active 
window will be zoomed in so that it is fully 
framed.

Download from Www.Somanuals.com. All Manuals Search And Download.



151

Chapter 2

View
Menu

9i
910
900
700
300

View – Area Orbit [W] (Effective while held down)
Rotating the Camera and Setting the Rotation Center

Use this command to set the camera’s rotation center point, and to rotate the camera in any direction.

Ref. 	To	find	the	camera’s	current	position	and	point-of-interest,	use	the	View	–	Camera	Settings	command (page 155).

Note
This	command	is	effective	in	element	view	windows	whose	view	direction	is	set	to	Isometric	or	Perspective.

Left : Rotates the camera in any direction
Middle ([Shift] + Left) : –

Right  : Sets the center of rotation.

 Operating Procedure 

1 Open the [View] menu and click [Area 
Orbit].

2  Hold down the left mouse button, and 
drag the element (in the element view 
window) to rotate it about its center.
Dragging left or right rotates the element hori-
zontally, while dragging up or down rotates it 
vertically.

•  The image rotates around the center point that 
you select by right-clicking on the element view 
window.

Memo

The program automatically switches to simplified element 
display while the camera is in motion. When you finish 
dragging, the program displays from the new camera 
position using the originally selected display type.

3 Press the [ESC] key.
View–Area Orbit mode will be canceled.
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View – Area Zoom [X] (Effective while held down)
Enlarging/Reducing Item Enclosed by Specified Rectangle

This command is used to enlarge (zoom-in) the item enclosed by a rectangle or reduce (zoom-out) the cur-
rently displayed item so that it is displayed within the rectangle, by defining a rectangle to be used as a scale 
on the element view window.

Left : zoom-in
Middle ([Shift] + Left) : –
Right  : zoom-out

 Operating Procedure 

1 Click [Area Zoom] on the [View] menu.

2  Locate the mouse pointer to the start 
point of the desired area (rectangle), 
drag it, then release the mouse button 
at the end point.
The rectangle to be used as a scale will be 
defined. Dragging while holding down the left 
mouse button will enlarge the item, and drag-
ging while holding down the right button will 
reduce it.

3 Press the [ESC] key.
View – Area Zoom mode will be canceled.
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View – Move Plane [A] (Effective while held down)
Setting Display Depth

This command is used to set the display depth by changing the position (Near Plane) where the target element
starts to appear and the position (Far Plane) where it starts to disappear.

Left  : Near Plane
Middle ([Shift] + Left)  : Near Plane/Far Plane

Right  : Far Plane

 Operating Procedure 

1  Click [Move Plane] on the [View] menu.

•  If you click with the left mouse button, the Near 
Plane will be set on the point you clicked. If you 
click with the right mouse button, the Far Plane 
will be set on the point you clicked.

•  If you click with the middle mouse button ([Shift] 
+ Left), the Near Plane/Far Plane (fixed depth) 
will be centered on the point you clicked.

3 To move the plane, drag it.
•  If you drag with the mouse left button pressed, 

the Near Plane will move. If you drag with the 
mouse right button pressed, the Far Plane will 
move.

•  If you drag with the middle mouse button ([Shift] 
+ Left) pressed, the Near Plane/Far Plane (fixed 
depth) will move.

4 Press the [ESC] key.
View-Move Plane mode will be canceled.

2 Click the point on the element where 
you want to set the display range.
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View – Move Light
Moving the Light

This command is used to move the light, for instance when the element is displayed in shading mode.

Memo

•  The light is a pseudo light designed to produce a shadow when the element view window is in shading mode.
•  The position of the light is set relative to the point of view and line of vision of the window. By default, the light is located in  

the rear right quarter of the line of vision.
• One point light must be used as the light.

Left : Moves the light perpendicular to the line of vision.
Middle ([Shift] + Left) : –

Right : Moves the light along the line of vision.

 Operating Procedure 

1 Click [Move Light] on the [View] menu.
The active window will be set in shading 
mode.

2  Drag the item in an element view win-
dow while holding down the left mouse 
button.
The light will move on a plane perpendicular to 
the line of vision, causing the view of the ele-
ment to change accordingly.

•  Dragging upward while holding down the right 
mouse button will move the light forward along 
the line of vision, and dragging downward will 
move the light backward along the line of vision.

Memo

Dragging while holding down the [Shift] key will in-

crease the movement of the light.

3 Press the [ESC] key.
View–Area Orbit mode will be canceled. 
However, the element will remain displayed in 
shading mode.
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View – Camera Settings
Setting the Camera Parameters

This command is used to set the camera parameters.

Memo

• The camera indicator is provided to help you understand the direction in which the image displayed in “Isometric” or “Perspec-
tive” element view window is taken. (The image displayed in “Isometric” or “Perspective” element view window is the image 
of the object viewed from the camera position.)

• The point of interest indicates the direction in which the image is taken by the camera.

 Operating Procedure 

1 From the [View] menu, select [Camera] 
and then click [Settings].
The [View-Camera Settings] dialog box will 
appear.

2 Set the camera parameters.

Note
If	the	window	view	is	not	set	to	Isometric	or	Perspective,	
some	parameters	settings	are	disabled.	In	particular,	it	will	
not	be	possible	to	set	the	“View	angle”	or	to	set	some	of	the	
“View	point”	and	“Interest”	values,	as	follows.
•	 If	view	is	set	to	Front	or	Back:	Only	the	Z	parameters	
can	be	set.

•	 If	view	is	set	to	Top	or	Bottom:	Only	the	Y	parameters	
can	be	set.

•	 If	view	is	set	to	Right	or	Left:	Only	the	X	parameters	
can	be	set.

•	 If	view	is	set	to	Isometric,	all	parameters	other	than	
“View	angle”	can	be	set.

•	 If	view	is	set	to	Perspective,	all	parameters	can	be	set.

3 Click the [Preview] button.
The changes made to the camera parameters 
for the active window will be effective, and 
the contents of the element view window will 
change accordingly.

4 Click the [OK] button.
The dialog box will close and the changes 
made to the element view window will be 
confirmed.

Parameters for [View-Camera Settings] Dialog Box

View point Camera position

Interest Position of the point of interest

Near plane Position (distance from camera) at which subject becomes visible

Far plane Position (distance from camera) at which subject goes out of sight

View angle View angle of the camera
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View – Image
Displaying Color Images

This command is used to display color images of the element currently selected in the element list.

 Operating Procedure 

1 From the element list, select the de-
sired element.

2 Click [Image] on the [View] menu.
An image window will open and display a color 
image of the selected element.

Memo

If the element includes multiple color images, you can 
switch among color images by placing the mouse pointer 
over the element view window, opening the pop-up menu, 
and selecting the Change Image command.

View – Show Element List/Hide Element List
Displaying/Hiding the Element List

This command is used to display or hide the element list.

 Operating Procedure    When the element list is not displayed:

1 Click [Show Element List] on the [View] 
menu.
The element list will be displayed.

 Operating Procedure    When the element list is displayed:

1 Click [Hide Element List] on the [View] 
menu.
The element list will be closed.

View – Show Toolbar
Displaying the Toolbar

This command is used to display the toolbar.

 Operating Procedure    When the toolbar is not displayed:

1 Click [Show Toolbar] on the [View] 
menu.
The toolbar will appear.

Memo

Nothing will happen if the toolbar is already displayed.

Download from Www.Somanuals.com. All Manuals Search And Download.



157

Chapter 2

Select
Menu

9i
910
900
700
300

Select Menu
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Select – Point
Selecting/Unselecting a Point by Clicking the Mouse

This command is used to select or unselect the clicked point.

Memo

Selected points will be displayed in red, and unselected points will be displayed in blue.
Left : Selects one point present within the rectangle area by clicking the mouse.
Middle ([Shift] + Left) : –

Right : Unselects one point present within the rectangle area by clicking the mouse.

 Operating Procedure 

1  From the element list, select the de-
sired element.

2 Click [Point] on the [Select] menu.
The selected element will be ready to be dis-
played in all windows. It will be displayed if it 
is not displayed in the active window or the 
windows for which all the elements are set to 
be displayed.

3  Click the desired point.
The point will be selected if it is left-clicked 
and unselected if it is right-clicked.

Memo

•  Selected points will be displayed in red, and unselected 
points will be displayed in blue.

• If the Select – Select Front command is switched on 
(i.e. the command name is checked in the menu), the 
Select– Point command will operate only on points 
comprising polygons that are at the front and that are 
visible, and the mouse cursor will change to “+F”. If 
the Select – Select Front command is off (unchecked), 
the Select – Point command will operate on all points, 
and the mouse cursor will change to “+”.

4 Press the [ESC] key.
Select – Point mode will be canceled.
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Select – Rectangle [E] (Effective while held down)
Selecting/Unselecting Points within Specified Rectangle Area

This command is used to select/unselect the points present within a rectangle area drawn using the mouse.

Memo

Selected points will be displayed in red, and unselected points will be displayed in blue.

Note
When	Windows	Vista	or	Windows	7	is	used,	it	may	occur	that	the	object	cannot	be	drawn.	In	this	case,	please	set	the	window	
design	other	than	Windows	Aero.	To	change	the	window	design,	right-click	on	the	desktop	and	select	Personalize	–	Window	
Color	and	Appearance.

Left : Selects all the points present within the rectangle area.
Middle ([Shift] + Left) : –

Right : Unselects all the points present within the rectangle area.

 Operating Procedure 

1 From the element list, select the de-
sired element.

2 Click [Rectangle] on the [Select] menu.
The selected element will be ready to be dis-
played in all windows. It will be displayed if it 
is not displayed in the active window or the 
windows for which all the elements are set to 
be displayed.

3 Locate the mouse pointer to the start 
point of the desired area (rectangle), 
press the left mouse button and drag 
it, then release the mouse button at the 
end point.
A rectangle will be drawn as illustrated, and all 
the points inside the rectangle will be selected 
if the rectangle is drawn while the left mouse 
button is pressed or they will be unselected 
if it is drawn while the right mouse button is 
pressed. Memo

• Selected points will be displayed in red, and unselected 
points will be displayed in blue.

• If using the shortcut key (default is [E]), note that you 
must hold the key down while setting the range of 
points to be selected (or deselected). The shortcut key 
works only on visible parts of the element.

• If the Select – Select Front command is switched on 
(i.e. the command name is checked in the menu), the 
Select – Point command will operate only on points 
comprising polygons that are at the front and that are 
visible, and the mouse cursor will change to “+F”. If 
the Select – Select Front command is off (unchecked), 
the Select – Point command will operate on all points, 
and the mouse cursor will change to “+”.

4 Press the [ESC] key.
Select – Rectangle mode will be canceled.

Press a mouse button at the start point.

Drag
Release the mouse
button at the end
point.
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Select – Bezier
Selecting Points within Specified Bezier Curve

This command is used to select the points present within a Bezier curve drawn using the mouse.

Note
•		 No	any	other	commands	can	be	executed	until	this	command	is	canceled.	To	execute	another	command,	press	the	[ESC]	
key	to	cancel	the	Select	–	Bezier	mode.

•	 	All	the	steps	must	be	carried	out	within	the	same	window.	The	size	of	the	window	(full	or	1/4)	must	be	set	in	advance.

Memo

Selected points will be displayed in red, and unselected points will be displayed in blue.

Note
When	Windows	Vista	or	Windows	7		is	used,	it	may	occur	that	the	object	cannot	be	drawn.	In	this	case,	please	set	the	window	
design	other	than	Windows	Aero.	To	change	the	window	design,	right-click	on	the	desktop	and	select	Personalize	–	Window	
Color	and	Appearance.

Left : Sets control points/Edits control points if the curve is closed.
Middle ([Shift] + Left) : Confirms the curve if it has been closed/Unselects the points and exits the menu.

Right : Closes the curve/Confirms the curve if it has been closed/Selects the points and exits the menu.

 Operating Procedure 

1 From the element list, select the de-
sired element.

2  Click [Bezier] on the [Select] menu.
The selected element will be ready to be dis-
played in all windows. It will be displayed if it 
is not displayed in the active window or the 
windows for which all the elements are set to 
be displayed.

3  Enclose the desired area with a Bezier 
curve.
Clicking the left mouse button will create a 
control point. Dragging it will create a tangent 
line for the created control point. Locate the 
mouse to the next desired point, and click the 
left button to create another control point.
Repeat the above steps until the desired area 
is enclosed with a Bezier curve.

Memo

• The Bezier curve will be shown in white and the con-
trol points in yellow.

• If the Select – Select Front command is switched on 
(i.e. the command name is checked in themenu), the 
Select – Point command will operate only on points 
comprising polygons that are at the front and that are 
visible, and the mouse cursor will change to “+F”. If 
the Select – Select Front command is off (unchecked), 
the Select – Point command will operate on all points, 
and the mouse cursor will change to “+”. 

4 Click the right mouse button.
The Bezier curve will be closed and edit mode 
is activated.

Control point

Tangent line

Drag
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5 To edit the Bezier curve, drag control 
points or tangent lines while holding 
down the left button.

6 Click the right or middle mouse button.
If the right button is clicked, the Bezier curve 
will be confirmed, and the points present 
within the curve will be selected.
If the middle button is clicked, the Bezier curve 
will be confirmed, and the points present 
within the curve will be unselected.

Memo

• Selected points will be displayed in red, and unselected 
points will be displayed in blue.

• If the Select – Select Front command is switched on 
(if the command name is checked in the menu), then 
the Select – Bezier command operates only on points 
comprising polygons that are at the front and that are 
visible. If the Select – Select Front command is off 
(unchecked), then the Select – Bezier command oper-
ates on all points.

7 Press the [ESC] key.
Select – Bezier mode will be canceled. 

Select – Bezier
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Select – Boundary – Elements
Selecting Only the Boundary of Holes of Element(s)

This command is used to select only the points on the boundary of holes among those comprising the selected
element(s).

Memo

Selected points will be displayed in red, and unselected points will be displayed in blue.

 Operating Procedure 

1 From the element list, select the desired 
element(s).

2 From the [Select] menu, select [Bound-
ary] and then click [Elements].
Among the points comprising the currently se-
lected element(s), the points on the boundary 
of holes will be selected and the other points 
will be unselected.

Select – Boundary – Points
Selecting Only the Boundary of Holes of Points

This command is used to select only the points on the boundary of holes, among those currently selected.

Memo

Selected points will be displayed in red, and unselected points will be displayed in blue.

 Operating Procedure 

1 From the element list, select the desired 
element.

2 Select the desired points.

3 From the [Select] menu, select [Bound-
ary] and then click [Points].
Among the selected points, the points on the 
boundary of holes will be selected and the 
other points will be unselected.

• The selected element(s) will be ready to be dis-
played in all windows. It will be displayed if 
it is not displayed in the active window or the 
windows for which all the elements are set to be 
displayed.

• The selected element will be ready to be displayed 
in all windows. It will be displayed if it is not dis-
played in the active window or the windows for 
which all the elements are set to be displayed.
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Select – Color
Selecting Points within Specified Homogeneous Area

This command is used to select the points corresponding to the homogeneous areas that are selected by speci-
fying sample color data (sample point) on the color image window.

Memo

Selected points will be displayed in red, and unselected points will be displayed in blue.

Left : Selects the sample color data (sample points).
Middle ([Shift] + Left) : Selects the sample color data to be excluded from the area enclosed by a dotted line.

Right : Cancels the previous operation (Undo).

 Operating Procedure 

1 From the element list, select the desired 
element.

2 Click [Color] on the [Select] menu.
The [Select-Color] dialog box will appear.
The cursor will switch to a cross cursor when it 
is located over the color image window.

• The selected element will be ready to be displayed 
in all windows. It will be displayed if it is not 
displayed in the active window or the windows for 
which all the elements are set to be displayed.

• If the image window that displays a color image 
has not been opened, it will be displayed when 
this command is selected. If the color image win-
dow of an element other than the selected element 
is currently displayed, it will be closed.

3  On the color image window, locate the 
cross cursor to the point (sample point) 
containing the desired color, then click 
the left mouse button.
An “×” mark will be displayed on the sample 
point, and the homogeneous color area 
around the sample
point will be enclosed by a blinking dotted line. 
The size of the area changes according to the 
value set in [Color range].

4 While observing the selected area, ad-
just the Color range (1 to 100) in the 
[Select-Color] dialogbox.

• The larger the color range is, the larger the en-
closed area.

• If the color range is changed after the sample 
point is specified, the selected area (the area en-
closed by a dotted line) will change accordingly.
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5 If the enclosed area contains an un-
wanted area, locate the cursor to the 
sample point of that area and click the 
middle mouse button ([Shift] + Left but-
ton).
The corresponding area on the color image will 
be excluded from the enclosed area, accord-
ing to the [Color range].

6 If you need another sample area, locate 
the cursor to another sample point, 
then click the left button.
A new enclosed area will be created on the 
color image.

• Clicking the right mouse button over an image 
window will cancel the selections made by click-
ing the left button or middle button ([Shift] + Left 
button), and will cause the previously selected 
areas to be displayed. (This will also cancel the 
sample points.)

  Only the one previous selection can be canceled. 
Older selections will not be canceled.

7 Click the [Apply] button.
The points corresponding to the selected ar-
eas on the color image will be selected.
• Only the points comprising front-facing surfaces 

will be selected.
• Points on back surfaces, points forming back-fac-

ing surfaces and isolated points that are not form-
ing a surface will not be selected.

Memo

• Each time the [Apply] button is clicked, the previously 
selected areas and selection state of the points in those 
areas will be canceled, and the points within the cur-
rently selected areas will be selected.

• If sample areas are selected on more than two color im-
age windows and the color image window is switched 
from one to another, the sample areas (i.e. areas en-
closed by a dotted line) on the previous color image 
window will be deleted. The state of the points selected 
by clicking the [Apply] button on the previous color 
image window will be confirmed, and those selected 
by clicking the [Apply] button from the sample area 
on the new color image window will be added to the 
confirmed points.

8 Click the [OK] button.
Selection state of the points on the element 
view window will be confirmed, and the dialog 
box will be closed. 

Select – Colort
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Select – Toggle Points
Reversing Selection State of Points of Selected Element(s)

This command is used to reverse the selection state of all the points present in the currently selected 
element(s).

Memo

Selected points will be displayed in red, and unselected points will be displayed in blue.

 Operating Procedure 

1 From the element list, select the desired 
element.

2 Click [Toggle Points] on the [Select] 
menu.
Selection state of all the points present in the 
currently selected element will be reversed.

• The selected element will be ready to be dis-
played in all windows. It will be displayed if 
it is n ot displayed in the active window or the 
windows for which all the elements are set to be 
displayed.

Select – Select by Elements [Ctrl] + [A]
Selecting All the Points of Element(s)

This command is used to select all the points present in the currently selected element(s).

Memo

Selected points will be displayed in red, and unselected points will be displayed in blue.

 Operating Procedure 

1 From the element list, select the desired 
element.

2 Click [Select by Elements] on the [Se-
lect] menu.
All the points present in the selected element 
will be selected.

• The selected element will be ready to be dis-
played in all windows. It will be displayed if 
it is not displayed in the active window or the 
windows for which all the elements are set to be 
displayed.
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Select – Unselect by Elements
Unselecting All the Points of Element(s)

This command is used to unselect all the points present in the currently selected element(s).

Memo

Selected points will be displayed in red, and unselected points will be displayed in blue.

 Operating Procedure 

1 From the element list, select the desired 
element.

2 Click [Unselect by Elements] on the 
[Select] menu. 
All the points present in the selected element 
will be unselected.

• The selected element will be ready to be dis-
played in all windows. It will be displayed if 
it is not displayed in the active window or the 
windows for which all the elements are set to be 
displayed.

Select – Select Front
Selecting Only the Points Comprising Polygons that are Both Visible and at the Front

This command is used to limit point selection to only the points that comprise visible, front-facing polygons
(as determined by the current view direction of the selected element).

 Operating Procedure 

1 Click [Select Front] on the [Select] 
menu.
A check mark will be placed and cleared al-
ternately each time this command is selected. 
(Select Front is enabled when a check mark is 
placed, and disabled when no check mark is 
placed.)

• This command determines the action of the Select 
– Point, Select – Rectangle and Select – Bezier 
commands. Specifically, if the Select – Select 
Front command is active (if a checkmark appears 
next to the command name in the menu), then the 
Select – Point, Select – Rectangle and Select 
– Bezier commands will only operate on points 
comprising front-facing, visible polygons. In this 
case, the mouse cursor will change to “+F”.

• If no check mark is placed, all the points in the 
selecting area will be selected. In this case, the 
mouse cursor will change to “+”.
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Edit – Undo [Ctrl] + [z]
Canceling the Previous Operation

This command is used to cancel the previous operation. This command can be performed for the number of
times specified by the File – Preferences command.

Note
Execution	of	this	command	may	not	display	simplified	data.

Ref.  For details of the File	–	Preferences command, refer to page 142.

 Operating Procedure 

1 Click [Undo] on the [Edit] menu.
The state in effect before the previous opera-
tion was performed will be restored. (In the 
case of a command that activates a mode, the 
state in effect before that command was per-
formed will be restored.)

Edit – Redo [Ctrl] + [Y]
Performing the Canceled Operation

This command is used to perform the previous operation that has been canceled by the Edit – Undo command.
It is possible to repeat this command up to the state in effect before the Edit – Undo was started.

Note
Execution	of	this	command	may	not	display	simplified	data.

Ref.  For details of the Edit – Undo command, refer to page 168.

 Operating Procedure 

1 Click [Redo] on the [Edit] menu.
The previous operation that has been can-
celed by the Edit – Undo command will be 
performed.

Memo

The Undo function cannot be used for the following.
• Commands in the [File] menu, except for those 

provided to import camera data and element data
• Commands in the [Info], [View], [File Import 

Digitizer] and [Window] menus
• Selection and display in the element list
• Commands in pop-up menus, except for those 

provided to delete elements.
• Changes to window properties
• Selection/unselection of elements in the element 

view windows
• Operations on image windows

Memo

This command can be repeated until the state in effect 
before the Edit – Undo was performed is restored.

Download from Www.Somanuals.com. All Manuals Search And Download.



169

Chapter 2

Edit
Menu

9i
910
900
700
300

Edit – Delete – Elements
Deleting the Selected Elements from the Element List

This command is used to delete the element(s) selected from the element list.

Memo

The Edit – Delete – Elements command has the same function as the File – Remove Elements command.

Ref.  For details of the	File	–	Remove	Elements	command, refer to page 141.

 Operating Procedure 

1 From the element list, select the 
element(s) you want to delete.

Memo

It is possible to select two or more elements by clicking 
them while holding down the [Shift] or [Ctrl] key.

2 From the [Edit] menu, select [Delete] 
and then click [Elements].
A message dialog box asking you whether to 
delete all the selected elements will appear.

3 Click the [OK] button.
All the selected elements and their corre-
sponding points will be removed.
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Edit – Delete – Points [Ctrl] + [X]
Deleting the Selected Points

This command is used to delete the point(s) selected for the currently displayed element.
Note
Execution	of	this	command	may	not	display	simplified	data.

 Operating Procedure 

1 From the element list, select the desired 
element.

Edit – Delete – Polygons
Deleting Polygons Comprised of Selected Points

This command is used to delete the polygon(s) that are comprised of the points selected in the currently displayed
element.

 Operating Procedure 

1 From the element list, select the desired 
element.

Memo

It is possible to select two or more elements by clicking 
them while holding down the [Shift] or [Ctrl] key.

2 Select the point(s) you want to delete.

3 From the [Edit] menu, select [Delete] 
and then click [Points].
The selected point(s) will be deleted.

• The selected element will be ready to be dis-
played in all windows. It will be displayed if 
it is not displayed in the active window or the 
windows for which all the elements are set to be 
displayed.

Memo

If all the points of the element are deleted, the element 
will be deleted from the element list.

Memo

It is possible to select two or more elements by clicking 
them while holding down the [Shift] or [Ctrl] key.

2 Select the polygon(s) you want to de-
lete.
To select a polygon, all the constituent verti-
ces must be selected.

3 From the [Edit] menu, select [Delete] 
and then click [Polygons].
The selected polygon(s) will be deleted.

• The selected element will be ready to be displayed 
in all windows. It will be displayed if it is not dis-
played in the active window or the windows for 
which all the elements are set to be displayed.

Memo

Even if a polygon is deleted, the vertices comprising that 
polygon will not be deleted.
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Edit – Images
Editing the Texture of Selected Element

This command is used to edit or output color images of the selected element.

 Operating Procedure 

1 From the element list, select the desired 
element.

2 From the [Edit] menu, and then click 
[Images].
The [Edit-Images] dialog box will appear.
• The selected element will be ready to be dis-

played in all windows. It will be displayed if 
it is not displayed in the active window or the 
windows for which all the elements are set to be 
displayed.

• If image windows for displaying color images 
have been opened, they will be closed when this 
command is selected.

The [Texture List] will show the names of the 
images that belong to the selected element.
• Clicking an image name will display its corre-

sponding color image.
Note
An	error	message	will	appear	if	an	element	that	has	no	
images	is	selected.	In	this	case,	the	command	will	not
be	executed.

3 Add, delete or replace textures.

4 Click the [OK] button.
The [Edit-Images] dialog box will close, and 
the texture changes made at step 3 will be 
effected.
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n Adding a Texture ([ADD] button)
The [Add] button allows you to add a texture to the element.

 Operating Procedure 

Before starting the following procedure, make sure that the [Edit-Images] dialog box is displayed.

1 Click the [Add] button.
The [Edit-Images-Open Image] dialog box will 
appear.

2 Select the desired texture file.
• To display files of a certain format only, select the 

desired format from the [Files of type] pull-down 
menu.

3 Click the [Open] button.
The [Edit-Image] and [Edit-Images-Open Im-
age] dialog boxes will close, the data of the 
selected file will be loaded, then the [Point Set] 
dialog box will appear.
• All the element view windows will disappear (be 

hidden), an image window to display the color 
image of the loaded data and an image window to 
display the color image of the element will ap-
pear.

4 On the first image window click the 
desired point using the left mouse but-
ton, then clickthe left button at its cor-
responding point on the second image 
window.
When the left mouse button is clicked on an 
image window, a marker (“×” mark) will be 
displayed. A red marker will be displayed for 
the point you are currently designating, and a 
black marker for those that have already been 
designated.
Note
•	 An	alarm	will	be	heard	if	a	point	that	has	no	data	is	
clicked	in	the	image	window	showing	the	color	image	
of	the	element,	or	if	the	left	button	is	clicked	twice	or	
more	continuously	in	the	same	window.

•	 It	is	not	possible	to	close	image	windows.

Edit – Images
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5 Repeat step 4 until six or more pairs of 
corresponding points are designated.
The order of designating points in the first and 
second image windows for the first pair can 
differ from that for the second pair.

Memo

For satisfactory registration of the images, approximately 
12 pairs of corresponding points must be designated.

6 To delete a pair of corresponding 
points, click either of those points with 
the left mouse button while holding 
down the [Shift] button.
The pair of corresponding points will be de-
leted.
• Even when designating corresponding points, 

they can be deleted by clicking with the left 
mouse button while holding down the [Shift] but-
ton.

• An alarm will be heard if a point other those 
designated is clicked with the left mouse button 
while holding down the [Shift] button.

7 Click the [Preview] button.
A temporary window will appear, showing the 
preview image.
• The temporary window is a Perspective view, and 

is displayed in texture mapping mode.
• Dragging while holding down the left mouse 

button inside the preview window will rotate the 
camera.

Note
•	 An	error	message	will	appear	if	only	five	or	less	pairs	
of	points	have	been	designated.

•	 An	error	message	will	appear	if	calculation	cannot	be	
made	based	on	the	designated	points.

Memo

If registration is not satisfactory, designate more cor-
responding points or delete unsatisfactory corresponding 
points.

8 Click the [OK] button.
A new image will be added to the element.
• All the image windows, [Point Set] dialog box 

and the temporary window (if it is open) will 
close, and the [Edit-Image] dialog box will ap-
pear. All the element view windows will also 
appear.

  The added image will be displayed in the [Tex-
ture List] in the [Edit-Image] dialog box.

Edit – Images

Download from Www.Somanuals.com. All Manuals Search And Download.



174

Chapter 2

Edit
Menu

9i
910
900
700
300

n Replacing a Texture ([Replace] button)
The [Replace] button allows you to replace a texture with a new one.

 Operating Procedure 

Before starting the following procedure, make sure that the [Edit-Images] dialog box is displayed.

1 From the Texture List, select the de-
sired image.

2 Click the [Replace] button.
The [Edit-Images-Open Image] dialog box will 
appear.

3 Select the desired texture file.
• To display files of a certain format only, select the 

desired format from the [File of type] pulldown 
menu.

4 Click the [Open] button.
The data of the selected file will be loaded, 
replacing the image selected from the [Texture 
List] with the one loaded.
• The [Edit-Images-Open Image] dialog box will 

close, and the name of that new image will be 
displayed in the [Texture List] in the [Edit-Image] 
dialog box.

Note
If	the	aspect	ratio	of	the	selected	image	differs	from	the	
aspect	ratio	of	the	image	selected	in	the	Texture	list,	the		
program	will	display	an	error	message.	In	this	case,	the	
texture	will	not	be	replaced.

Edit – Images
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n Deleting a Texture ([Delete] button)
 The [Delete] button allows you to delete a texture from the element.

 Operating Procedure 

Before starting the following procedure, make sure that the [Edit-Images] dialog box is displayed.

n Exporting a Texture ([Export])
 The [Export] button lets you output the selected texture in any of a variety of data formats.

 Operating Procedure 

Open the [Edit-Images] dialog box before starting the following procedure.

1 From the [Texture List], select the de-
sired image.

2 Click the [Delete] button.
A message dialog box asking you whether to 
delete the selected image will appear.

3 Click the [OK] button.
The selected image will be deleted.
• The name of the deleted image will be removed 

from the [Texture List] in the [Edit-Image] dialog 
box.

1 Click on the appropriate image name in 
the [Texture List] of the [Edit-Images] 
dialog box.

2 Click the [Export] button.
The [Export-Image] dialog box will appear.

Memo

Now proceed in the same way as if using the File-Export-
Images command.

Ref.  For information about the File- Export -Images com-
mand, see page 115.

Edit – Images
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n Changing a Texture’s Brightness ([Brightness])
Use the [Brightness] slidebar to adjust the brightness of the selected texture.

 Operating Procedure 

Open the [Edit-Images] dialog box before starting the following procedure.

1 Click on the appropriate image name in 
the [Texture List] of the [Edit-Images] 
dialog box.

2 Adjust the brightness by moving the 
[Brightness] slidebar.
The brightness changes as you move the 
slidebar.

3 If you want to return to the original 
brightness, click [Reset].
The [Reset] button resets both the brightness 
and contrast to their original settings.

4 When you are satisfied with the bright-
ness, click [OK].
The program registers the new brightness set-
ting, and the dialog closes.
• The program will also register your new setting 

if you change the name selection in the [Texture 
List] of the [Edit-Images] dialog box.

Edit – Images
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n Changing a Texture’s Contrast ([Contrast])
Use the [Contrast] slidebar to adjust the contrast of the selected texture.

 Operating Procedure 

Open the [Edit-Images] dialog box before starting the following procedure.

1 Click on the appropriate image name in 
the [Texture List] of the [Edit-Images] 
dialog box.

2 Adjust the contrast by moving the [Con-
trast] slidebar.
The contrast changes as you move the slide-
bar.

3 If you want to return to the original con-
trast, click [Reset].
The [Reset] button resets both the brightness 
and contrast to their original settings.

4 When you are satisfied with the con-
trast, click [OK].
The program registers the new contrast set-
ting, and the dialog box will close.
• The program will also register your new setting 

if you change the name selection in the [Texture 
List] of the [Edit-Images] dialog box.

Edit – Images
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Edit – Define
Defining Points as a New Element

This command is used to define the points selected for the currently selected element(s) as a new element.

 Operating Procedure 

1 From the element list, select the desired 
element(s).

2 Select the desired points.

3 Click [Define] on the [Edit] menu.
The [Edit-Define] dialog box will appear.
• The selected element(s) will be ready to be dis-

played in all windows. It will be displayed if 
it is not displayed in the active window or the 
windows for which all the elements are set to be 
displayed.

4 Enter the desired element name, and 
set parameters.

Note
The	element	name	must	consist	of	up	to	31	alphanu-
meric	characters.

• To copy the color image data of the original ele-
ment, check the [Copy image(s)] checkbox.

5 Click the [OK] button.
The selected points will be defined as an ele-
ment.
• The defined element will be displayed in the win-

dow. The name of the element will also appear in 
the element list, indicating that the element has 
been selected.

• All the elements except for those newly defined 
will be hidden in all windows and cannot be 
selected.
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Edit – Recalc LOD
Recalculating the Simplified Display Data

This command is used to recalculate the simplified display data of the element(s) selected in the element list.

Note
This	feature	is	disabled	if	you	have	set	[Use	LOD]	to	“Off”	in	the	File-Preferences	dialog	(Default	Behavior	tab).

Memo

The simplified display data is displayed, for example, while the camera is dragged. If recalculation is not performed, the
data in effect when the element(s) was simplified lastly will be displayed. If necessary, recalculate the simplified display

data after the data is edited.

 Operating Procedure 

1 From the element list, select the desired 
element.

2 Click [Recalc LOD] on the [Edit] menu.
The simplified display data of the selected ele-
ment will be recalculated.
 
Note
An	error	message	may	appear	if	the	selected	element	
contains	an	excessively	small	number	of	polygons.
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Build Menu

Registration – Initial – Manual ……………………………………………………… 182
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Move – To Origin …………………………………………………………………… 191
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Build – Registration – Initial – Manual
Performing Initial Registration of Elements Manually

This command is used to perform registration of elements by designating corresponding points.

Left  : Designates corresponding points.
Middle ([Shift] + Left)  : Cancels designation of corresponding points

Right : Performs registration.

 Operating Procedure 

1 From the element list, select the desired 
elements.

2 From the [Build] menu, select [Registra-
tion], [Initial] and then click [Manual].
The [Build-Registration-Initial-Manual] dialog 
box will appear.
• The selected element will be ready to be dis-

played in all windows. It will be displayed if 
it is not displayed in the active window or the 
windows for which all the elements are set to be 
displayed.

3 Select the basis element in the dialog 
box, and click the [OK] button.
All the currently displayed windows will be 
hidden, and the temporary window for each 
selected element will appear.

• Each temporary window is a “Isometric” or 
“Perspective” view and displayed in texture map-
ping mode (if the element has a color image) or in 
shading mode (if the element has no color image). 
One element will be displayed in each temporary 
window. The elements will be fully framed.

•  It is not possible to change the view mode and 
rendering mode for the temporary windows.

4 On the first window click the desired 
point using the left mouse button, then 
click the left button at the correspond-
ing point on the second window.
When the left mouse button is clicked on a 
window, a marker (n mark) will be displayed. 
Different colors of markers are available, and 
each pair of corresponding points will have a 
different color.

Memo

Dragging a corresponding point with the left mouse 
button will move it.
Note
An	alarm	will	be	heard	if	a	point	that	has	no	data	is	
clicked	in	a	window	or	if	the	left	button	is	clicked	twice	
or	more	continuously	in	the	same	window.

5 Repeat step 4 until three or more pairs 
of corresponding points are designated.
The order of designating points in the first and 
second windows for the first pair can differ 
from that for the second pair.
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6 To delete a pair of corresponding 
points, click either of those points with 
the middle button ([Shift] + Left).
The marker will be deleted.

Memo

Even when designating corresponding points, they can 
be deleted by clicking with the middle button ([Shift] + 
Left).

Note
An	alarm	will	be	heard	if	a	point	other	those	designated	
is	clicked	with	the	middle	button	([Shift]	+	Left).

7 After designation of corresponding 
points has been completed, click the 
right mouse button.
The initial registration will start, and the result 
will be displayed in the window.
A message dialog box asking whether the 
result is satisfactory will appear.

8 Click the [OK] button.
The program executes fine registration, and 
opens a dialog asking whether the results are 
satisfactory.

• If you click [Retry], the program will reopen the 
temporary windows so that you can reset the cor-
respondences again.

• If you click [Cancel], fine registration will be 
canceled and closes the menu.

9 Click the [OK] button.
All temporary registration windows close, and 
the program reopens the windows that were 
on display when you started the command.

• To continue fine registration processing, click the 
[Repeat] button.

Memo

The [Error Average] and [Sigma] values are indicators of 
the correctness of the registration (the alignment). 
In general, the closer to zero they are, the more accurate 
alignment is.

Build – Registration – Initial – Manual
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Build – Registration – Initial – Auto
Performing Initial Registration of Elements Automatically

This command is used to automatically detect data overlap of each element to perform registration of the ele-
ments.

 Operating Procedure 

1 From the element list, select the desired 
elements.

Memo

It is possible to select two or more elements by clicking 
them while holding down the [Shift] or [Ctrl] key.

2 Select the desired points for each se-
lected element.
The selected points will be subjected to detec-
tion of overlapped data.

3 From the [Build] menu, select [Registra-
tion], [Initial] and then click [Auto].
The [Build-Registration-Initial-Auto] dialog box 
will appear.
• The selected element will be ready to be dis-

played in all windows. It will be displayed if 
it is not displayed in the active window or the 
windows for which all the elements are set to be 
displayed.

4 Select the basis element in the dialog 
box, and click the [OK] button.
Initial registration will start. A bar will be dis-
played to indicate progress of initial registration.

Memo

• If registration with the selected basis element fails for 
any elements, a new basis element will be selected au-
tomatically from the elements whose relative positions 
are known.

• If 50% or more of the element data overlap or if ele-
ments are angled at less than approximately 60 degrees, 
initial registration may be satisfactory. (However, it 
may still fail depending on the shape of the elements.)

Note
An	error	message	will	appear	if	the	number	of	points	
selected	in	the	elements	is	below	a	certain	number.

The dialog box shown on the right will appear 
when initial registration was successful for all 
the elements.

The dialog box shown on the right will appear 
if initial registration was unsuccessful for any 
of the elements.
• The elements that have failed initial registration 

will be hidden in all windows.

5 Click the [OK] button.
The menu will be exited.
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Build – Registration – Fine – Elements
Performing Fine Registration of Elements

This command is used to perform registration of the selected elements.

 Operating Procedure 

1 From the element list, select the desired 
elements.

Memo

It is possible to select two or more elements by clicking 
them while holding down the [Shift] or [Ctrl] key.

2 From the [Build] menu, select [Registra-
tion], [Fine] and then click [Elements].
The [Build-Registration-Fine-Elements] dialog 
box will appear.
• The selected element will be ready to be dis-

played in all windows. It will be displayed if 
it is not displayed in the active window or the 
windows for which all the elements are set to be 
displayed.

3 Set the base element, and then click 
the [OK] button.
The program executes fine registration for the 
selected elements, and displays a dialog ask-
ing whether results are satisfactory.

4 Click the [OK] button.
The menu will be exited.

• To continue fine registration processing, click the 
[Repeat] button.

Memo

The [Error Average] and [Sigma] values are indicators of 
the correctness of the registration (the alignment).
In general, the closer to zero they are, the more accurate
alignment is.
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Build – Registration – Fine – Points
Performing Fine Registration of Selected Points

This command is used to perform fine registration of the points present in the selected elements.

 Operating Procedure 

1 From the element list, select the desired 
elements. Memo

• It is possible to select two or more elements by clicking 
them while holding down the [Shift] or [Ctrl] key.

• Among the selected elements, the element located first 
in the element list will be used as the basis element for 
registration.

2 From each selected element, select the 
points to be subjected to fine registra-
tion.

3 From the [Build] menu, select [Registra-
tion], [Fine] and then click [Points].
The [Build-Registration-Fine-Points] dialog box 
will appear.
• The selected element will be ready to be dis-

played in all windows. It will be displayed if 
it is not displayed in the active window or the 
windows for which all the elements are set to be 
displayed.

4 Set the base element, and then click the 
[OK] button.
The program executes fine registration for the 
selected points in the selected elements. It 
then displays a dialog asking whether results 
are satisfactory.

5 Click the [OK] button.
The menu will be exited.

• To continue fine registration processing, click the 
[Repeat] button.

Memo

The [Error Average] and [Sigma] values are indicators of 
the correctness of the registration (the alignment).
In general, the closer to zero they are, the more accurate 
alignment is.
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Build – Move – Points [P] (Effective while held down)
Moving the Selected Points

This command is used to move the selected point(s).
Note
Execution	of	this	command	may	not	display	simplified	data.

Left : Moves the point(s) using the mouse.
Middle ([Shift] + Left) : Moves the point(s) along the major axis.

Right : Moves the point(s) by entering values.

 Operating Procedure 

1 From the element list, select the desired 
elements.

2 Select the point(s) you want to move.

3 From the [Build] menu, select [Move] 
and then click [Points].
The selected element will be ready to be dis-
played in all windows. It will be displayed if it 
is not displayed in the active window or the 
windows for which all the elements are set to 
be displayed.
• If you select all of the element’s points at Step 2 

above, this command becomes equivalent to the 
Build – Move – Elements command.

Ref.  For information about the Build	–	Move	–	Elements	
command, see page 189.

4 Drag the points with the left mouse but-
ton.
The point(s) will move accordingly.
• Dragging with the middle (or [Shift] + Left) but-

ton will move the point(s) along the major axis.

5 Press the [ESC] key.
Build – Move – Points mode will be canceled.
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n Moving the Point(s) by Entering Values

 To move the point(s) by specifying how much they must be moved, follow the procedure given below.
Note
If	Build – Move – Points mode	was	activated	using	the	shortcut	key,	the	point(s)	cannot	be	moved	by	this	method.

 Operating Procedure    The following steps must be carried out in Build – Move – Points mode.

1 Click the right mouse button.
The [Build-Move-Points] dialog box will ap-
pear.

2 Enter the desired amount of movement 
for X, Y and Z.
The amount can be entered for all the axes at 
the same time.

3 Click the [Apply] button.
The selected point(s) will move according to 
the values entered.

• If you change a value(s) and click the [Apply] 
button, the point(s) will move again according to 
the new value(s).

  New values will not be added to the previous 
values. They are absolute values from the original 
position.

4 Click the [OK] button.
The [Build-Move-Points] dialog box will close, 
movement of the point(s) will be confirmed, 
and the Build-Move-Points mode will be 
canceled.

• Clicking the [Cancel] button will cancel all the 
operations that have been performed since the 
dialog box was opened.

Build – Move – Points
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Build – Move – Elements [M] (Effective while held down)
Moving Element(s)

This command is used to move the selected element(s).

Left : Moves the element(s) using the mouse.
Middle ([Shift] + Left) : Moves the element(s) along the major axis.

Right : Moves the element(s) by entering values.

 Operating Procedure 

1 From the element list, select the desired 
element(s).

2 From the [Build] menu, select [Move] 
and then click [Elements].
The selected element will be ready to be dis-
played in all windows. It will be displayed if it 
is not displayed in the active window or the 
windows for which all the elements are set to 
be displayed.

3  Drag with the left mouse button.
The element(s) will move accordingly.
• Dragging with the middle (or [Shift] + Left) but-

ton will move the element(s) along the major axis.

Memo

The element will be displayed in simple form during 
drag. It will be displayed in detailed form when dragging 
is canceled.

4 Press the [ESC] key.
Build – Move – Elements mode will be can-
celed.
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n Moving the Element(s) by Entering Values

 To move the element(s) by specifying how much they must be moved, follow the procedure given below.
Note
If	Build – Move – Elements	mode	was	activated	using	the	shortcut	key,	the	element(s)	cannot	be	moved	by	this	method.

 Operating Procedure    The following steps must be carried out in Build – Move – Elements mode.

1 Click the right mouse button.
The [Build-Move-Elements] dialog box will ap-
pear.

2 Enter the desired amount of movement 
for X, Y and Z.
The amount can be entered for all the axes at 
the same time.

3 Click the [Apply] button.
The selected element(s) will move according to 
the values entered.

• If you change a value(s) and click the [Apply] 
button, the element(s) will move again according 
to the new value(s).

  New values will not be added to the previous 
values. They are absolute values from the original 
position.

4 Click the [OK] button.
The [Build-Move-Points] dialog box will close, 
movement of the point(s) will be confirmed, 
and the Build-Move-Points mode will be 
canceled.

• Clicking the [Cancel] button will cancel all the 
operations that have been performed since the 
dialog box was opened.

Build – Move – Elements
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Build – Move – To Origin
Moving the Element(s) to the Origin

This command is used to move the selected element(s) to the origin.

 Operating Procedure 

1 From the element list, select the desired 
element(s).

2 From the [Build] menu, select [Move] 
and then click [To Origin].
The selected element(s) will move in such a 
way that the center of gravity of all the con-
stituent points is located at the origin.
• The selected element will be ready to be dis-

played in all windows. It will be displayed if 
it is not displayed in the active window or the 
windows for which all the elements are set to be 
displayed.
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Build – Move – To X-Y-Z
Converting the Coordinate System of Elements

This command is used to convert the coordinate system of the currently selected element(s) to the specified
coordinate system.

Note
When	you	execute	this	command,	all	screen	display	modes	change	to	Show	Vertex.

 Operating Procedure 

1 From the element list, select the desired 
element(s). Memo

It is possible to select two or more elements by clicking 
them while holding down the [Shift] or [Ctrl] key.

2 From the [Build] menu, select [Move] 
and then click [To X-Y-Z].
The [Build-Move-To X-Y-Z] dialog box will ap-
pear.
• The selected element(s) will be ready to be dis-

played in all windows. It will be displayed if 
it is not displayed in the active window or the 
windows for which all the elements are set to be 
displayed (i.e. the windows that are not set to “Se-
lective”).

3 At the pull-down menu, select the de-
sired method for setting the new coor-
dinate system. Then click the [OK] but-
ton.

4 Extract the desired face, lines and 
points.
• If you have selected [Point/Point/Point], extract 

three points in succession.
• If [Face/Point/Point] is selected, extraction will be 

performed in the order of face, point and point.
• If [Face/Point/Line] is selected, extraction will be 

performed in the order of face, point and line.
• If [Face/Line/Line] is selected, extraction will be 

performed in the order of face, line and line.

When all the elements are extracted, they will 
be displayed in the new coordinate system.
And [Confirmation (for Coordinate)] dialog box 
will appear.
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5 Save the coordinate system.

If you selected [Point/Point/Point]:
• Once you have extracted the three points, the 

program displays the input design values and the 
standard deviations of the extracted points.

  Click [Yes] to continue.
  Click [No] if you wish to re-enter the design 

values.

If you selected [Face/Point/Point], [Face/Point/
Line], [Face/Line/Line]:
• You can use the [Reverse] button to invert the 

normal vector of the face that you extracted in 
Step 4 above. If you select [Reverse], the program will 
invert the face, recalculate the coordinate system, and 
then redraw the display accordingly.

6 Click the right mouse button.
The [Question] dialog box will appear.

7 Click the [OK] button.
Coordinate conversion will be performed.

Parameters for [Build-Move-To X-Y-Z] Dialog Box

Point/Point/Point You set up a new coordinate system by extracting three points, one at a time, from among the 
selected points. The program generates the origin and axes of the new coordinate system based on 
the coordinate positions and design values of the three extracted points.

Face/Point/Point Extracts a face and two points from the selected points sequentially to set a new coordinate sys-
tem. Two axes and origin on the face are calculated based on the attribute of face and the coordi-
nate/design values of the extracted points to generate a new coordinate system.

Face/Point/Line Extracts a face, point, and line (in that order) from the selected points set. Calculates the origin 
or the new coordinate system based on the face attribute and the coordinate/design values of the 
extracted points; determines a single axis from the extracted line attribute; and generates the new 
coordinate system accordingly.

Face/Line/Line Extracts a face and two lines from the selected points sequentially to set a new coordinate system.
The origin and two axes are calculated based on the attribute of face and two lines to generate a 
new coordinate system.

Build – Move – To X-Y-Z
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n Extracting a Face

 Extract a face from the selected points as explained below.

 Operating Procedure    The following steps must be carried out in Build – Move – To X-Y-Z mode.

Parameters for [Select Face Attribute] Dialog Box

XY-Plane Generates a XY plane based on the selected points.

YZ-Plane Generates a YZ plane based on the selected points.

ZX-Plane Generates a ZX plane based on the selected points.

1 Select the desired points.
Memo

• Select the points using the Select and View menu com-
mands.

• After operation, please cancel the Select or View menu 
command.

2 Click the right mouse button.
The [Select Face Attribute] dialog box will ap-
pear.

3 Select the desired face attribute from 
the pull-down menu.
When the selected attribute of the face is “XY-
Plane”, Z-Axis is made in agreement with the 
face normal.
But the direction of the axis is calculated by 
the algorithm. If the direction is not suitable, 
click the [Reverse] button in [Confirmation(for 
coordinate)] dialog box to reverse the axis 
direction.

4 Click the [OK] button.
The generated face will be displayed, and the 
[Confirmation] dialog box will appear.

5 Click the [OK] button.
Proceed to the extraction procedure for the 
next element (point or line).

Build – Move – To X-Y-Z
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n Extracting a Point

 Extract a point from the selected points as explained below.

 Operating Procedure    The following steps must be carried out in Build – Move – To X-Y-Z mode.

1 Select the desired points.
Memo

• Select the points using the Select and View menu com-
mands.

• After operation, please cancel the Select or View menu 
command.

2 Click the right mouse button.
The [Select Point Type] dialog box will appear.

3 Select the desired point type from the 
pull-down menu.

4 Click the [OK] button.
The [Input XYZ Value] dialog box will appear.

5 Enter the design values for the point.

Memo

For certain types of extraction, you will only be able to 
enter values for two of three axes. For instance, if XY-
Plane is selected, the text box for Z value will be inactive 
since it is not necessary to enter the Z-coordinate value.

6 Click the [OK] button.
The generated point will be displayed, and the 
[Confirmation] dialog box will appear.

Build – Move – To X-Y-Z
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7 Click the [OK] button.
Proceed to the extraction procedure for the 
next element (point or line).
• When you have completed extraction of all ele-

ments: Right-click the mouse to open the
  Question dialog, and proceed to convert to the 

new coordinate system.

Parameters for [Select Point Type] Dialog Box

Gravity Point Generates the gravity point based on the selected points.

Center of Circle Generates the center of circle based on the selected points.

Center of Sphere Generates the center of sphere based on the selected points.

Build – Move – To X-Y-Z
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n Extracting a Line

 Extract a line from the selected points as explained below.

 Operating Procedure    The following steps must be carried out in Build – Move – To X-Y-Z mode.

Parameters for [Select Line Attribute] Dialog Box

X-Axis Generates the X-axis based on the selected points.

Y-Axis Generates the Y-axis based on the selected points.

Z-Axis Generates the Z-axis based on the selected points.

1 Select the desired points.
Memo

• Select the points using the Select and View menu  com-
mands.

• After operation, please cancel the Select or View menu 
command.

4 Click the [OK] button.
The line direction will be displayed, and the 
[Question] dialog box will appear.

5 If you want to change the direction, 
click the [No] button.
The line direction will be changed, and the 
[Question] dialog box will reappear.

6 Click the [Yes] button.
The generated line will be displayed, and the 
[Confirmation] dialog box will appear.

7 Click the [OK] button.
Proceed to the extraction procedure for the 
next element (point or line).
• When you have completed extraction of all ele-

ments: Right-click the mouse to open the Ques-
tion dialog, and proceed to convert to the new 
coordinate system.

2 Click the right mouse button.
The [Select Line Attribute] dialog box will ap-
pear.

3 Select the desired line attribute from 
the pull-down menu.

Build – Move – To X-Y-Z
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Build – Rotate – Elements [R] (Effective while held down)
Rotating Element(s)

This command is used to rotate the selected element(s).

Left : Rotates the element(s) using the mouse.
Middle ([Shift] + Left) : Rotates the element(s) along the major axis.

Right : Rotates the element(s) by entering values.

 Operating Procedure 

1 From the element list, select the desired 
element(s).

2 From the [Build] menu, select [Rotate] 
and then click [Elements].
The selected element will be ready to be dis-
played in all windows. It will be displayed if it 
is not displayed in the active window or the 
windows for which all the elements are set to 
be displayed.

3 Drag while holding down the left button.
The element(s) will rotate at their center of 
gravity.
• Dragging with the middle (or [Shift] + Left) 

button will rotate the element(s) along the major 
axis.

Memo

The element will be displayed in simple form during drag. 
It will be displayed in detailed form when dragging is
canceled.

4 Press the [ESC] key.
Build – Rotate – Elements mode will be can-
celed.
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n Rotating the Element(s) by Entering a Value Directly
 To rotate the element(s) by specifying the rotating angle, follow the procedure given below.

Note
If Build – Rotate – Elements	mode	was	activated	using	the	shortcut	key,	the	element(s)	cannot	be	moved	by	this	method.

 Operating Procedure    　The following steps must be carried out in Build – Rotate – Elements mode.

1 Click the right mouse button.
The [Build-Rotate-Elements] dialog box will 
appear.

2 Select X, Y or Z to be used as the pivot, 
and enter the desired rotating angle.

3 Click the [Apply] button.
The selected element(s) will rotate by the 
specified angle.

• If you change the angle and click the [Apply] 
button, the element(s) will rotate again according 
to the new angle. The new angle will not be added 
to the previous angle. It is an absolute angle from 
the original position.

4 Click the [OK] button.
The [Build-Move-Points] dialog box will close, 
movement of the point(s) will be confirmed, 
and the Build-Move-Points mode will be 
canceled.

• Clicking the [Cancel] button will cancel all the 
operations that have been performed since the 
dialog box was opened.

Build – Rotate – Elements

Download from Www.Somanuals.com. All Manuals Search And Download.



200

Chapter 2

Build
Menu

9i
910
900
700
300

Build – Merge
Merging Elements

This command is used to merge elements that have been subjected to registration.

 Operating Procedure 

1 From the element list, select the elements 
to be merged.

2 Click [Merge] on the [Build] menu.
The [Build-Merge] dialog box will appear.
• The selected element will be ready to be dis-

played in all windows. It will be displayed if 
it is not displayed in the active window or the 
windows for which all the elements are set to be 
displayed.

3 Set the merge smoothness using the 
scale bar.

• To merge only the points selected in the elements, 
check the [With selected points] checkbox.

4 Click the [OK] button.
A dialog box asking you to enter a new ele-
ment name will appear.

5 Enter the new element name, and click 
the [OK] button.
The program merges the elements to create 
a new element. The new element is given the 
name that you just entered.
• The elements in effect before merging started will 

be hidden.
• The registrated data will be ready to be displayed 

in all windows, and will be displayed in the active 
window as well as the windows for which all the 
elements are set to be displayed.

Note
The	element	name	must	consist	of	up	to	31	alphanu-
meric	characters.
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Build – Fill Holes – Manual
Filling Holes Manually

This command is to create polygon data using the mouse for the holes (i.e. areas where no data is present) 
located in the area selected in the currently displayed element.

Left : Designates a point.
Middle ([Shift] + Left) : –

Right : Cancels designation.

 Operating Procedure 

1 From the element list, select one desired 
element.

2 Select the points on the boundary of 
the hole for which you want to create 
polygon data.

3 From the [Build] menu, select [Fill 
Holes] and then click [Manual].
The system will search for holes present within 
the area of the selected points. A bar will be 
displayed during search to indicate progress. If 
a hole is found, only the points on its boundary 
will be selected.
• If no holes are found, a message dialog box will 

appear. Clicking the [OK] button will close the 
dialog box and exit the menu.

4 Among the selected points, click the 
three nodes of a triangular polygon 
with the left mouse button, one by one 
in a counter-clockwise direction (when 
viewed from the front of the polygon).
When the node is clicked, a white rubber band 
will appear between that node and the mouse 
pointer.
When all the three nodes are clicked, a poly-
gon composed of those three nodes will be 
formed.
• Selection of the points which are no longer on the 

boundary of the hole due to the created polygon 
will be canceled.

• To cancel designation of the points or created 
polygon, click the right mouse button. By clicking 
the right button repeatedly, it is possible to return 
to the state in effect before this command was 
selected.

Note
•	 It	is	not	possible	to	designate	nodes	if	they	have	not	
been	selected.

•	 It	is	not	possible	to	designate	nodes	of	a	triangle	fac-
ing	opposite	the	adjacent	polygons.

•	 While	a	rubber	band	is	displayed,	it	is	not	possible	to	
switch	the	view	and	designate	a	point	or	change	the	
window	size.

5 When the hole is filled, click the [ESC] 
key.
Selection state of points will remain and Build 
– Fill Holes – Manual mode will be canceled.
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Build – Fill Holes – Auto
Filling Holes Automatically

This command is to create polygon data automatically for the holes (i.e. areas where no data is present) locat-
ed in the area selected in the currently displayed element. However, some complicated holes may not be filled.

 Operating Procedure 

1 From the element list, select one desired 
element.

2 Select the points on the boundary of 
the hole for which you want to create 
polygon data.

3 From the [Build] menu, select [Fill 
Holes] and then click [Auto].
The system will search for holes present within 
the area of the selected points. A bar will be 
displayed during search to indicate progress. If 
a hole is found, only the points on its boundary 
will be selected.
• If no holes are found, a message dialog box will 

appear. Clicking the [OK] button will close the 
dialog box and exit the menu.

All the element view windows will be hidden, 
and the temporary window and [Build-Fill 
Holes-Auto] dialog box will appear.
• The hole for which you want to create polygon 

data will be displayed in the temporary window. 
The points comprising the hole will be highlight-
ed (yellow). The selected holes will be processed 
one by one, starting with the hole composed of 
the largest number of points.

Memo

If the number of remaining holes (Number of holes) is 
1, the [OK] button will be displayed instead of the [Next 
Hole] button.

Note

It	is	not	possible	to	close	the	temporary	window.

4 Set the [Flatness] and [Algorithm] pa-
rameters, and click the [Apply] button.
The program merges the elements to create 
a new element. The new element is given the 
name that you just entered.

A progress bar shows the progress while 
the fill is being carried out. If you click the 
progress bar’s [Cancel] button, the program 
suspends fill processing and displays a dialog 
showing results up to that moment.

Memo

The program retains the fill data generated up to the time 
when you clicked the [Cancel] button. If you wish to 
resume the fill operation, click the [All] button. Filling 
will then continue from the hole at which the operation 
was suspended.
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• If you mchange the “Flatness” and “Algorithm” 
parameter settings and click the [Apply] but-
ton, the holes will be filled according to the new 
parameter settings.

• To restore the initial state (i.e. holes are not 
filled), click the [Hole Reset] button.

• To fill all the holes, click the [All] button.
• All the holes which have not been filled will be 

filled according to the parameter settings.
• After filling the holes, the program closes the dia-

log and the temporary window, and then displays 
a dialog indicating the results.

5 Click the [Next Hole] button.
The dialog box will close and a new dialog box 
will appear.
The hole to be filled next will be displayed in 
the window.

6 Repeat step 4 until all the desired holes 
are filled.
• If you click the [Next Hole] button without click-

ing the [Apply] button, nothing will happen, and 
the dialog box will close and a new dialog box 
will appear.

• If you click the [Close] button, the program will 
close the dialog box, windows, and menu. All 
hole fills that you have executed will be retained.

7 Click the [OK] button.
The dialog box and window will close, and the 
menu will be exited.
All the element view windows will be dis-
played. 

Parameters for [Build-Fill Holes-Auto] Dialog Box

Number of nodes Number of points comprising the hole to be filled

Number of holes Number of remaining holes to be filled

Flatness A parameter provided for hole filling. Used to decide whether the hole is to be filled with flat 
surfaces or with curved surfaces. (100: Flat, 0: Curved, Default: 50)

Algorithm

by curvature Used to fill holes by creating meshes inside the holes.

by connecting nodes Used to fill holes by creating meshes and then replacing polygons on the boundary with the cre-
ated meshes.

by curvature and
replace facets

Used to fill holes by connecting the vertices of the holes.

Build – Fill Holes – Auto
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Build – Smooth – Element
Smoothing the Selected Element

This command is used to make the selected element smooth as well as to regularize surface points density.

 Operating Procedure 

1 From the element list, select  one desired 
element.

2 From the [Build] menu, select [Smooth] 
and then click [Element].
The [Build-Smooth-Element] dialog box will 
appear.
• The selected element will be ready to be dis-

played in all windows. It will be displayed if 
it is not displayed in the active window or the 
windows for which all the elements are set to be 
displayed.

3 Set the parameters.

4 Click the [Apply] button.
The selected element will be smoothed ac-
cording to the parameter settings and then 
displayed.

Parameters for [Build-Smooth-Element] Dialog Box

Weight Used to set level of regularization of surface points density.

Repetition Used to set level of smoothness.

• If you change the parameter settings and click 
the [Apply] button again, the element will be 
smoothed according to the new parameter set-
tings.

5 Click the [OK] button.
This will confirm execution of smoothing and 
close the dialog box.
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Build – Smooth – Points
Smoothing the Selected Points

This command is used to make the boundary of the points selected in the currently displayed element smooth
as well as to regularize surface points density.

 Operating Procedure 

1 From the element list, select one desired 
element.

2 Select the desired points.

3 From the [Build] menu, select [Smooth] 
and then click [Points].
The [Build-Smooth-Points] dialog box will ap-
pear.
• The selected element will be ready to be dis-

played in all windows. It will be displayed if 
it is not displayed in the active window or the 
windows for which all the elements are set to be 
displayed.

4 Set the parameters.

5 Click the [Apply] button.
The boundary of the selected points will be 
smoothed according to the parameter settings 
and then displayed.

Parameters for [Build-Smooth-Points] Dialog Box

Weight Used to set level of regularization of surface points density.

Repetition Used to set level of smoothness.

• If you change the parameter settings and click 
the [Apply] button again, the element will be 
smoothed according to the new parameter set-
tings.

6 Click the [OK] button.
This will confirm execution of smoothing and 
close the dialog box.
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Build – Subsample – Uniformly – Element
Reducing the Number of Points of the Selected Element Uniformly

This command is used to reduce the data of the points of the selected element so that surface points density 
becomes uniform.

 Operating Procedure 

1 From the element list, select one desired 
element.

2 From the [Build] menu, select [Subsam-
ple] –[Uniformly] and then click [Element].
The [Build-Subsample-Uniformly-Element] 
dialog box will appear.
• The selected element will be ready to be dis-

played in all windows. It will be displayed if 
it is not displayed in the active window or the 
windows for which all the elements are set to be 
displayed.

3 Set the parameters.

4 Click the [Apply] button.
The data of the points comprising the selected 
element will be reduced according to the 
parameter settings so that the surface points 
density becomes uniform.

Parameters for [Build-Subsample-Uniformly-Element] Dialog Box

Number of points Reduces the current number of points to the specified number. When the [Apply] button is clicked, 
the current number of vertices will be displayed. (The default for the “Number of points” param-
eter is set so that the number of selected points will be reduced by 50%.).

Fix boundary Among the points comprising the selected element, the points present on the boundary of the hole 
will be excluded from data reduction.

• If you change the parameter settings and click 
the [Apply] button again, the data comprising 
the element will be reduced according to the new 
parameter settings.

Memo

In some cases, the number of vertices present after data 
reduction may not match the specified number.

5 Click the [OK] button.
This will confirm execution of data reduction 
and close the dialog box.
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Build – Subsample – Uniformly – Points
Reducing the Selected Points Uniformly

This command is used to reduce the points selected in the currently displayed element so that surface points
density becomes uniform.

Parameters for [Build-Subsample-Uniformly-Points] Dialog Box

Number of points Reduces the current number of points to the specified number. When the [Apply] button is clicked, 
the current number of vertices will be displayed. (The default for the “Number of points” param-
eter is set so that the number of selected points will be reduced by 50%.)

Fix boundary Among the selected points, the points present on the boundary of the hole will be excluded from 
data reduction.

Memo

Processing may take time if the element is composed of many points.

 Operating Procedure 

1 From the element list, select one desired 
element.

2 Select the desired points.

3 From the [Build] menu, select [Subsam-
ple] –[Uniformly] and then click [Points].
The [Build-Subsample-Uniformly-Points] dia-
log box will appear.
• The selected element will be ready to be displayed 

in all windows. It will be displayed if it is not 
displayed in the active window or the windows for 
which all the elements are set to be displayed.

4 Set the parameters.

5 Click the [Apply] button.
The data of the selected points will be reduced 
according to the parameter settings so that 
the surface points density becomes uniform.

• If you change the parameter settings and click 
the [Apply] button again, the data comprising 
the points will be reduced according to the new 
parameter settings.

Memo

In some cases, the number of vertices present after 
data reduction may not match the specified number.

6 Click the [OK] button.
This will confirm execution of data reduction 
and close the dialog box.
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Build – Subsample – Adaptively – Element
Reducing the Number of Points of the Selected Element Adaptively

This command is used to reduce the data of the points of the selected element so that surface points density in
simple-shaped areas is lower than that in complicated-shaped areas.

Memo

The elements selected before execution of this command will be divided to triangular polygons.

Parameters for [Build-Subsample-Adaptively-Element] Dialog Box

Number of points Reduces the current number of points to the specified number. When the [Apply] button is clicked, 
the current number of vertices will be displayed. (The default for the “Number of points” param-
eter is set so that the number of selected points will be reduced by 50%.)

Range of errors The program reduces data in accordance with the value that you enter. The value serves as a gen-
eral yardstick for the amount of reduction-induced change in model tolerance.

Memo

The default setting is “0.2”.

Fix boundary Among the points comprising the selected element, the points present on the boundary of the hole 
will be excluded from data reduction.

 Operating Procedure 

1 From the element list, select one desired 
element.

2 From the [Build] menu, select [Subsam-
ple] –[Adaptively] then click [Element].
The [Build-Subsample-Adaptively-Element] 
dialog box will appear.
• The selected element will be ready to be displayed 

in all windows. It will be displayed if it is not 
displayed in the active window or the windows for 
which all the elements are set to be displayed.

3 Set the parameters.

4 Click the [Apply] button.
The data of the points comprising the selected 
element will be reduced according to the pa-
rameter settings so that surface points density 
in simple-shaped areas is lower than that in 
complicated-shaped areas.
• The polygons comprising the selected element 

will be triangulated.

• If you change the parameter settings and click 
the [Apply] button again, the data comprising 
the element will be reduced according to the new 
parameter settings.

Memo

In some cases, the number of vertices present after data 
reduction may not match the specified number.

5 Click the [OK] button.
This will confirm execution of data reduction 
and close the dialog box.
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Build – Subsample – Adaptively – Points
Reducing the Selected Points Adaptively

This command is used to reduce the points selected in the currently displayed element so that surface points 
density in simple-shaped areas is lower than that in complicated-shaped areas.

Memo

The elements selected before execution of this command will be divided to triangular polygons.

Parameters for [Build-Subsample-Adaptively-Points] Dialog Box

Number of points Reduces the current number of points to the specified number. When the [Apply] button is clicked, 
the current number of vertices will be displayed. (The default for the “Number of points” param-
eter is set so that the number of selected points will be reduced by 50%.)

Range of errors The program reduces data in accordance with the value that you enter. The value serves as a gen-
eral yardstick for the amount of reduction-induced change in model tolerance.

Memo

The default setting is “0.2”.

Fix boundary Among the selected points, the points present on the boundary of the hole will be excluded from 
data reduction.

 Operating Procedure 

1 From the element list, select one desired 
element.

2 Select the desired points.

3 From the [Build] menu, select [Subsam-
ple] –[Adaptively] then click [Points].
The [Build-Subsample-Adaptively-Points] dia-
log box will appear.
• The selected element will be ready to be displayed 

in all windows. It will be displayed if it is not dis-
played in the active window or the windows for 
which all the elements are set to be displayed.

4 Set the parameters.

5 Click the [Apply] button.
The data of the selected points will be reduced 
according to the parameter settings so that 
surface points density in simple-shaped areas 
is lower than that in complicated-shaped areas.
• The polygons comprising the selected element 

will be triangulated.

• If you change the parameter settings and click 
the [Apply] button again, the data comprising 
the points will be reduced according to the new 
parameter settings.

Memo

In some cases, the number of vertices present after data 
reduction may not match the specified number.

6 Click the [OK] button.
This will confirm execution of data reduction 
and close the dialog box.
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Build – Modify – Element
Rebuilding the Selected Element by Deleting Small Polygons

This command is used to rebuild the selected element by deleting small polygons.
Memo

The element selected before execution of this command will be divided to triangular polygons.

Parameters for [Build-Modify-Element] Dialog Box

Minimum edge length Used to set the minimum edge length of polygons to be deleted.

Minimum face area Used to set the minimum face area of polygons to be deleted

Fix boundary Among the points comprising the selected element, the points present on the boundary of the hole 
will be excluded from data reduction.

 Operating Procedure 

1 From the element list, select  the desired 
element.

2 From the [Build] menu, select [Modify] 
and then click [Element].
The [Build-Modify-Element] dialog box will 
appear.
• The selected element will be ready to be displayed in 

all windows. It will be displayed if it is not displayed 
in the active window or the windows for which all 
the elements are set to be displayed.

3 Set the parameters.

4 Click the [Apply] button.
Polygons smaller than the specified size will 
be deleted from the selected element.
• The polygons comprising the selected element 

will be triangulated.

• If you change the parameter settings and click 
the [Apply] button again, the data comprising 
the element will be reduced according to the new 
parameter settings.

5 Click the [OK] button.
This will confirm execution of data reduction and close 
the dialog box.
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Build – Modify – Points
Rebuilding the Selected Points by Deleting Small Polygons

This command is used to rebuild the points selected in the currently displayed element by deleting small poly-
gons.

Memo

The elements selected before execution of this command will be divided to triangular polygons.

Parameters for [Build-Modify-Points] Dialog Box

Minimum edge length Used to set the minimum edge length of polygons to be deleted.

Minimum face area Used to set the minimum face area of polygons to be deleted

Fix boundary Among the points comprising the selected element, the points present on the boundary of the hole 
will be excluded from data reduction.

 Operating Procedure 

1 From the element list, select  one desired 
element.

2 Select the desired points.

3 From the [Build] menu, select [Modify] 
and then click [Points].
The [Build-Modify-Points] dialog box will appear.
• The selected element will be ready to be dis-

played in all windows. It will be displayed if 
it is not displayed in the active window or the 
windows for which all the elements are set to be 
displayed.

4 Set the parameters.

5 Click the [Apply] button.
Polygons smaller than the specified size will 
be deleted from the selected points.
• The polygons comprising the selected element 

will be triangulated.

• If you change the parameter settings and click 
the [Apply] button again, the data comprising 
the points will be reduced according to the new 
parameter settings.

6 Click the [OK] button.
This will confirm execution of data reduction 
and close the dialog box.
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Build – Subdivision – Element
Rebuilding the Selected Element by Dividing Large Polygons

This command is used to rebuild the selected element by dividing large polygons.
Memo

The element selected before execution of this command will be divided to triangular polygons.

Parameters for [Build-Subdivision-Element] Dialog Box

Maximum edge length Used to set the maximum edge length of element to be rebuilt.

Maximum face area Used to set the maximum face area of element to be rebuilt.

 Operating Procedure 

1 From the element list, select the desired 
element.

2 From the [Build] menu, select [Subdivi-
sion] then click [Element].
The [Build-Subdivision-Element] dialog box 
will appear.
• The selected element will be ready to be displayed 

in all windows. It will be displayed if it is not 
displayed in the active window or the windows for 
which all the elements are set to be displayed.

3 Set the parameters.

4 Click the [Apply] button.
The data of the points comprising the selected 
element will be rebuilt according to the param-
eter settings.
• The polygons comprising the selected element 

will be triangulated.

• If you change the parameter settings and click the 
[Apply] button again, the data for the selected ele-
ment will be rebuilt according to the new param-
eter settings.

5 Click the [OK] button.
This will confirm execution of data rebuilding 
and close the dialog box.
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Build – Subdivision – Points
Rebuilding the Selected Points by Dividing Large Polygons

This command is used to rebuild the points selected in the currently displayed element by dividing large poly-
gons.

Memo

The elements selected before execution of this command will be divided to triangular polygons.

Parameters for [Build-Subdivision-Points] Dialog Box

Maximum edge length Used to set the maximum edge length of polygons to be divided.

Maximum face area Used to set the maximum face area of polygons to be divided.

 Operating Procedure 

1 From the element list, select one desired 
element.

2 Select the desired points.

3 From the [Build] menu, select [Subdivi-
sion] then click [Points].
The [Build-Subdivision-Points] dialog box will 
appear.
• The selected element will be ready to be displayed 

in all windows. It will be displayed if it is not 
displayed in the active window or the windows for 
which all the elements are set to be displayed.

4 Set the parameters.

5 Click the [Apply] button.
The data for the selected points will be rebuilt 
according to the parameter settings.
• The polygons comprising the selected element 

will be triangulated.

• If you change the parameter settings and click the 
[Apply] button again, the data for the points will 
be rebuilt according to the new parameter set-
tings.

6 Click the [OK] button.
This will confirm execution of data rebuilding 
and close the dialog box.

Download from Www.Somanuals.com. All Manuals Search And Download.



214

Chapter 2

Build
Menu

9i
910
900
700
300

Build – Triangulate – Elements
Dividing Polygons in Elements into Triangles

This command is used to divide polygons of the selected element(s) into triangles.

Build – Triangulate – Polygons
Dividing Selected Polygons into Triangles

This command is used to divide the polygon(s) composed of the points selected in the currently displayed ele-
ment into triangles.

 Operating Procedure 

1 From the element list, select the desired 
element(s).

2 From the [Build] menu, select [Triangu-
late] then click [Elements].
The polygons comprising the selected 
element(s) will be divided into triangles.
• The selected element will be ready to be dis-

played in all windows. It will be displayed if 
it is not displayed in the active window or the 
windows for which all the elements are set to be 
displayed.

 Operating Procedure 

1 From the element list, select the desired 
element(s).

2 Select the polygons you want to divide 
into triangles.
A polygon can be selected by selecting all the 
vertices of which it is comprised.
Memo

It is possible to select polygons in more than one element.

3 From the [Build] menu, select [Triangu-
late] and then click [Polygons].
Polygons comprised of the selected points will 
be divided into triangles.
• The selected element will be ready to be dis-

played in all windows. It will be displayed if 
it is not displayed in the active window or the 
windows for which all the elements are set to be 
displayed.
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Build – Texture Blending
Blending Textures

This command is used to make the edges of color image of registrated element smooth.

Parameters for [Build-Texture Blending] Dialog Box

Blending Area Sets the area over which blending occurs, with the area increasing as you raise the value.
If you set this value too high, colors will bleed together excessively and the result will be unsatis-
factory. If you set this value to 0, there will be no blending at all.

 Operating Procedure 

1 From the element list, select one desired 
element.

2 Click [Texture Blending] on the [Build] 
menu.
All the element view windows will be hidden, 
and the temporary window and [Build-Texture 
Blending] dialog box will appear.
• The temporary window is displayed in texture 

mapping mode, and the selected element will be 
fully framed in that window.

• The selected element will be ready to be displayed 
in all windows. It will be displayed if it is not 
displayed in the active window or the windows for 
which all the elements are set to be displayed.

Note

•	 An	error	message	will	appear	if	an	element	that	has	
no	images	is	selected.

•	 It	is	not	possible	to	close	the	temporary	window.

3 Set the parameters.

4 Click the [Apply] button.
Junctures of textures will be smoothed ac-
cording to the parameter settings.

• If you change the parameter settings and click the 
[Apply] button again, the junctures of textures 
will be smoothed according to the new parameter 
settings.

5 Click the [OK] button.
This will confirm execution of texture blending 
and close the dialog box.
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Build – Check Polygons – Element
Checking for Illegal Polygons in Element

This command is used to check for illegal polygons among those comprising the selected element.

 Operating Procedure 

1 From the element list, select one desired 
element.

2 From the [Build] menu, select [Check 
Polygons] then click [Element].
The [Build-Check Polygons-Element] dialog 
box will appear.
• The selected element will be ready to be dis-

played in all windows. It will be displayed if 
it is not displayed in the active window or the 
windows for which all the elements are set to be 
displayed.

Note
An	error	message	will	appear	if	more	than	one	element	
is	selected.

3 Check the checkboxes of the param-
eter items to be checked.

4 Click the [OK] button.
Illegal polygons will be detected and the fol-
lowing dialog box will appear.

5 Click the [OK] button.
Only the vertices comprising the illegal poly-
gons will remain selected, the dialog box will 
close and the menu will be exited.
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Parameters for [Build-Check Polygons-Element] Dialog Box

Intersection Checks for polygons intersecting with another polygon at points other than at shared vertices and 
edges.
ex.) Polygons intersecting with each other

Degeneration Checks for polygons whose edges intersect with each other at points other than at shared vertices.
ex.) Triangular polygon whose three vertices are positioned on a straight line

Orientation Checks for polygons that share an edge and face opposite each other.
ex.) Polygons sharing one edge and facing opposite each other

Connection Checks for polygons that share more than three vertices or two non-edge vertices.
ex.) Quadrangular polygons sharing three vertices

ex.) Triangular polygon having as an edge the diagonal edge of a quadrangular polygon

Singularity Checks for polygons connected to a vertex of conical polygons.
*All the polygons connected to a vertex will be detected.
ex.) Triangular polygon sharing its vertex with a
       conical polygon

Vertex 1 Vertex 2 Vertex 3

Front

Front

Front

FrontBack

Quadrangular polygon A

Quadrangular polygon B

Build – Check Polygons – Element
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Build – Check Polygons – Polygons
Checking for Illegal Polygons Composed of Selected Points

This command is used to check illegal polygons composed of the selected points in the selected element.

 Operating Procedure 

1 From the element list, select  one desired 
element.

2 Select the points that contain polygons 
to be checked
Only the polygons for which all vertices are 
selected will be checked.

3 From the [Build] menu, select [Check 
Polygons] and then click [Polygons].
The [Build-Check Polygons-Polygons] dialog 
box will appear.
• The selected element will be ready to be dis-

played in all windows. It will be displayed if 
it is not displayed in the active window or the 
windows for which all the elements are set to be 
displayed.

Note
An	error	message	will	appear	if	more	than	one	element	
is	selected.

4 Check the checkboxes of the param-
eter items to be checked.

5 Click the [OK] button.
Illegal polygons will be detected and the fol-
lowing dialog box will appear.

6 Click the [OK] button.
Only the vertices comprising the illegal poly-
gons will remain selected, the dialog box will 
close and the menu will be exited.
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Parameters for [Build-Check Polygons-Polygons] Dialog Box

Intersection Checks for polygons intersecting with another polygon at points other than at shared vertices and 
edges.
ex.) Polygons intersecting with each other

Degeneration Checks for polygons whose edges intersect with each other at points other than at shared vertices.
ex.) Triangular polygon whose three vertices are positioned on a straight line

Orientation Checks for polygons that share an edge and face opposite each other.
ex.) Polygons sharing one edge and facing opposite each other

Connection Checks for polygons that share more than three vertices or two non-edge vertices.
ex.) Quadrangular polygons sharing three vertices

ex.) Triangular polygon having as an edge the diagonal edge of a quadrangular polygon

Singularity Checks for polygons connected to a vertex of conical polygons.
*All the polygons connected to a vertex will be detected.
ex.) Triangular polygon sharing its vertex with a 
       conical polygon

Vertex 1 Vertex 2 Vertex 3

Front

Front

Front

FrontBack

Quadrangular polygon A

Quadrangular polygon B

Build – Check Polygons – Polygons
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Info – Elements
Displaying Information for the Element(s)

This command is used to display information related to the selected element.

Parameters for [Info-Elements] Dialog Box

Element name Name of the element

Points Number of points comprising the element

Polygons Number of polygons comprising the element

Surface Element’s surface area

Volume Element’s volume

Date Acquisition date (“N/A” will be displayed in the case of merged element data)

Time Acquisition time (“N/A” will be displayed in the case of merged element data)

Image Image No. (for the image whose information is displayed)/Total number of images

Size Size of the image

View point Coordinates of the view point

Direction Vector of the line of view

Up Vector Upward vector

Focal length Focal distance

Previous Displays information for the previous image.

Next Displays information for the next image.

 Operating Procedure 

1 From the element list, select one desired 
element.

2 Click [Element] on the [Info] menu.
The [Info-Element] dialog box will appear.

3 If you want to change the element 
name, enter a new name.

4 Click the [OK] button.
The dialog box will close.

Memo

The program calculates the surface area by calculating the 
triangles comprising the element, and then summing the 
surface areas of these triangles.
The program calculates the volume by estimating the 
volume enclosed by the polygons comprising the element.
Results may not be precise if elements have many broken 
parts.
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Info – Points
Displaying Information for Points

This command is used to display information related to the points comprising the polygon selected in the 
selected element.

Parameters for [Info-Points] Dialog Box

No. Serial No. of each point

X, Y, Z X, Y and Z coordinates

Element name Name of the element to which the point(s) belong

 Operating Procedure 

1 From the element list, select one desired 
element.

2 Select the desired point(s).

3 Click [Points] on the [Info] menu.
The [Info-Points] dialog box will appear.
• The selected element will be ready to be dis-

played in all windows. It will be displayed if 
it is not displayed in the active window or the 
windows for which all the elements are set to be 
displayed.

Note
Information	for	up	to	20,000	points	can	be	viewed.	If	the
number	of	selected	points	exceeds	20,000,	the	informa-
tion	for	those	extra	points	will	be	omitted.

4 If you wish to output the displayed in-
formation, click the [Export] button.
The program outputs the point coordinate 
data, in ASCII format.

5 Click the [OK] button.
The dialog box will close.
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Info – Picked Point
Displaying Information for the Picked Point

This command is used to display information related to a point selected by clicking it.

Left : Selects one point.
Middle ([Shift] + Left) : –
Right : –

Parameters for [Info-Picked Point] Dialog Box

No. Serial No. of each point

X Y Z X, Y and Z coordinates

Element Name of the element to which the point(s) belong

 Operating Procedure 

1 From the element list, select the de-
sired element.

2 Click [Picked Point] on the [Info] menu.
The selected element will be ready to be dis-
played in all windows. It will be displayed if it 
is not displayed in the active window or the 
windows for which all the elements are set to 
be displayed.

3 Click the point whose information you 
want to display.
The information of the left-clicked point will be 
displayed.

4 Press the [ESC] key.
Info – Picked Point mode will be canceled.
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Window Menu

New – Front/Right/Left/Back/Top/Bottom/Isometric/Perspective …………………… 226
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Window – New – Front/Right/Left/Back/Top/Bottom/Isometric/Perspective
Changing Direction of View of Element View Window

This command is used to open a new window by selecting the orientation of the image displayed in the win-
dow from [Front], [Right], [Left], [Back], [Top], [Bottom], [Isometric] and [Perspective].

Window – Clone
Cloning an Element View Window

This command is used to clone (duplicate) the active element view window.

 Operating Procedure 

1 From the [Window] menu, select [New] 
and then click [Front], [Right], [Left], 
[Back], [Top], [Bottom], [Isometric] or  
[Perspective].
A new window will open in the selected view 
orientation.
The data will be fully framed in the new window.

 Operating Procedure 

1 Click [Clone] on the [Window] menu.
The active window will be cloned.

Memo

• It is possible to open two or more windows having the 
same orientation.

• If [Perspective] or [Isometric] is selected, the image 
can be rotated in different directions using a View com-
mand.
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Window – Close
Closing Active Element View Window

This command is used to close the active element view window.

Window – Cascade
Cascading Element View Windows

This command is used to cascade all the currently displayed windows.

 Operating Procedure 

1 Click [Cascade] on the [Window] menu.
The currently displayed windows will be cas-
caded from the top left to bottom right in the 
element view window area.

 Operating Procedure 

1 Click [Close] on the [Window] menu.
The active window will close. • If only one element view window is present and 

modifications have been made to an element after 
it has been imported or saved, the “Some ele-
ments are modified. Do you want to save them?” 
message dialog box will appear.
q Click the [YES] button.
 If an element file has been imported, its data 

will be overwritten.
 If the selected elements are not those explained 

above (i.e. if they are newly created elements 
or those that have been imported in another file 
format), the [File-Save as-Elements] dialog box 
will appear, displaying the names of the non-
saved elements at the top of the element list. (If 
you want to change the file names, change them) 
Click the [Save] button to save them one by one.

 When all the elements are saved, the dialog box 
and the selected windows will close.
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Window – Tiling
Tiling Element View Windows

This command is used to tile all the currently displayed windows.

Window – Layout – 1/4
Displaying an Element View Windows in 1/4 Layout

This command is used display windows in 1/4 layout.

Window – Layout – 1/1
Displaying an Element View Window in 1/1 Layout

This command is used to fully display a window in the element view window area.

 Operating Procedure 

1 Click [Tiling] on the [Window] menu.
The currently displayed windows will be fully 
tiled in the element view window area.

 Operating Procedure 

1 From the [Window] menu, select [Lay-
out] and then click [1/4].
Four views will appear, with Top view in the 
top left, Isometric view in the top right, Front 
view in the bottom left and Right view in the 
bottom right.

 Operating Procedure 

1 From the [Window] menu, select [Lay-
out] and then click [1/1].
The active window will be maximized and dis-
played fully in the element view window area.
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Window – Layout – Format A
Displaying an Element View Window in Format A Layout

This command is used to display windows in Format A layout.

Window – Layout – Format B
Displaying an Element View Window in Format B Layout

This command is used to display windows in “Format B” layout.

 Operating Procedure 

1 From the [Window] menu, select [Lay-
out] and then click [Format A].
All the windows except for the active window 
will close, and a window having the same 
display properties of that active window will be 
created. It will be displayed in Format A from 
certain different viewing angles.

 Operating Procedure 

1 From the [Window] menu, select [Lay-
out] and then click [Format B].
All the windows except for the active window 
will close, and a window having the same 
display properties of that active window will 
be created. It will be displayed in the for-
mat shown on the right from certain viewing 
angles.
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Window – Property
Displaying Window Properties

This command is used to display and set various types of information related to all the currently displayed 
windows.

 Operating Procedure 

1 Click [Property] on the [Window] menu.
The [Window – Property] dialog box will ap-
pear.

2 Set the parameters.
Clicking the [View reset] button will change the
Camera Settings as follows:
• Interest: 0.000, 0.000, -1000.000
• Near plane: 500.000
• Far plane: 5000.000
• View angle: 45.0

To change the element for only the windows 
for which parameters have been set, check the
[Select] checkbox and place a check mark for 
those elements.
“Selective” will appear in the window’s title 
bar.

Note
For	window	views	other	than	“Isometric”	or	“Perspec-
tive”	view,	it	is	not	possible	to	set	[View	angle]	and	
certain	“View	point”	and	Interest”	parameters.
•	 For	“Front”	and	“Back”	views,	only	[Z]	parameter	
can	be	set.

•	 For	“Top”	and	“Bottom”	views,	only	[Y]	parameter	
can	be	set.

•	 For	“Right”	and	“Left”	views,	only	[X]	parameter	can	
be	set.

•	 For	“Isometric”	view,	all	parameters	other	than	
[View	angle]	can	be	set.

•	 For	“Perspective”	view,	all	the	parameters	can	be	set.

• For those elements set in the element list to be 
hidden, it is not possible to set them to be shown 
by checking the [Select] checkbox.

• The [Flat] and [Smooth] radio buttons cannot be 
selected if Wireframe is selected as Rendering 
mode.

3 Click the [Apply] button.
The windows will be updated according to the 
parameter settings
• If you change the parameter settings and click the 

[Apply] button again, the windows will be up-
dated according to the new parameter settings.

4 Click the [OK] button.
This will confirm execution of window property 
change and close the dialog box.
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Parameters for [Window – Property] Dialog Box

View mode Click the pull-down menu, and select the desired view mode from [Front], [Back], [Top], [Bottom], 
[Right], [Left], [Isometric] and [Perspective] from the list that appears.

Rendering mode Click the pull-down menu, and select the desired rendering mode from [Wireframe], [Shading], 
[Texture Mapping], [Wireframe + Shading] and [Wireframe + Texture Mapping].

Parameters for Camera Settings

View point Camera position

Interest Position of the point of interest

Near plane Position (distance from camera) at which subject becomes visible

Far plane Position (distance from camera) at which subject goes out of sight

View angle View angle of the camera

Parameters for Display

Select Used to select the elements to be displayed in windows.

Points Used to set whether to show or hide vertices.

Normal Used to set whether to show or hide normal.

Shading Used to select flat shading or smooth shading by the [Flat] and [Smooth] radio buttons.

Window – Property
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Window – Next
Displaying Next Element View Window

This command is used to switch the next window to the active window.

Window – Previous
Displaying Previous Element View Window

This command is used to switch the previous window to the active window.

 Operating Procedure 

1 Click [Next] on the [Window] menu.
Among the windows listed in the [Window] 
menu, the window listed below the currently 
active window will be active.

 Operating Procedure 

1  Click [Previous] on the [Window] menu.
Among the windows listed in the [Window] 
menu, the window listed above the currently 
active window will be active.
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Tool Menu

Measure  ……………………………………………………………………………… 234

Menu Add …………………………………………………………………………… 241

Menu Del …………………………………………………………………………… 241

Shortcut Keys  ………………………………………………………………………… 242
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Tool – Measure
Measuring Dimensions within the Selected Element(s)

This command measures specified dimensions within the selected element.

Parameters for [Tool-Measure] Dialog Box

Points Measures the distance between multiple points on the element (the distance between two selected 
points, or the dimensions of the “bounding box” fitted to three or more selected points).

Point to Face Measures the distance between a specified point and a selected face (where the face is specified by 
selection of multiple points).

Angle Measures the angle formed by three specified points.

Circle Measures the circle formed by multiple points (the circle defined by three specified points, or the 
circle formed by fitting of multiple selected points.)

 Operating Procedure 

1 From the element list, select the de-
sired elements

2 Select the [Measure] from the [Tool] 
menu.
The [Tool – Measure] dialog box will appear.

3 Select the type of measurement you 
want to perform by checking on the 
radio button.

Memo

The measurement results is displayed in the upper-right win-
dow. Note that the content of this window can be edited.
The measurement procedure is indicated sequentially in 
the Status window.

4 Click the [Exit] button.
Tool – Measure mode will be canceled.
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n Measuring the Distance Between Two Points ([Points])

 Use the following procedure to measure the distance between two specified points on the selected elment.

Parameters Returned When Measuring Distance Between Two Points ([Points])

Dist. Length of the straight line connecting the two points. (Yellow line in an element view window.)

dx Distance along x-axis between the two points. (Red arrow in an element view window.)

dy Distance along y-axis between the two points. (Green arrow in an element view window.)

dz Distance along z-axis between the two points. (Blue arrow in an element view window.)

Point 1 Coordinates of the first point. (First white point in an element view window.)

Point 2 Coordinates of the second point. (Second white point in an element view window.)

 Operating Procedure 

1 Check on the [Points] of the [Distances] 
category.

2 Specify the first point on the element by 
clicking on it.
The specified point is displayed in an element 
view window.
Memo

If you want to redo the point specifying, click the Right
mouse button at anywhere.

3 Specity the second point on the ele-
ment by clicking on it.
The distance between the two points is mea-
sured, and the calculated results will be dis-
played in the upperright window of the [Tool 
– Measure] dialog box, and the two specified 
points and line connecting them will be dis-
played in an element view window.

Tool – Measure
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Parameters Returned When Measuring a Bounding Box ([Points])

Dist. Length of the diagonal across the bounding box. (Yellow line in an element view window.)

dx Length of bounding box in the x direction. (Red arrow in an element view window.)

dy Length of bounding box in the y direction. (Green arrow in an element view window.)

dz Length of bounding box in the z direction. (Blue arrow in an element view window.)

Point 1 Coordinate at one end of diagonal crossing the box. (White point in an element view window.)

Point 2 Coordinates at the other end of diagonal crossing the box. (White point in an element view win-
dow.)

n Measuring a Bounding Box ([Points])

Use the following procedure to measure the dimensions of the bounding box fitted to specified points on 
the selected element.
Memo

A “bounding box” is the rectangular box formed with the shortest boundary lines bounding the selected points.

 Operating Procedure 

1 Check on the [Points] of the [Distance] 
category.

2 Select the points on the element by us-
ing the Select menu.

Ref.  For details of Select	commands, refer to page 157 to 
166.

3 Click the Right mouse button.
The bounding box that covers the selected 
points is calculated, and the culculated results 
will be displayed in the upper-right window 
of the [Tool – Measure] dialog box, and the 
bounding box fitted to the specified points
will be displayed in an element view window.

Tool – Measure
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n Measuring the Distance Between a Specified Point and a Specified Face ([Point to Face])

Use the following procedure to measure the distance between a specified point and a specified face on the 
selected element.

 Operating Procedure 

1 Check on the [Point to Face].

2 Select the points on the element by us-
ing the Select menu. Ref.  For details of Select	commands, refer to page 157 to 

166.

3 Click the Right mouse button.
A face is fitted with the selected points, and 
the fitted face will be displayed in an element 
view window.
Memo

If you want to redo the face extracting, click the Right
mouse button again.

4 Specify a single point on the element by 
clicking on it.
The distance between the specified point and 
the face is calculated, and the calculated re-
sults will be displayed in the upper-right win-
dow of the [Tool – Measure] dialog box, and 
the line showing the distance will be displayed 
in an element view window.
Memo

You can specify a different point by clicking on it.
If you want to change the specified face, click the Right
mouse button at anywhere.

Parameters Returned When Measuring Distance Between Specified Point and Specified Face ([Point to Face])

Dist. Distance between point and face. (White line in an element view window.)

Point Coordinates of the circle’s center point. (White point in an element view window.)

Plane normal Value of selected face’s normal vector.

Point on the plane Coordinates of a point on the selected plane. (Yellow on-face point in an element view window.)

Tool – Measure
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n Measuring an Angle ([Angle])

Use the following procedure to measure the angle formed by three specified points on the selected ele-
ment.

Parameters Returned When Measuring an Angle ([Angle])

Angle Angle formed by the three points, in degrees. (White lines in an element view window.)

Point 1 Coordinates of the first specified point. (Yellow point in an element view window.)

Point 2 Coordinates of the second specified point. (Yellow point in an element view window.)

Point 3 Coordinates of the third specified point. (Yellow point in an element view window.)

 Operating Procedure 

1 Check on the [Angle].

2 Specify the first point on the element by 
clicking on it.
The specified point will be displayed in an ele-
ment view window.

Memo

If you want to redo the point specifying, click the Right 
mouse button at anywhere.

3 Specify the second point by clicking on 
it.

Memo

If you want to redo the point specifying, click the Right 
mouse button at anywhere.

4 Specify the third point by clicking on it.
The angle defined by the three specified points 
is calculated, and the calculated results will 
be displayed in the upper-right window of the 
[Tool – Measure] dialog box, and two lines - 
connecting the first point to second point and 
second point to third point - will be displayed
in an element view window.

Memo

To calculate the next angle, click the Right mouse button 
on the next point.

Tool – Measure
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n Measuring the Circle Passing Through Three Specified Points ([Circle])
Use the following procedure to measure the circle fitted to coincide with three specified points on the 
selected element.

 Operating Procedure 

1 Check on the [Circle].

2 Specify the first point on the element by 
clicking on it.
The specified point will be displayed in an ele-
ment view window.

Memo

To redo the point specifying, click the Right mouse but-
ton at anywhere.

3 Specify the second point by clicking on 
it.

Memo

To redo the point specifying, click the Right mouse but-
ton at anywhere.

4 Specify the third point by clicking on it.
The circle fitted to coincide with the specified 
three points is calculated, and the calculated 
results will be displayed in the upper-right win-
dow of the [Tool – Measure] dialog box, and 
the fitted circle will be displayed in an element 
view window.

Memo

To calculate the next circle, click the Right mouse button 
on the next point.

Tool – Measure

Download from Www.Somanuals.com. All Manuals Search And Download.



240

Chapter 2

Tool
Menu

9i
910
900
700
300

n Measuring a Circle Comprised of Multiple Selected Points ([Circle])

Use the following procedure to measure the circle created by fitting of multiple selected points on the 
selected element.

 Operating Procedure 

1 Check on the [Circle].

2 Select the points on the element by us-
ing the Select menu.

Ref.  For details of Select	commands, refer to page 157 to 
166.

3 Click the Right mouse button.
The circle fitted with multiple specified point 
is calculated, and the calculated results will 
be displayed in the upper-right window of 
the [Tool – Measure] dialog box, and the fit-
ted circle will be displayed in an element view 
window.

Parameters Returned When Measuring a Circle Comprised of Multiple Selected Points ([Circle])

Center Coordinates of the circle’s center point. (White point in an element view window.)

Radius Radius of the circle.

Circle normal Value of vector normal to the circle plane.

Tool – Measure
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 Operating Procedure 

1 Click the [Menu Add] on the [Tool] 
menu.
The program opens a file-load dialog.

2 Select the appropriate menu-addition 
file.
Operation is guaranteed only for well-formed 
menu-addition files. Operation may not pro-
ceed correctly if you select the wrong type of 
file.

3 Click the [Open] button.
The program opens a confirmation dialog 
based on the content of the menu-addition file.

4 Click the [OK] button.
The program executes the menu addition in 
accordance with the content of the file.

Tool – Menu Add
Adding a Menu

Tool – Menu Del
Deleting an Added Menu

 Operating Procedure 

1 Click the [Menu Del] on the [Tool] 
menu.
The program opens a menu-deletion dialog.

2 Select the appropriate menu name from 
the list.
Operation is guaranteed only for well-formed 
deletion lists. Operation may not proceed cor-
rectly if you select an improper list.

3 Click the [OK] button.
The program deletes the selected menu.

Download from Www.Somanuals.com. All Manuals Search And Download.



242

Chapter 2

Tool
Menu

9i
910
900
700
300

This command is used to display a list of shortcut keys. By default, shortcut keys have already been assigned
to popular commands. By using this command, you can add or modify shortcut keys.

Memo

Shortcut keys can also be assigned to commands given in pop-up menus.

Tool – Shortcut Keys
Displaying a List of Shortcut Keys

 Operating Procedure 

1 Click [Shortcut Keys] on the [Tool] 
menu.
The [Tool-Shortcut Keys] dialog box will ap-
pear.

Note
•	 For	commands	to	which	no	shortcut	key	is	assigned,	
“None”	will	be	displayed	in	their	text	boxes.

•	 When	assigning	a	shortcut	key,	an	error	message	will	
appear	if	it	has	already	been	assigned.

•	 Some	commands	do	not	support	shortcuts	that	use	
[shift]	+	[Ctrl].	Attempting	to	set	such	a	shortcut	com-
bination	for	these	commands	will	produce	an	error	
massage.

3 Click the [OK] button.
The dialog box will close, and changes made 
to shortcut key assignment will be effective.
The changes will be saved in the user prefer-
ence file.

• A list of shortcut keys is shown for each menu 
category. To display a list for a certain category, 
click the corresponding tab with the left mouse 
button.

2 In the [Shortcut Key] text boxes, specify 
the desired keys or combinations of 
keys.
If you want to modify a shortcut key, overwrite 
it. To add a new shortcut key, just enter it.
• Alphabet keys, [Shift] key, [Ctrl] key and their 

combinations can be assigned. However, to use a 
function key, it cannot be assigned in combination.

• For instance, if you press the [Ctrl], [Shift] and 
[a] keys at the same time, “Ctrl + Shift + a” will 
be displayed in the text box.

 
To restore the following default shortcut key 
assignment, click the [Default] button.
• [File] – [New]  [Ctrl] + [N]
• [File] – [Open]   [Ctrl] + [O]
• [File] – [Save] – [Elements]   [Ctrl] + [S]
• [File] – [Exit]   [Ctrl] + [Q]
• [View] – [Orbit]  [O]
• [View] – [Zoom]  [Z]
• [View] – [Full Frame All]   [Shift] + [F]
• [View] – [Full Frame]   [F]
• [View] – [Area Orbit]   [W]
• [View] – [Area Zoom]   [X]
• [View] – [Move Plane]   [A]
• [Select] – [Rectangle]   [E]
• [Select] – [Select by Elements]  [Ctrl] + [A]
• [Edit] – [Undo]   [Ctrl] + [Z]
• [Edit] – [Redo]   [Ctrl] + [Y]
• [Edit] – [Delete] – [Points]   [Ctrl] + [X]
• [Build] – [Move] – [Elements]  [M]
• [Build] – [Move] – [Points]   [P]
• [Build] – [Rotate] – [Elements]  [R]
• [Popup 1] – [Show Vertex/Hide Vertex] [F9]

Note
To	use	a	shortcut	key,	make	sure	that	the	mouse	cursor	
is	located	in	a	window	in	the	view	area.
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Pop-up Menus
in Element View 
Window

Pop-up Menus in Element View Window
Clicking the right mouse button on an element view window while holding down the 

[Ctrl] key will display a pop-up menu, allowing you to make various settings.

View Mode – Front/Right/Left/Back/Top/Bottom/Isometric/Perspective ……………  244

Rendering Mode – Wireframe/Shading/Texture Mapping/

                               Wireframe + Shading/Wireframe + Texture Mapping ………… 244

Show Vertex/Hide Vertex  …………………………………………………………… 244

Show Normal/Hide Normal …………………………………………………………  245

Show Axis/Hide Axis ………………………………………………………………… 245

Smooth Shading/Flat Shading………………………………………………………… 245

Select element from window ………………………………………………………… 246

Create clone window ………………………………………………………………… 247

Close window ………………………………………………………………………… 247

Property  ……………………………………………………………………………… 248
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View Mode – Front/Right/Left/Back/Top/Bottom/Isometric/Perspective
Changing View Mode

This command is used to change view mode for windows.

 Operating Procedure 

1 Select [View Mode] from a pop-up 
menu, and then click [Front], [Right], 
[Left], [Back], [Top], [Bottom], [Isomet-
ric] or [Perspective].
The view mode will be changed.

Rendering Mode – Wireframe/Shading/Texture Mapping/Wire-
frame + Shading/Wireframe + Texture Mapping
Changing Rendering Mode

This command is used to change rendering mode for windows.

 Operating Procedure 

1 Select [Rendering Mode] from a pop-
up menu, and then click [Wireframe], 
[Shading], [Texture Mapping], [Wire-
frame + Shading] or [Wireframe + Tex-
ture Mapping].
The rendering mode will be changed.
• If Shading mode is selected, rear-facing sur-

faces will be displayed in Wireframe mode.

Show Vertex/Hide Vertex [F9]
Showing or Hiding Vertices

 This command is used to set whether to show or hide vertices.

 Operating Procedure    When Vertices are Currently Hidden

1 From the pop-up menu, click [Show Vertex].
The vertices will be shown.

 Operating Procedure    When Vertices are Currently Shown

1 From the pop-up menu, click [Hide Vertex].
The vertices will be hidden.
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Show Normal/Hide Normal
Showing or Hiding Normal Vectors

This command is used to set whether to show or hide the normal.

 Operating Procedure    When the Normal is Currently Hidden

1 From the pop-up menu, click [Show Normal].
The normal will be shown.

 Operating Procedure    When the Normal is Currently Shown

1 From the pop-up menu, click [Hide Normal].
The normal will be hidden.

Show Axis/Hide Axis
Showing or Hiding Axes

This command is used to set whether to show or hide axes.

 Operating Procedure     When Axes are Currently Hidden

1 From the pop-up menu, click [Show Axis].
The axes will be shown.

 Operating Procedure     When Axes are Currently Shown

1 From the pop-up menu, click [Hide Axis].
The axes will be hidden.

Smooth Shading/Flat Shading
Changing Shading Mode

This command is used to change shading mode.

 Operating Procedure    When Window is Currently in Flat Shading Mode

1 From the pop-up menu, click [Smooth 
Shading].
The window will be displayed in smooth shad-
ing mode.

 Operating Procedure    When Window is Currently in Smooth Shading Mode

1 From the pop-up menu, click [Flat 
Shading].
The window will be displayed in flat shading 
mode.
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Select element from window
Changing Displayed Element by Windows

This command is used to switch the currently selected element to another. This is possible only for the win-
dow in which a pop-up menu is displayed.

Note
For	those	elements	set	in	the	element	list	to	be	hidden,	it	is	not	possible	to	set	them	to	be	shown	by	checking	the	[Select]
checkbox.

 Operating Procedure 

1 From the pop-up menu, click [Select 
element from window].
The [Element to be shown] dialog will appear.
• If all the elements are set to be shown (i.e. not set 

to “Selective”), the dialog box will appear with 
the [Select] checkbox unchecked.

  Otherwise, the dialog box will appear with the 
[Select] checkbox checked.

2 Check the [Select] checkbox (i.e. a 
check mark is placed).
This allows you to set whether to show or hide 
elements.

3 Check the checkbox of the desired ele-
ments to be shown.

4 Click the [OK] button.
The dialog box will close and the selected ele-
ments will be displayed.
“Selective” will appear in the window’s title 
bar.
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Create clone window
Cloning an Element View Window

This command is used to clone (duplicate) the active element view window.

Close window
Closing an Element View Window

This command is used to close the currently selected element view window.

 Operating Procedure 

1 From the pop-up menu, click [Create 
clone window].
The active window will be cloned.

 Operating Procedure 

1 From the pop-up menu, click [Close 
window].
The currently selected element view window 
will close.

• If only one view window is present and modifica-
tions have been made to an element after it has 
been imported or saved, the [Some elements are 
modified. Do you want to save them?] message 
dialog box will appear.

Press [YES].
  If an element file has been imported, its data will 

be overwritten.

  If they are newly created elements or those that 
have been imported in another file format, the 
[File-Save as-Elements] dialog box will appear, 
displaying the names of the non-saved elements at 
the top of the element list. (If you want to change 
the file names, change them.) Click the [Save] 
button to save them one by one.

  When all the elements are saved, the dialog box 
and the selected windows will close.
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Pop-up Menus
in Element View 
Window

This command is used to display and set various types of information related to all the currently displayed 
windows.

Memo

This command has the same functions as the Window – Property command.

Ref.  For details of the Window	–	Property	command, refer to page 230.

Property
Displaying Window Properties

 Operating Procedure 

1 From the pop-up menu, click [Property].
The [Window – Property] dialog box will ap-
pear.

2 Set the parameters.

3 Click the [Apply] button.

•  If you change the parameter settings and click the 
[Apply] button again, the windows will be up-
dated according to the new parameter settings.

4 Click the [OK] button.
This will confirm execution of window property 
change and close the dialog box.
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Pop-up Menus in Element List
Clicking the right mouse button on the element list while holding down the [Ctrl] key will 

display a pop-up menu, allowing you to make various settings.

Show Element/Hide Element  ………………………………………………………… 250

Delete Elements ……………………………………………………………………… 250

View Image  ………………………………………………………………………… 251

Set Wireframe Color  ………………………………………………………………… 251

Set Shading Color …………………………………………………………………… 252

Rename Element  …………………………………………………………………… 252
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Show Element/Hide Element
Showing/Hiding Elements

This command is used to show or hide the element(s) selected in the element list.
Memo

This command has the same effect as when a check mark is placed for the desired elements in the element list.

Note
If	a	pop-up	menu	is	displayed	in	areas	other	than	element	name	area	in	the	element	list,	the	menu	items	[Show	Element]
and	[Hide	Element]	will	not	be	displayed.

[Operating Procedure    When Elements are Currently Hidden

1 Click the element(s) to be shown with 
the right mouse button, and select 
[Show Element] from the pop-up menu 
that appears.
The element(s) will be shown.

Delete Elements
Deleting Elements from the Element List

This command is used to delete the element(s) selected from the element list.
Memo

The Delete Elements command has the same function as the File – Remove Elements and Edit – Delete – Elements command.

Ref.  
　•　For details of the File	–	Remove	Elements command, refer to page 141.
　•　For details of the Edit	–	Delete	–	Elements	command, refer to page 169.

 Operating Procedure 

1 Click the element(s) to be deleted with 
the right mouse button, and select [De-
lete Elements] from the pop-up menu 
that appears.
A message asking you whether to delete all 
the selected elements will appear.

Memo

If two or more elements have been selected by clicking 
them while holding down the [Shift] or [Ctrl] key, they 
can be deleted.

2 Click the [OK] button.
All the selected elements and their corre-
sponding points will be removed.

[Operating Procedure]    When Elements are Currently Shown

1 Click the desired element(s) to be hid-
den with the right mouse button, and 
select [Hide Element] from the pop-up 
menu that appears.
The element(s) will be hidden.
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View Image
Displaying Color Images

This command is used to display color images of the element(s) currently selected in the element list.

 Operating Procedure 

1 Click the desired element(s) whose 
color images are to be shown with the 
right mouse button, and select [View 
Image] from the pop-up menu that ap-
pears.
The color images of the selected element(s) 
will be displayed.

Set Wireframe Color
Changing Wireframe Color

This command is used to set the wireframe color for the element(s) selected in the element list.
Note

If	a	pop-up	menu	is	displayed	without	elements	selected	in	the	element	list,	[Set	Wireframe	Color]	will	not	be	displayed
in	the	menu.

 Operating Procedure 

1 Click the element(s) for which you want 
to set wireframe color with the right 
mouse button, and select [Set Wire-
frame Color] from the pop-up menu 
that appears.
A color palette dialog box will appear.

Memo

If two or more elements have been selected by clicking 
them while holding down the [Shift] or [Ctrl] key, the 
color images for those elements can be displayed.

Memo

If two or more elements have been selected by clicking 
them while holding down the [Shift] or [Ctrl] key, the 
wireframe color for those elements can be set.

2 Select the desired color from the color 
palette.

3 Click the [OK] button.
The wireframe color(s) for the selected element(s) will be 
changed to the one selected at step 2.
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Set Shading Color
Changing Shading Color

This command is used to set the shading color for the element(s) selected in the element list.
Note
If	a	pop-up	menu	is	displayed	without	elements	selected	in	the	element	list,	[Set	Shading	Color]	will	not	be	displayed
in	the	menu.

 Operating Procedure 

1 Click the element(s) for which you 
want to set shading color with the right 
mouse button, and select [Set Shading 
Color] from the pop-up menu that ap-
pears.
A color palette dialog box will appear.

Rename Element
Changing an Element Name

This command is used to rename the element(s) currently selected in the element list.
Memo

It is also possible to rename an element by double-clicking it in the element list with the right mouse button.

Note
If	a	pop-up	menu	is	displayed	without	elements	selected	in	the	element	list,	[Rename	Element]	will	not	be	displayed	in
the	menu.

 Operating Procedure 

1 Click the element(s) to be renamed with 
the right mouse button, and select [Re-
name Element] from the pop-up menu 
that appears.
It is now possible to enter a new element 
name.
Note
The	element	name	must	consist	of	up	to	31	alphanu-
meric	characters.

Memo

If two or more elements have been selected by clicking 
them while holding down the [Shift] or [Ctrl] key, the 
shading color for those elements can be set.

2 Select the desired color from the color 
palette.

3 Click the [OK] button.
The shading color(s) for the selected 
element(s) will be changed to the one selected 
at step 2.

Memo

If two or more elements have been selected by clicking 
them while holding down the [Shift] or [Ctrl] key, they 
can be renamed.

2 Enter the desired element name, and 
press the [ENTER] key.
The element will be renamed.
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Pop-up Menus in Image Window
Clicking the right mouse button on an image window while holding down the [Ctrl] key 

will display a pop-up menu, allowing you to make various settings.

Change Image ………………………………………………………………………… 254

Overlay  ……………………………………………………………………………… 254

Zoom In  ……………………………………………………………………………… 254

Zoom Out  …………………………………………………………………………… 255

Actual Pixels  ………………………………………………………………………… 255

Close ………………………………………………………………………………… 255
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Change Image
Changing the Color Image

This command is used to change the currently displayed color image with a new one.

 Operating Procedure 

1 From the pop-up menu, click [Change 
Image].
A sub menu will appear.

2 Select the desired color image.
The currently displayed color image will be 
replaced with the selected one.

Overlay
Displaying Wireframe on a Color Image

This command is used to overlay wireframe on the currently displayed color image.

 Operating Procedure 

1 From the pop-up menu, click [Overlay].
Wireframe will be overlaid on the element im-
age.
Note

However,	if	the	currently	displayed	color	image	is	the	
one	that	has	been	added	to	the	data	taken	by	the	VIVID
(VI)	series	digitizer,	no	wireframe	will	be	displayed.

Zoom In
Changing the Color Image

This command is used to enlarge the currently displayed color image.

 Operating Procedure 

1 From the pop-up menu, click [Zoom In].
The color image will be enlarged in steps by 
the following magnification ratio each time this 
command is selected.
1/12, 1/8, 1/6, 1/4, 1/3, 1/2, 2/3, 1, 2, 3, 4, 5, 6, 
7 and 8
• If the image is enlarged beyond the image win-

dow, a scroll bar will appear.
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Zoom Out
Reducing the Color Image

This command is used to reduce the currently displayed color image.

 Operating Procedure 

1 From the pop-up menu, click [Zoom 
Out].
The color image will be reduced in steps by 
the following magnification ratio each time this 
command is selected.
1/12, 1/8, 1/6, 1/4, 1/3, 1/2, 2/3, 1, 2, 3, 4, 5, 6, 
7 and 8

Actual Pixels
Displaying the Color Image in One-to-One Pixel Mode

This command is used to display color images in one-to-one pixel mode (one data pixel = one monitor pixel).

 Operating Procedure 

1 From the pop-up menu, click [Actual 
Pixels].
The color images will be displayed in one-to-
one pixel mode.

Close
Changing the Color Image

This command is used to close the currently displayed color image.

 Operating Procedure 

1 From the pop-up menu, click [Close].
The color image will close.
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Chapter 3 contains Error Message 
explanations and Technical Terms 
glossary.
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AF error. Laser barrier may be 
closed

The digitizer was not ready due to an 
AF error.

Click the [OK] button to close the mes-
sage dialog box.

AF error. The digitizer was not ready due to an 
AF error.

Click the [OK] button to close the mes-
sage dialog box.

Calculation disable. Failed to calculate using the specified 
corresponding points.

Click the [OK] button to close the mes-
sage dialog box.
*When selecting correspondence points, 
you must select points so that they are 
sufficiently spaced and so that are within 
the range that can be specified within the 
element’s colorimage window.

Cannot display wireframe. The command was selected even though 
the currently displayed color image was 
the one added to the data taken by the 
digitizer.

Click the [OK] button to close the mes-
sage dialog box.

Cannot show information of more 
than 20000 points. (Number of 
selected points – 20000) Points 
will be omitted.

More than 20000 points were selected. Click the [OK] button to display the 
[Info-Points] dialog box. Information for 
the extra points (i.e. the points exceeding 
– 20000) will not be included.

Choose more than 2 points. An attempt was made to extract a line 
without selecting two or more points.

Click the [OK] button to close the mes-
sage dialog box.

Choose more than 3 points. An attempt was made to extract a face 
or circle without selecting three or more 
points.

Click the [OK] button to close the mes-
sage dialog box.

Choose more than 4 points. An attempt was made to extract a sphere 
without selecting four or more points.

Click the [OK] button to close the mes-
sage dialog box.

Create Meshes Fault! Failed to fill holes.
(This message appears if creation of 
meshes fails with “Fillholes by meshes” 
or “Replace meshed” selected.)

Click the [OK] button to close the mes-
sage dialog box.

Design value is same as that of 
others.

The design values of the extracted point 
are the same as those of the extracted 
line.

Click the [OK] button to close the mes-
sage dialog box.

Extracted line’s vector overlaps The extracted line’s vector is the same 
as the other line’s vector.

Click [OK] button to close message 
dialog box.

Extracted point overlaps The extracted coordinate (X, Y, Z) is the 
same as the other’s coordinate.

Click [OK] button to close message 
dialog box.

Extraction failure. Please select 
again.

Fail extraction of Point, Line or Face. Click [OK] button to close message 
dialog box.

File write error. A write error occurred, for instance, due 
to an excessively long file path name.

Click the [OK] button to close the mes-
sage dialog box.

File write error: user preferences. A write error occurred. Click the [OK] button to close the mes-
sage dialog box.
No preference file will be created even if 
the [OK] button is clicked.
(The settings will be lost if this software 
is exited.)

Error Messages
The following error messages appear if incorrect operation is performed or an abnormality occurs. If an error
message appears, take the appropriate corrective actions as shown in the table below.
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File write permission error. An attempt was made to save a file in　
a directory for which no file write　
permission was given.

Click the [OK] button to close the mes-
sage dialog box.

An attempt was made to copy a file in a 
directory for which no file write permis-
sion was given when “Copy” or “Copy/
All” was selected.

File write permission error: user 
preferences.

No write permission was given for the 
preference file or directory.

Click the [OK] button to close the mes-
sage dialog box.
*No preference file will be created even 
if the [OK] button is clicked.
(The settings will be lost if this software 
is exited.)

FillHoles Disable. Failed to fill holes. (Failed to divide 
holes.)

Click the [OK] button to close the mes-
sage dialog box.

FillHoles Fault! Please select other 
Algorithm.

Failed to fill holes. (This message ap-
pears when replacement fails even if 
“Replace meshes” is selected.)

Click the [OK] button to close the mes-
sage dialog box.

Identical name entered. Please 
enter another name.

The [Rename] button was clicked even 
though the same file name as the origi-
nal file name had been entered.

Click the [OK] button to close the mes-
sage dialog box.

Illegal format file. An attempt was made to open a file 
which cannot be read.

Click the [OK] button to close the mes-
sage dialog box.

Invalid directory. An attempt was made to enter a direc-
tory name which did not exist.

Click the [OK] button to close the mes-
sage dialog box.

Invalid format.
(VIVID 700, VI-700)

The memory card was not formatted. Click the [OK] button to close the mes-
sage dialog box.

Memory allocation error. Failed to reserve sufficient memory to 
execute a command.

Click the [OK] button to close the 
message dialog box. Quit this software 
immediately.

No holes were found. No holes were found as a result of a 
search.

Click the [OK] button to close the mes-
sage dialog box.

No more redo. (An alarm will be 
heard if the shortcut key is used.)

An attempt was made to perform redo 
more than the specified times.

Click the [OK] button to close the mes-
sage dialog box.

No more undo. (An alarm will be 
heard if the shortcut key is used.)

An attempt was made to perform undo 
more than the specified times.

Click the [OK] button to close the mes-
sage dialog box.

No name entered. Please enter 
again.
(“Element name”)

The [OK] button was clicked even 
though no element name had been 
entered.

Click the [OK] button to close the mes-
sage dialog box. Enter an element name, 
and click the [OK] button to open the file.

No name entered. Please enter 
again.

The [OK], [Load] or [Rename] button 
was clicked even though no element 
name had been entered.

Enter the desired file name, and click the 
button.

No memory card. Please insert a 
card.
(VIVID 700, VI-700)

No memory card has been inserted. Click the [OK] button to close the mes-
sage dialog box.

No step angle entered. Please 
enter again.

The [Scan] button was clicked without 
entering a rotating angle even though 
“Other” was selected for [Rotation step].

Click the [OK] button to close the mes-
sage dialog box.

Not Ready for Remote. Keys on the digitizer were operated 
while the monitor image was displayed.

Stop operating the keys and click the [OK] 
button to open a message dialog box.

PC Card had reset since last 
update.

Power was turned Off then turned On or 
the memory card was replaced.

Click the [OK] button to close the mes-
sage dialog box.
The memory card information will be 
updated automatically.
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PC Card had updated since last 
update.

A file(s) was added, deleted or renamed 
on the digitizer while the [File-Import-
Digitizer-PC Card] dialog box was open, 
but the memory card was not updated. 

Click the [OK] button to close the mes-
sage dialog box. The memory card infor-
mation will be updated automatically.

Please capture chart data again. Not possible to make calculation for the 
rotary shaft using the chart’s image even 
though the [Convert] button was clicked.

Click the [OK] button to close the mes-
sage dialog box.

Please capture chart data. The [Convert] button was clicked even 
though no image of the chart had been 
acquired.

Click the [OK] button to close the mes-
sage dialog box.

Please capture data. The [Convert] button was clicked even 
though no data had been acquired.

Click the [OK] button to close the mes-
sage dialog box.

Please capture more than one 
data.

The [Convert] button was clicked even 
though two or more shots had not been 
acquired.

Click the [OK] button to close the mes-
sage dialog box.

Please draw line. The middle mouse button was clicked 
even though no control points had been 
set.

Click the [OK] button to close the mes-
sage dialog box.

Please match equal to or more 
than 6 points.

The [OK] or [Preview] button was 
clicked even though more than six pairs 
of corresponding points had not been 
designated.

Click the [OK] button to close the mes-
sage dialog box.

Please read element first. An attempt was made to execute the 
Build – Move – To X-Y-Z command 
without first importing an element.

Click the [OK] button to close the mes-
sage dialog box.

Please select 2 polygon mesh ele-
ments. (An alarm will be heard if 
the shortcut key is used.)

The command was selected without 
selecting two polygon mesh elements.

Click the [OK] button to close the mes-
sage dialog box.

Please select a file. The [Rename], [Load], [Copy] or [De-
lete] button was clicked even though no 
files had been selected.

Click the [OK] button to close the mes-
sage dialog box.

Please select a polygon mesh 
element. (An alarm will be heard if 
the shortcut key is used.)

The command was selected even though 
no elements had been selected or ele-
ments other than polygon mesh elements 
had been selected.

Click the [OK] button to close the mes-
sage dialog box.

Please select a sample point on 
the image.

The [Apply] button was clicked without 
selecting sample points.

Click the [OK] button to close the mes-
sage dialog box.

Please select a single polygon 
mesh element. (An alarm will be 
heard if the shortcut key is used.)

The command was selected even though 
more than one polygon mesh elements 
had been selected or a polygon mesh 
element and an element other than poly-
gon mesh type had been selected.

Click the [OK] button to close the mes-
sage dialog box.

Please select a single scene file. The [Open] button was clicked even 
though more than one scene files had 
been selected.

Click the [OK] button to close the mes-
sage dialog box.

Please select element(s). (An 
alarm will be heard if the shortcut 
key is used.)

The command was selected even if no 
elements had been selected.

Click the [OK] button to close the mes-
sage dialog box.

Please select multiple polygon 
mesh elements. (An alarm will be 
heard if the shortcut key is used.)

The command was selected even though 
more than one polygon mesh element 
had not been selected.

Click the [OK] button to close the mes-
sage dialog box.

Please select only polygon mesh 
element( s). (An alarm will be 
heard if the shortcut key is used.)

An element(s) other than polygon mesh 
type element was also selected.

Click the [OK] button to close the mes-
sage dialog box.
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Please select only same format 
files.

The [Open] or [Import] button was 
clicked even though more than one file 
of different format had been selected.

Click the [OK] button to close the mes-
sage dialog box.

Please select point(s). (An alarm 
will be heard if the shortcut key is 
used.)

The command was selected with no 
points selected.

Click the [OK] button to close the mes-
sage dialog box.

Please select points within each 
selected element. (An alarm will 
be heard if the shortcut key is 
used.)

The command was selected even though 
no points had been selected or points 
had been selected for only some selected 
element but not all.

Click the [OK] button to close the mes-
sage dialog box.

Please select polygon mesh ele-
ment( s). (An alarm will be heard if 
the shortcut key is used.)

The command was selected even though 
no elements had been selected or ele-
ments other than polygon mesh elements 
had been selected.

Click the [OK] button to close the mes-
sage dialog box.

Please select polygon(s). (An 
alarm will be heard if the shortcut 
key is used.)

The command was selected even though 
no polygons had been selected.

Click the [OK] button to close the mes-
sage dialog box.

Please select three or more 
points. (An alarm will be heard if 
the shortcut key is used.)

The command was selected even though 
three or more points had not been 
selected.

Click the [OK] button to close the mes-
sage dialog box.

The right mouse button was clicked 
even though more than three pairs of 
corresponding points had not been 
designated.

Same element name exists. 
Please enter another name. (“File 
name”)

The same element name already exists. Enter a new element name, and click the 
[OK] button to open the file.

Same element name exists. Re-
place?

An attempt was made to enter an ele-
ment name that already exists.

To replace the existing element, click the 
[Replace] button.

Same file name exists. An attempt was made to enter a file 
name that already exists.

To overwrite the file, click the [Over-
write] button.

SCSI read error. An error occurred with SCSI connection.
A read error from the memory card oc-
curred in VIVID 900/910 (VI-900/ 910).

Click the [OK] button to close the mes-
sage dialog box.

Select more points. We need 
more than 500 selected points for 
registration.

Among selected elements, at least one 
element that does not have a certain 
number of selected points exists.

Click the [OK] button to close the mes-
sage dialog box.

Selected file “****” may be bro-
ken. Continue?

An attempt was made to read a file that 
had not been saved properly.

To continue to read the file, click the 
[Continue] button. *If the [Continue] 
button is clicked, an abnormal stop of the 
software may occur during reading.

Something wrong with VIVID. A SCSI error other than SCSI connec-
tion error, SCSI command end error and 
ready error due to an AF error occurred.

Click the [OK] button to close the mes-
sage dialog box.

The element has no image/The 
elements have no image. (An 
alarm will be heard if the shortcut 
key is used.)

The command was selected even though 
only the polygon mesh elements that 
were defined without copying images or 
elements other than polygon mesh ele-
ments were selected.

Click the [OK] button to close the mes-
sage dialog box.
*If both polygon mesh elements with 
images and those without images are 
selected, this error message will not be 
displayed for those elements that do not 
contain images.

The element has no image. (An 
alarm will be heard if the shortcut 
key is used.)

The selected element did not have any 
images when the command was se-
lected.

Click the [OK] button to close the mes-
sage dialog box.
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The size of this image is different 
from the size of selected image.

The size of the selected image was dif-
ferent from that of the image you tried to 
load, due to replacement of textures.

Click the [OK] button to close the mes-
sage dialog box.

There are no points. The element 
will be removed. (“File name”)

No data points were contained. Click the [OK] button to close the mes-
sage dialog box. The element will be 
selected.

This element does not have mul-
tiple images.

You attempted to execute the command 
on an element that has only a single 
image.

Click the [OK] button to close the mes-
sage dialog box.

This Shortcut key about [Com-
mand Name] is an invalid combi-
nation. It will be reset!

The shortcut key combination you at-
tempted to set is not supported by this 
command.

Click the [OK] button to close the mes-
sage dialog box.

This Shortcut key about [Com-
mand Name] is exist! Please set 
another!

The same shortcut key had already been 
assigned when you tried to assign it.

Click the [OK] button to close the mes-
sage dialog box.

This version of scene file is not 
supported.

The [Open] button was clicked even 
though a scene file saved by the Utility 
Software VI-S1 had been selected.

Click the [OK] button to close the mes-
sage dialog box.

Too Small Mesh. We can’t get 
enough information for registra-
tion.

Among selected elements, at least one 
element that is composed of less than 
a certain number of constituent points 
exists.

Click the [OK] button to close the mes-
sage dialog box.

Turntable not found. The rotary stage is not connected to the 
digitizer or it is not turned ON.

Click the [OK] button to close the mes-
sage dialog box.

Unknown PC Card
(VIVID 700, VI-700)

The type of memory card is incorrect. Click the [OK] button to close the mes-
sage dialog box.

Value must be 0 < value < 10000. A value outside the allowable range was 
entered.

Click the [OK] button to close the mes-
sage dialog box.

Value must be –100000 < value < 
100000.

A value outside the allowable range was 
entered and the OK button was clicked.

Click the [OK] button to close the mes-
sage dialog box.

VIVID busy. The SCSI command did not complete. Click the [OK] button to close the mes-
sage dialog box.

VIVID not found. VIVID (VI) series digitizer is not turned 
ON, cables are disconnected, or the 
SCSI device driver setting is not correct.

Click the [OK] button to close the mes-
sage dialog box.

“Element name” Zero or few poly-
gons found. Skip making LOD.

The selected element has an excessively 
small number of polygons.

Click the [OK] button to close the mes-
sage dialog box.
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n Coordinate System
With this utility software, points located in a three-
dimensional space are expressed using coordinate 
values of threedimensional right-handed Cartesian 
coordinates. The center of the light-receiving lens of 
the digitizer is set as the origin of the coordinates. 
+Z direction refers to the direction facing the front 
side along the optical axis, + Y direction refers to 
the upward direction and +X direction refers to the 
direction facing the right, when viewed from the 
back of the light-receiving section.

n Window View
This program lets you view elements using three types of views: orthogonal views (Top, Front, Back, Bottom, Left, 
Right), perspective views, and isometric views.

n Vertex
Vertices refer to points in a three-dimensional space. They possess three-dimensional coordinate values, and can be 
selected or unselected.
They can also be edited (i.e. moved and deleted).
To edit vertices, they must be selected using the [Select] menu. (For the [Select] menu, refer to page 157.)
In addition, vertices can be shown or hidden by using the Window – Property command. (For details of the Win-
dow – Property command, refer to page 230.)

n Polygon
Polygons refer to areas (surfaces) enclosed by lines (edges) connecting vertices. Only triangular and rectangular 
polygons are available with this software, and they can be positioned facing toward the front or rear side.

n Color Image
When an image is acquired by the VIVID (VI) series digitizer, a range image containing distance data to each point 
on the surface of the object is acquired as well as a color image taken from the same view angle as the range image. 
With this software, color images possess information used to correspond picture elements to vertices based on color 
information. If images are acquired using the Remote command, color images will also be saved automatically. 
(When saving data on the VIVID 9i (VI-9i), VIVID 910 (VI-910) or VIVID 900 (VI-900), it is possible to select whether 
or not to save color images.) 

Back View

Front View

Left View

Bottom View

Right View

Top View

Perspective View

Bottom View

Camera View
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n Element
Elements refer to data consisting of points (vertices), polygons and color images *1.
When data acquired by the VIVID (VI) series digitizer is loaded to this software, it will always be displayed as a 
polygon mesh element. In addition, use of the Edit – Define command allows you to define a part of an existing ele-
ment as a new element. Names of elements loaded to this software and those that are newly defined are displayed in 
the element list located at the right edge of the screen.

*1 Some polygon mesh elements do not have color images.
 For instance, a polygon mesh element created by the Edit – Define command without “Copy image( s)” 

selected does not have color images.

n Scene
A scene refers to information such as currently opened element, its view information (zoom setting, viewing direc-
tion, Shades/Lines display mode), camera *2, point of interest *3 and light *4 . When a scene is saved using the File – 
Save – Scene command, all this information will be saved. 

*2 The camera indicates direction in which the image displayed in a “Isometric” or “Perspective” element 
view window is viewed. (The image displayed in “Isometric” or “Perspective” element view window is the 
image of the object viewed from the camera position.)

 The camera position can be moved using the View – Camera – Settings or View – Orbit command. 
*3 The point of interest shows the direction in which the camera views the image. By moving the point of in-

terest using the View – Camera – Settings command, the viewing direction of the camera can be changed. 
*4 The light provides shadow for “Shades” element view windows, and two kinds of light are available: point 

light source and environmental light.
 With the default settings, the point light source is located behind and to the right of the camera. Position of 

the point light can be moved by the View – Move Light command.
 In the SHADING display mode, the intensity of the environmental light, color of the light and material of 

elements (highlight, object’s color) are determined automatically. 

n Camera Data File
A camera data file contains data (i.e. the data before conversion to element data) acquired by the digitizer. It is pos-
sible to set the resolution for the range image, fill holes (i.e., areas where no data exists) with points automatically 
and merge more than one data acquired at different angles using the optional turntable.

n Element File
An element file contains data for a single element.

n Scene File
A scene file contains data for a scene.

n Dynamic Range Expansion Function 
This function expands the measurement range when the VIVID 9i (VI-9i) or VIVID 910 (VI-910) performs scanning.
The laser beam of three different intensity levels (high, middle, low) is emitted to the object, and the rays reflected 
from the object are captured by the CCD. Among the reflected rays, the data within the CCD’s measurement range 
are used to expand the entire measurement range.
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